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Note

Purpose

Preface

This preface describes the purpose, audience, organization, and conventions of this guide, and provides
information on how to obtain related documentation.

This document may not represent the latest Cisco product information that is available. You can obtain
the most current documentation by accessing Cisco product documentation page at this URL:

For Cisco Unified Communications Manager:
http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd products support series home.html

For Cisco Unified Communications Manager Business Edition:
http://www.cisco.com/en/US/products/ps7273/tsd products support series home.html

For Cisco Unity Connection:
http://www.cisco.com/en/US/products/ps6509/tsd products support series home.html

The preface covers these topics:
e Purpose, page iii
e Audience, page iv
e Organization, page v
e Related Documentation, page vi
e Conventions, page vi
e Obtaining Documentation, Obtaining Support, and Security Guidelines, page vii

e (Cisco Product Security Overview, page vii

The Cisco Unified Serviceability Administration Guide provides descriptions and procedures for
configuring alarms, traces, SNMP, and so on, through Cisco Unified Serviceability for Cisco Unified
Communications Manager, Cisco Unified Communications Manager Business Edition, and Cisco Unity
Connection. Use this guide with the documentation for your configuration:
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Audience

Cisco Unified Communications Cisco Unified Real-Time Monitoring Tool Administration
Manager Guide, Cisco Unified Communications Manager CDR

Analysis and Reporting Administration Guide, and Cisco
Unified Communications Manager Call Detail Records
Administration Guide.

Cisco Unified Communications Cisco Unified Real-Time Monitoring Tool Administration
Manager Business Edition Guide, Cisco Unified Communications Manager CDR

Analysis and Reporting Administration Guide, Cisco Unified
Communications Manager Call Detail Records
Administration Guide, and Cisco Unity Connection
Serviceability Administration Guide

Cisco Unity Connection Cisco Unity Connection Serviceability Administration

Guide, and Cisco Unified Real-Time Monitoring Tool
Administration Guide.

These documents provide the following information:

Cisco Unified Communications Manager CDR Analysis and Reporting Administration Guide—This
document describes how to configure and use Cisco Unified Communications Manager CDR
Analysis and Reporting (CAR), a tool that is used to create user, system, device, and billing reports.

Cisco Unified Communications Manager Call Detail Records Administration Guide—This
document includes Call Detail Record (CDR) definitions.

Cisco Unified Real-Time Monitoring Tool Administration Guide—This document describes how to
use RTMT, a tool that allows you to monitor many aspects of the system (critical services, alerts,
performance counters, and so on).

Cisco Unity Connection Serviceability Administration Guide—This document provides
descriptions and procedures for using alarms, traces, clusters, reports, and so on, through
Cisco Unity Connection Serviceability.

For Cisco Unity Connection, you must perform serviceability-related tasks in both Cisco Unified
Serviceability and Cisco Unity Connection Serviceability; for example, you may need to start and stop
services, view alarms, and configure traces in both applications to troubleshoot a problem.

Cisco Unified Serviceability supports the functionality that is described in the Cisco Unified
Serviceability Administration Guide; for tasks that are specific to Cisco Unity Connection
Serviceability, refer to the Cisco Unity Connection Serviceability Administration Guide.

The Cisco Unified Serviceability Administration Guide assists administrators that configure,
troubleshoot, and support Cisco Unified Communications Manager, Cisco Unified Communications
Manager Business Edition, or Cisco Unity Connection. This guide requires knowledge of telephony and
IP networking technology.

Cisco Unified Serviceability Administration Guide
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Organization

The following table shows the organization for this guide:

Table 1 Organization of Cisco Unified Serviceability Administration Guide
Part Description
Part 1 |“Understanding Cisco Unified Serviceability”

Provides an overview of Cisco Unified Serviceability, including browser support and
information on how to access and use the GUL

Part 2 |“Alarms”

e Provides an overview of Cisco Unified Serviceability alarms and alarm definitions.

e Provides procedures for configuring alarms in Cisco Unified Serviceability; provides
procedures for searching and editing Cisco Unified Serviceability alarm definitions.

Part 3 |“Trace”

e Provides an overview for configuring trace parameters in Cisco Unified Serviceability;
also provides an overview of trace collection in the Cisco Unified Real-Time Monitoring
Tool.

e Provides procedures for configuring trace parameters for Cisco Unified Serviceability
network and feature services; provides procedures for configuring the troubleshooting
trace settings for services in Cisco Unified Serviceability.

Part 4 |“Tools”

e Provides a description of each network and feature service that displays in Cisco Unified
Serviceability; provides procedures and recommendations for activating, deactivating,
starting, and stopping Cisco Unified Serviceability feature and network services.

e Unified CM and Unified CM BE only: Provides information on using the CDR
Management Configuration window to set the amount of disk space to allocate call detail
record (CDR) and call management record (CMR) files, configure the number of days to
preserve files before deletion, and configure billing application server destinations for
CDRs.

e Provides an overview on the reports that are generated by the Cisco Serviceability
Reporter service; provides procedures for viewing reports that are generated by the Cisco
Serviceability Reporter service.

Part 5 |“Simple Network Management Protocol”

e Provides an overview of Cisco Unified Communications Manager support of SNMP
versions 1, 2¢, and 3. Administrators use SNMP to troubleshoot and to perform
diagnostics and network management tasks.

e Provides procedures for configuring SNMP versions 1, 2c, and 3.

e Provides procedures for configuring the system contact and system location objects for
the MIB-II system group.

e Provides procedures for configuring SNMP trap and inform parameters.

e Provides troubleshooting tips for SNMP services and MIBs.

[ oL-18619-01
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Related Documentation

For additional documentation, refer to the documentation guide at the URL for your configuration:

Cisco Unified Communications Cisco Unified Communications Manager Documentation
Manager Guide:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/pr
oducts_documentation_roadmaps_list.html

Cisco Unified Communications Cisco Unified Communications Manager Business Edition
Manager Business Edition Documentation Guide:

http://www.cisco.com/en/US/products/ps7273/products_doc
umentation_roadmaps_list.html

Cisco Unity Connection Documentation Guide for Cisco Unity Connection:

http://www.cisco.com/en/US/products/ps6509/products_doc
umentation_roadmaps_list.html.

Conventions

This document uses the following conventions:

Convention Description

boldface font Commands and keywords are in boldface.

italic font Arguments for which you supply values are in italics.

[ ] Elements in square brackets are optional.

{xlylz} Alternative keywords are grouped in braces and separated by vertical
bars.

[xlylz] Optional alternative keywords are grouped in brackets and separated by
vertical bars.

string A nonquoted set of characters. Do not use quotation marks around the
string or the string will include the quotation marks.

screen font Terminal sessions and information the system displays are in screen font.

boldface screen font Information you must enter is in boldface screen font.

italic screen font Arguments for which you supply values are in italic screen font.

_— This pointer highlights an important line of text in an example.

A The symbol ” represents the key labeled Control—for example, the key

combination ~D in a screen display means hold down the Control key
while you press the D key.

< > Nonprinting characters, such as passwords, are in angle brackets.

Cisco Unified Serviceability Administration Guide
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Notes use the following conventions:

Note = Means reader take note. Notes contain helpful suggestions or references to material not covered in the
publication.

Timesavers use the following conventions:

Timesaver  Means the described action saves time. You can save time by performing the action described in the
paragraph.

Tips use the following conventions:

e

Tip Means the information contains useful tips.

Cautions use the following conventions:

A

Caution Means reader be careful. In this situation, you might do something that could result in equipment
damage or loss of data.

Warnings use the following conventions:

A

Warning  This warning symbol means danger. You are in a situation that could cause bodily injury. Before you
work on any equipment, you must be aware of the hazards involved with electrical circuitry and
familiar with standard practices for preventing accidents.

Obtaining Documentation, Obtaining Support, and Security
Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback,
security guidelines, and also recommended aliases and general Cisco documents, see the monthly
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Cisco Product Security Overview

This product contains cryptographic features and is subject to United States and local country laws
governing import, export, transfer and use. Delivery of Cisco cryptographic products does not imply
third-party authority to import, export, distribute or use encryption. Importers, exporters, distributors
and users are responsible for compliance with U.S. and local country laws. By using this product you
agree to comply with applicable laws and regulations. If you are unable to comply with U.S. and local
laws, return this product immediately.

Cisco Unified Serviceability Administration Guide
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Further information regarding U.S. export regulations may be found at
http://www.access.gpo.gov/bis/ear/ear_data.html.

Cisco Unified Serviceability Administration Guide
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= CHAPTER 1

Understanding Cisco Unified Serviceability

This document uses the following abbreviations to identify administration differences for these Cisco
products:

Unified CM refers to Cisco Unified Communications Manager

Unified CM BE refers to Cisco Unified Communications Manager Business Edition

Connection refers to Cisco Unity Connection

This chapter contains information on the following topics:

Cisco Unified Serviceability Overview, page 1-1
Reporting and Monitoring Tools, page 1-2
Remote Serviceability Tools, page 1-3
Customized Log-on Message, page 1-4

Browser Support, page 1-4

Where to Find More Information, page 1-4

Cisco Unified Serviceability Overview

Cisco Unified Serviceability, a web-based troubleshooting tool, provides the following functionality:

Saves alarms and events for troubleshooting and provides alarm message definitions.
Saves trace information to various log files for troubleshooting.

Monitors real-time behavior of components through the Cisco Unified Real-Time Monitoring Tool
(RTMT).

Unified CM and Unified CM BE only: Generates Cisco Unified Communications Manager reports
for Quality of Service, traffic, and billing information through Cisco Unified Communications
Manager CDR Analysis and Reporting (CAR).

Unified CM only: Provides audit capability by logging any configuration changes to the Cisco Unified
Communications Manager system by a user or as a result of the user action. This functionality supports
the Information Assurance feature of Cisco Unified Communications Manager.

Provides feature services that you can activate, deactivate, and view through the Service Activation
window.

Provides an interface for starting and stopping feature and network services.

[ oL-18619-01
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| Reporting and Monitoring Tools

Generates and archives daily reports; for example, alert summary or server statistic reports.

Allows Cisco Unified Communications Manager and Cisco Unity Connection to work as a managed
device for SNMP remote management and troubleshooting.

Monitors the disk usage of the log partition on a server.

Monitors the number of threads and processes in the system; uses cache to enhance the performance.

Cisco RIS Data Collector provides Process and Thread statistic counters in the Cisco Unified
Real-Time Monitoring Tool. To configure the maximum number of processes and threads that
are allowed, so Cisco RIS Data Collector can provide these associated counters, access the
Maximum Number of Threads and Process service parameter for the Cisco RIS Data Collector
service in the administration interface for your configuration.

Unified CM and Unified CM BE: For information on configuring service parameters, refer to the
Cisco Unified Communications Manager Administration Guide.

Connection: For information on configuring service parameters, refer to the System
Administration Guide for Cisco Unity Connection.

Tip Unified CM BE and Connection only: For Cisco Unity Connection, you must perform
serviceability-related tasks in both Cisco Unified Serviceability and Cisco Unity Connection
Serviceability; for example, you may need to start and stop services, view alarms, and configure traces
in both applications to troubleshoot a problem.

Cisco Unified Serviceability supports the functionality that is described in the Cisco Unified
Serviceability Administration Guide; for tasks that are specific to Cisco Unity Connection
Serviceability, refer to the Cisco Unity Connection Serviceability Administration Guide.

Reporting and Monitoring Tools

Cisco Unified Serviceability provides the following reporting tools:

Cisco Unified Real-Time Monitoring Tool (RTMT)—Monitors real-time behavior of components
through RTMT; creates daily reports that you can access through the Serviceability Reports
Archive. For more information, refer to the Cisco Unified Real-Time Monitoring Tool
Administration Guide.

Serviceability Reports Archive—Archives reports that the Cisco Serviceability Reporter service
generates.

Unified CM and Unified CM BE only: Cisco Unified Communications Manager CDR Analysis and
Reporting (CAR)—Generates Cisco Unified Communications Manager reports for Quality of
Service, traffic, and billing information through Cisco Unified Communications Manager CDR
Analysis and Reporting (CAR). For more information, refer to the CDR Analysis and Reporting
Administration Guide.

Cisco Unified Serviceability Administration Guide
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Note

Remote Serviceability Tools

e Unified CM and Unified CM BE only: Cisco Unified Communications Manager Dialed Number
Analyzer—Allows you to test and diagnose a deployed Cisco Unified Communications Manager
dial plan configuration, analyze the test results, and use the results to tune the dial plan. For more
information on how to access and use Dialed Number Analyzer, refer to the Cisco Unified
Communications Manager Dialed Number Analyzer Guide.

e Unified CM and Unified CM BE only: Cisco Unified Reporting Web Application—Allows you to
inspect or troubleshoot data for a standalone server or a cluster. This application, which is separate
from Cisco Unified Serviceability, combines data by category from all accessible Cisco Unified
Communications Manager servers in a cluster into one output view. Some reports run health checks
to identify conditions that could impact server or cluster operations. If you are an authorized user,
you access Cisco Unified Reporting in the main navigation menu in Cisco Unified Communications
Manager Administration or with the File > Cisco Unified Reporting link on the RTMT menu. Refer
to the Cisco Unified Reporting Administration Guide for more information

On Cisco Unified Communications Manager Business Edition servers, the Cisco Unified Reporting
application captures data for Cisco Unified Communications Manager only. Due to size constraints, the
application does not capture data for Cisco Unity Connection. On these servers, you can use this tool to
gather important information about your Cisco Unified Communications Manager installation.

Remote Serviceability Tools

N

Note

The content in this section does not apply to Cisco Unity Connection.

To supplement the management and administration of the Cisco Unified Communications Manager
system, you can use remote serviceability tools. Using these tools, you can gather system and debug
information for diagnostic help or remote troubleshooting. The tools can process and report on a
collection of local or remote Cisco Unified Communications Manager configuration information. With
customer permission, technical support engineers log on to a Cisco Unified Communications Manager
server and get a desktop or shell that allows them to perform any function that could be done from a local
logon session.

Cisco Unified Communications Manager supports the following capabilities for remote serviceability:

e Simple Network Management Protocol (SNMP)—Provides remote management for managed
devices such as Cisco Unified Communications Manager

e Show Command Line Interface—Displays Cisco Unified Communications Manager system data.

e CiscoWorks Lan Management Solution—Purchased separately from Cisco Unified
Communications Manager, supports maintenance of Cisco networks and devices. The following
features, which serve as examples only, show how you can use CiscoWorks Lan Management
Solution to manage Cisco Unified Communications Manager operations:

Path Analysis defines Cisco Unified Communications Manager system paths in the form of maps,
trace logs, or discovery tables. Path Analysis, which traces connectivity between two specified
points in your network, requires that you enable CDR logging in Cisco Unified Communications
Manager Administration.

Syslog Analysis tools monitor and manage a wide range of events and error messages concurrently
on each Cisco Unified Communications Manager server and other Cisco devices at your site.

[ oL-18619-01
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Bl Customized Log-on Message

Cisco Discovery Protocol (CDP) enables discovery of Cisco Unified Communications Manager
servers and management of those servers by CiscoWorks Lan Management Solution. After you use
the CDP cache MIB of the direct neighboring device to discover Cisco Unified Communications
Manager, you can use CiscoWorks Lan Management Solution to query other Cisco Unified
Communications Manager-supported MIBs for provisions or statistics information about topology
services, user tracking, path analysis, and other network management services. When you use
CiscoWorks Lan Management Solution, you must keep the CDP driver enabled at all times to
discover Cisco Unified Communications Manager.

Customized Log-on Message

You can upload a text file that contains a customized log-on message that appears on the initial Cisco
Unified Serviceability window.

For more information and the procedure for uploading your customized log-on message, refer to the
Cisco Unified Communications Operating System Administration Guide.

Browser Support

Cisco supports these browsers with Cisco Unified Serviceability:
¢ Internet Explorer 6 and 7
e Netscape 7.1

To access Cisco Unified Serviceability, you must browse to the application from a machine that runs the
supported browser.

Note  Cisco Unified Communications Manager CDR Analysis and Reporting, which is a Cisco Unified
Serviceability tool, supports these same browsers. Cisco Unified Real-Time Monitoring Tool, a separate
plug-in, supports a different set of browsers. Refer to the Cisco Unified Real-Time Monitoring Tool
Administration Guide for more information.

Cisco Unified Serviceability uses HTTPS to establish secure connections.

Tip Cisco Unified Serviceability does not support the buttons in your browser. Do not use the browser
controls, for example, the Back button, when you perform configuration tasks.

Where to Find More Information

Additional Cisco Documentation

e Unified CM and Unified CM BE only: Cisco Unified Communications Manager CDR Analysis and
Reporting Administration Guide

e  Unified CM and Unified CM BE only: Cisco Unified Communications Manager Dialed Number
Analyzer Guide

e Unified CM and Unified CM BE only: CiscoWorks Lan Management Solution user documentation

Cisco Unified Serviceability Administration Guide
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Where to Find More Information W

e Cisco Unified Real-Time Monitoring Tool Administration Guide
e Unified CM BE and Connection only: Cisco Unity Connection Serviceability Administration Guide
e Unified CM BE and Connection only: System Administration Guide for Cisco Unity Connection

e Cisco Unified Reporting Administration Guide

Cisco Unified Serviceability Administration Guide
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Using Cisco Unified Serviceability

This chapter comprises the following topics:
e Accessing Cisco Unified Serviceability, page 2-1
¢ Installing the Server Certificate, page 2-2
e Using the Cisco Unified Serviceability Interface, page 2-6
e Using Accessibility Features, page 2-8
¢  Where to Find More Information, page 2-8

Accessing Cisco Unified Serviceability

o

You can access the Serviceability application

¢ Dby entering https://<server name or IP address>:8443/ccmservice/ in a browser window and then
entering a valid username and password.

¢ by choosing Cisco Unified Serviceability in the Navigation menu in the Cisco Unified
Communications Manager Administration console.

¢ Dby choosing Application > Serviceability Webpage in the Real-Time Monitoring Tool (RTMT)
menu and then entering a valid username and password

¢ by choosing Cisco Unified Serviceability in the Navigation menu in Cisco Unity Connection.

After you log in to Cisco Unified Serviceability, you can access all administrative applications that
display in the Navigation menu, except for Cisco Unified OS Administration and Disaster Recovery
System, without logging in again. The web pages that you can access within Cisco Unified Serviceability
depend on your assigned roles and privileges. Cisco Unified OS Administration and Disaster Recovery
System require a separate authentication procedure.

The system uses the Cisco Tomcat service to authenticate users before allowing access to the web
application.

Je

Tip Unified CM and Unified CM BE only: Any user who has the “Standard CCM Admin Users” role
assigned can access Cisco Unified Serviceability. For information on how to assign this role to
a user, refer to the Cisco Unified Communications Manager Administration Guide.
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Installing the Server Certificate

pe

Tip Connection only: Any user who has the System Administrator role or Technician role assigned
can access Cisco Unified Serviceability. For information on how to assign this role to a user,
refer to the User Moves, Adds, and Changes Guide for Cisco Unity Connection.

If you get a security alert that the site is not trusted, this indicates that the server certificate has not yet
downloaded.

To access Cisco Unified Serviceability, perform the following procedure:

Procedure

Step1  In a supported browser, browse to the server where the Cisco Unified Serviceability service runs.

Je

Tip In the supported browser, enter https://<server name or IP address>:8443/ccmservice/, where
server name or [P address equals the server where the Cisco Unified Serviceability service runs
and 8443 equals the port number for HTTPS.

If you enter http://<server name or IP address>:8080 in the browser, the system redirects you to
use HTTP. HTTP uses the port number, 8080.

Step2  If the system prompts you about certificates, see the “Installing the Server Certificate” section on
page 2-2.

Step3  Enter a valid username and password; click Login.

To clear the username and password, click Reset.

Additional Information
See the “Related Topics” section on page 2-8.

Installing the Server Certificate

This section contains information on the following topics:
e HTTPS Overview for Internet Explorer, page 2-3
¢ Installing the Certificate with Internet Explorer 6, page 2-3
¢ Installing the Certificate with Internet Explorer 7, page 2-4
e Installing the Certificate with Netscape, page 2-5

N

Note  For additional information about using HTTPS with Cisco Unified Communications Manager, refer to
Cisco Unified Communications Manager Security Guide.

Cisco Unified Serviceability Administration Guide
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Note

Installing the Server Certificate 1l

Hypertext Transfer Protocol over Secure Sockets Layer (SSL), which secures communication between
the browser client and the Tomcat web server, uses a certificate and a public key to encrypt the data that
is transferred over the internet. HTTPS, which ensures the identity of the server, supports applications,
such as Cisco Unified Serviceability. HTTPS also ensures that the user login password transports
securely via the web.

Due to the way IE 7 handles certificates, this browser displays an error status after you import the server
certificate. This status persists if you reenter the URL or refresh or relaunch the browser and does not
indicate an error. Refer to the “Installing the Certificate with Internet Explorer 7” section on page 2-4
for more information.

HTTPS Overview for Internet Explorer

Note

On the first attempt to access Cisco Unified Serviceability, a Security Alert dialog box, which indicates
that the server is not trusted because the server certificate does not exist in the trusted folder, displays.
When the dialog box displays, perform one of the following tasks:

¢ By clicking Yes, you choose to trust the certificate for the current web session only. If you trust the
certificate for the current session only, the Security Alert dialog box displays each time that you
access the application: that is, until you install the certificate in the trusted folder.

¢ By clicking View Certificate > Install Certificate, you indicate that you intend to perform
certificate installation tasks, so you always trust the certificate. If you install the certificate in the
trusted folder, the Security Alert dialog box does not display each time that you access the web
application.

¢ By clicking No, you cancel the action. No authentication occurs, and you cannot access the web
application.

The system issues the certificate by using the hostname. If you attempt to access a web application by
using the IP address, the Security Alert dialog box displays, even though you installed the certificate.

Additional Information
See the “Related Topics” section on page 2-8.

Installing the Certificate with Internet Explorer 6

Step 1
Step 2

Step 3
Step 4
Step 5

Perform the following procedure to save the HTTPS certificate in the trusted folder.

Procedure

Browse to the application on the Tomcat web server.

When the Security Alert dialog box displays, click View Certificate. To verify certificate details, click
the Details tab.

In the Certificate pane, click Install Certificate.
When the Certificate Import Wizard displays, click Next.

Click the Place all certificates in the following store radio button; click Browse.

[ oL-18619-01
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Step 6
Step 7
Step 8

Step 9

Step 10
Step 11

Browse to Trusted Root Certification Authorities; select it and click OK.
Click Next.

Click Finish.

A Security Warning Box displays the certificate thumbprint for you.

To install the certificate, click Yes.

A message states that the import was successful. Click OK.

In the lower, right corner of the dialog box, click OK.

To trust the certificate, so you do not receive the dialog box again, click Yes.

L

Tip You can verify the certificate was installed successfully by clicking the Certification Path tab in
the Certificate pane.

Additional Information
See the “Related Topics” section on page 2-8.

Installing the Certificate with Internet Explorer 7

Note

Step 1

Internet Explorer 7 adds security features that change the way that the browser handles Cisco certificates
for website access. Because Cisco provides a self-signed certificate for the Cisco Unified
Communications Manager or Cisco Unity Connection server, Internet Explorer 7 flags the Cisco Unified
Communications Manager Administration or Cisco Unity Connection website as untrusted and provides
a certificate error, even when the trust store contains the server certificate.

Internet Explorer 7, which is a Windows Vista feature, also runs on Windows XP Service Pack 2 (SP2),
Windows XP Professional x64 Edition, and Windows Server 2003 Service Pack 1 (SP1). Java Runtime
Environment (JRE) must be present to provide Java-related browser support for IE.

Be sure to import the Cisco Unified Communications Manager or Cisco Unity Connection certificate to
Internet Explorer 7 to secure access without having to reload the certificate every time that you restart
the browser. If you continue to a website that has a certificate warning and the certificate is not in the

trust store, Internet Explorer 7 remembers the certificate for the current session only.

After you download the server certificate, Internet Explorer 7 continues to display certificate errors for
the website. You can ignore the security warnings when the Trusted Root Certificate Authority trust
store for the browser contains the imported certificate.

The following procedure describes how to import the Cisco Unified Communications Manager or
Cisco Unity Connection certificate to the root certificate trust store for Internet Explorer 7.

Procedure

Browse to application on the Tomcat server by entering the hostname (server name) or IP address in the
browser.

Cisco Unified Serviceability Administration Guide
m. OL-18619-01



| Chapter2

Using Cisco Unified Serviceability

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Installing the Server Certificate 1l

The browser displays a Certificate Error: Navigation Blocked message to indicate that this website is
untrusted.

To access the server, click Continue to this website (not recommended)

The administration window displays, and the browser displays the address bar and Certificate Error
status in red.

To import the server certificate, click the Certificate Error status box to display the status report. Click
the View Certificates link in the report.

Verify the certificate details.

The Certification Path tab displays “This CA Root certificate is not trusted because it is not in the
Trusted Root Certification Authorities store.”

Select the General tab in the Certificate window and click Install Certificate.
The Certificate Import Wizard launches.

To start the Wizard, click Next.

The Certificate Store window displays.

Verify that the Automatic option, which allows the wizard to select the certificate store for this
certificate type, is selected and click Next.

Verify the setting and click Finish.

A security warning displays for the import operation.

To install the certificate, click Yes.

The Import Wizard displays “The import was successful.”

Click OK. The next time that you click the View certificates link, the Certification Path tab in the
Certificate window displays “This certificate is OK.”

To verify that the trust store contains the imported certificate, click Tools > Internet Options in the
Internet Explorer toolbar and select the Content tab. Click Certificates and select the Trusted Root
Certifications Authorities tab. Scroll to find the imported certificate in the list.

After importing the certificate, the browser continues to display the address bar and a Certificate Error
status in red. The status persists even if you reenter the hostname or IP address or refresh or relaunch the
browser.

Additional Information
See the “Related Topics” section on page 2-8.

Installing the Certificate with Netscape

When you use HTTPS with Netscape, you can view the certificate credentials, trust the certificate for
one session, trust the certificate until it expires, or not trust the certificate at all.

If you trust the certificate for one session only, you must repeat this procedure each time that you access
the HTTPS-supported application. If you do not trust the certificate, you cannot access the application.
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Using the Cisco Unified Serviceability Interface

N

Note

Step 1

Step 2

Step 3

Step 4

The address that you use to access Cisco Unified Communications Manager or Cisco Unity Connection
must match the name on the certificate or a message will display by default. If you access the web
application by using the IP address after you install the certificate in the trusted folder, a security alert
indicates that the name of the security certificate does not match the name of the site that you are
accessing.

Perform the following procedure to save the certificate to the trusted folder:

Procedure

Browse to the application, for example, Cisco Unified Serviceability, by using Netscape.
The certificate authority dialog box displays.
Click one of the following radio buttons:

e Accept this certificate for this session

¢ Do not accept this certificate and do not connect

e Accept this certificate forever (until it expires)

Note If you choose Do not accept, the Cisco Unified Serviceability application does not display.

Note  To view the certificate credentials before you continue, click Examine Certificate. Review the
credentials and click Close.

Click OK.
The Security Warning dialog box displays.
Click OK.

Additional Information
See the “Related Topics” section on page 2-8.

Using the Cisco Unified Serviceability Interface

In addition to performing troubleshooting and service-related tasks in Cisco Unified Serviceability, you
can perform the following tasks:

e Unified CM and Unified CM BE only: To access Dialed Number Analyzer to test and diagnose a
deployed Cisco Unified Communications Manager dial plan configuration, analyze the test results
and use the results to tune the dial plan, activate the Cisco Dialed Number Analyzer service by
choosing Tools > Service Activation and choosing Tools > Dialed Number Analyzer. For more
information on how to use the Dialed Number Analyzer, refer to the Cisco Unified Communications
Manager Dialed Number Analyzer Guide.

Cisco Unified Serviceability Administration Guide
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)

Note

N

Using the Cisco Unified Serviceability Interface Il

Unified CM and Unified CM BE only: To access Cisco Unified Communications Manager CDR
Analysis and Reporting from Tools > CDR Analysis and Reporting, perform the required
procedures, as described in the CDR Analysis and Reporting Administration Guide.

You cannot access the Cisco Unified Communications Manager CDR Analysis and Reporting
tool unless you are a member of the Cisco CAR Administrators user group. Refer to the
“Configuring the CDR Analysis and Reporting Tool” chapter in the CDR Analysis and
Reporting Administration Guide for information on how to become a member of the Cisco CAR
Administrators user group.

To display documentation for a single window, choose Help > This Page in Cisco Unified
Serviceability.

To display a list of documents that are available with this release (or to access the online help index),
choose Help > Contents in Cisco Unified Serviceability.

To verify the version of Cisco Unified Serviceability that runs on the server, choose Help > About
or click the About link in the upper, right corner of the window.

To go directly to the home page in Cisco Unified Serviceability from a configuration window,
choose Cisco Unified Serviceability from the Navigation drop-down list box in the upper, right
corner of the window.

Note In some scenarios, you cannot access the Cisco Unified Serviceability from Cisco Unified OS

Administration. A “Loading, please wait” message displays indefinitely. If the redirect fails, log
out from Cisco Unified OS Administration, select Cisco Unified Serviceability from the
navigation menu, and log in to Cisco Unified Serviceability.

To access other application GUIs, choose the appropriate application from the Navigation
drop-down list box in the upper, right corner of the window; then, click Go.

To log out of Cisco Unified Serviceability, click the Logout link in the upper, right corner of the
Cisco Unified Serviceability window.

In each Cisco Unified Serviceability configuration window, configuration icons display that
correspond to the configuration buttons at the bottom of the window; for example, you can either
click the Save icon or the Save button to complete the task.

Cisco Unified Serviceability does not support the buttons in your browser. Do not use the browser
buttons, for example, the Back button, when you perform configuration tasks.

Wh

en a session has been idle for more than 30 minutes, the Cisco Unified Serviceability user interface

allows you to make changes before indicating that the session has timed out and redirecting you to the
login window. After you log in again, you may have to repeat those changes. This behavior occurs in the

Ala

rm, Trace, Service Activation, Control Center, and SNMP windows. If you know that the session has

been idle for more than 30 minutes, log out by using the Logout button before making any changes in

the

user interface.
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W Using Accessibility Features

Using Accessibility Features

Cisco Unified Serviceability provides functionality for users that allows them to access buttons on the
window without using a mouse. These navigation shortcuts assist visually impaired or blind attendants

to use the application.

Use Table 2-1 as a guide for navigating the interface by using keyboard shortcuts.

Table 2-1 Navigation Shortcuts for Cisco Unified Serviceability
Keystroke Action
Alt Moves focus to the browser menu bar.

Enter

Chooses the item with focus (menu option,
button, and so on.)

Alt, arrow keys

Moves between browser menus.

Alt+underlined letter

Takes you to the menu; for example, Alt+A
moves you to the Alarms menu.

Spacebar

Toggles control; for example, checks and
unchecks a check box.

Tab

Moves focus to the next item in the tab order or to
next control group.

Shift+Tab

Moves focus to the previous item or group in the
tab order.

Arrow keys

Moves among controls within a group.

Home

Moves to the top of the window if more than one
screenful of information exists. Also, moves to
the beginning of a line of user-entered text.

End

Moves to the end of a line of user-entered text.

Moves to the bottom of the window if more than
one screenful of information exists.

Page Up

Scrolls up one screen.

Page Down

Scrolls down one screen.

Where to Find More Information

Related Topics

e Accessing Cisco Unified Serviceability, page 2-1

¢ Installing the Server Certificate, page 2-2

e Using the Cisco Unified Serviceability Interface, page 2-6

e Using Accessibility Features, page 2-8

Additional Cisco Documentation

e Unified CM and Unified CM BE only: Cisco Unified Communications Manager Administration

Guide

Cisco Unified Serviceability Administration Guide
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e Unified CM and Unified CM BE only: Cisco Unified Communications Manager System Guide

e Unified CM and Unified CM BE only: Cisco Unified Communications Manager CDR Analysis and
Reporting Administration Guide

e Unified CM and Unified CM BE only: Cisco Unified Communications Manager Security Guide

e Unified CM and Unified CM BE only: CiscoWorks Lan Management Solution user documentation
e Cisco Unified Real-Time Monitoring Tool Administration Guide

e Unified CM BE and Connection only: Cisco Unity Connection Serviceability Administration Guide

e Unified CM BE and Connection only: System Administration Guide for Cisco Unity Connection

Cisco Unified Serviceability Administration Guide
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Understanding Alarms

This chapter, which provides information on Cisco Unified Serviceability alarms, contains the following
topics:

¢ Understanding Alarms, page 3-1

e Alarm Configuration, page 3-2

e Alarm Definitions, page 3-3

e Viewing Alarm Information, page 3-4

e Alarm Configuration Checklist, page 3-4

¢  Where to Find More Information, page 3-5

Understanding Alarms

Note

Cisco Unified Serviceability alarms provide information on runtime status and the state of the system,
so you can troubleshoot problems that are associated with your system; for example, to identify issues
with the Disaster Recovery System. Alarm information, which includes an explanation and
recommended action, also includes the application name, machine name, and so on, to help you perform
troubleshooting. If you have clusters, this is even true for problems that are not on your local Cisco
Unified Communications Manager or Cisco Unity Connection server.

You configure the alarm interface to send alarm information to multiple locations, and each location can
have its own alarm event level (from debug to emergency). You can direct alarms to the Syslog Viewer
(local syslog), Syslog file (remote syslog), an SDI trace log file, an SDL trace log file (for Cisco
CallManager and CTIManager services only), or to all destinations.

When a service issues an alarm, the alarm interface sends the alarm information to the locations that you
configure (and that are specified in the routing list in the alarm definition) (for example, SDI trace). The
system can either forward the alarm information, as is the case with SNMP traps, or the system can write
the alarm information to its final destination (such as a log file).

Cisco Unified Communications Manager supports SNMP traps in Cisco Unified Communications
Manager and Cisco Unified Communications Manager Business Edition systems. Cisco Unity
Connection SNMP does not support traps.
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£
Tip

For the Remote Syslog Server, do not specify a Cisco Unified Communications Manager server, which
cannot accept syslog messages from other servers.

You use the Trace and Log Central option in the Cisco Unified Real-Time Monitoring Tool (RTMT) to
collect alarms that get sent to an SDI trace log file or SDL trace log file (for Cisco CallManager and
CTIManager services only). You use the SysLog Viewer in RTMT to view alarm information that gets
sent to the local syslog.

Alarm Configuration

You can configure alarms for services, such as Cisco Database Layer Monitor, in Cisco Unified
Serviceability. Then, you configure the location(s), such as Syslog Viewer (local syslog), where you
want the system to send the alarm information. With this option, you can

e Configure alarms for services on a particular server or on all servers (Unified CM clusters only)
¢ Configure different remote syslog servers for the configured service(s) or server(s)
e Configure different alarm event level settings for different destinations

Cisco Syslog Agent enterprise parameters in Cisco Unified Communications Manager Administration
allow you to forward all alarms that meet or exceed the configured threshold to a remote syslog server
with these two settings: remote syslog server name and syslog severity. To access these Cisco Syslog
Agent parameters, go to the applicable window for your configuration:

Cisco Unified Communications Manager In Cisco Unified Communications Manager Administration,
choose System > Enterprise Parameters.

Cisco Unified Communications Manager In Cisco Unified Communications Manager Administration,

Business Edition choose System > Enterprise Parameters.

Cisco Unity Connection In Cisco Unity Connection Administration, choose System

Setting > Enterprise Parameters.

The alarms include system (OS/hardware platform), application (services), and security alarms. If you
have a Cisco Unified Communications Manager Business Edition server, the system also forwards
Cisco Unity Connection alarms.

Note  If you configure both the Cisco Syslog Agent alarm enterprise parameters and application (service)
alarms in Cisco Unified Serviceability, the system can send the same alarm to the remote syslog twice.

If local syslog is enabled for an application alarm, the system sends the alarm to the enterprise remote
syslog server only when the alarm exceeds both the local syslog threshold and the enterprise threshold.

If remote syslog is also enabled in Cisco Unified Serviceability, the system forwards the alarm to the
remote syslog server by using the application threshold that is configured in Cisco Unified
Serviceability, which may result in the alarm getting sent to the remote syslog server twice.

The event level/severity settings provide a filtering mechanism for the alarms and messages that the
system collects. This setting helps to prevent the Syslog and trace files from becoming overloaded. The
system forwards only alarms and messages that exceed the configured threshold.

Cisco Unified Serviceability Administration Guide
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Alarm Definitions

For more information about the severity levels attached to alarms and events, see the “Alarm
Definitions” section on page 3-3.

Alarm Definitions

Used for reference, alarm definitions describe alarm messages: what they mean and how to recover from
them. You search the Alarm Definitions window for alarm information. When you click any
service-specific alarm definition, a description of the alarm information (including any user-defined text
that you have added) and a recommended action display.

You can search for definitions of all alarms that display in Cisco Unified Serviceability. To aid you with
troubleshooting problems, the definitions, which exist in a corresponding catalog, include the alarm
name, description, explanation, recommended action, severity, parameters, monitors, and so on.

When the system generates an alarm, it uses the alarm definition name in the alarm information, so you
can identify the alarm. In the alarm definition, you can view the routing list, which specifies the locations
where the system can send the alarm information. The routing list may include the following locations,
which correlate to the locations that you can configure in the Alarm Configuration window:

e Unified CM and Unified CM BE only: SDL—The system sends the alarm information to the SDL
trace if you enable the alarm for this option and specify an appropriate event level in the Alarm
Configuration window.

e SDI —The system sends the alarm information to the SDI trace if you enable the alarm for this
option and specify an appropriate event level in the Alarm Configuration window.

e Sys Log—The system sends the alarm information to the remote syslog server if you enable the
alarm for this option, specify an appropriate event level in the Alarm Configuration window, and
enter a server name or IP address for the remote syslog server.

e Event Log—The system sends the alarm information to the local syslog, which you can view in the
SysLog Viewer in the Cisco Unified Real-Time Monitoring Tool (RTMT), if you enable the alarm
for this option and specify an appropriate event level in the Alarm Configuration window.

e Data Collector—System sends the alarm information to the real-time information system (RIS data
collector) (for alert purposes only). You cannot configure this option in the Alarm Configuration
window.

e Unified CM and Unified CM BE only: SNMP Traps—System generates an SNMP trap. You cannot
configure this option in the Alarm Configuration window.

Note  Cisco Unified Communications Manager supports SNMP traps in Unified CM and Unified CM
BE systems. Cisco Unity Connection SNMP does not support traps in either Unified CM BE or
Connection systems.

Tip If the SNMP Traps location displays in the routing list, the system forwards the alarm
information to the CCM MIB SNMP agent, which generates the appropriate traps according to
the definition in CISCO-CCM-MIB.

The system sends an alarm if the configured alarm event level for the specific location in the Alarm
Configuration window is equal to or lower than the severity that is listed in the alarm definition. For
example, if the severity in the alarm definition equals WARNING_ALARM, and, in the Alarm
Configuration window, you configure the alarm event level for the specific destination as Warning,
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Notice, Informational, or Debug, which are lower event levels, the system sends the alarm to the
corresponding destination. If you configure the alarm event level as Emergency, Alert, Critical, or Error,
the system does not send the alarm to the corresponding location.

For each Cisco Unified Serviceability alarm definition, you can include an additional explanation or
recommendation. All administrators have access to the added information. You directly enter
information into the User Defined Text pane that displays in the Alarm Details window. Standard
horizontal and vertical scroll bars support scrolling. Cisco Unified Serviceability adds the information
to the database.

Viewing Alarm Information

Tip

You view alarm information to determine whether problems exist. The method that you use to view the
alarm information depends on the destination that you chose when you configured the alarm. You can
view alarm information that is sent to the SDI trace log file, or SDL trace log file (Cisco Unified
Communications Manager and Cisco Unified Communications Manager Business Edition only) by
using the Trace and Log Central option in RTMT or by using a text editor. You can view alarm
information that gets sent to local syslog by using the SysLog Viewer in RTMT.

Unified CM and Unified CM BE only: For Cisco Unified Communications Manager, you can also use
CiscoWorks Lan Management Solution report viewer to view remote syslog messages.

Alarm Configuration Checklist

Table 3-1 provides an overview of the steps for configuring alarms.

Cisco Unified Serviceability Administration Guide
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Table 3-1

Alarm Configuration Checklist

Where to Find More Information

Configuration Steps

Related Procedures and Topics

Step 1

In Cisco Unified Communications Manager
Administration or in Cisco Unity Connection
Administration, configure the Cisco Syslog Agent
enterprise parameters to send system, application
(services), and security alarms/messages to a remote
syslog server that you specify.

Skip this step to configure application (services)
alarms/messages in Cisco Unified Serviceability.

e Configuring the Cisco Syslog Agent Enterprise
Parameters, page 4-1

Step 2

In Cisco Unified Serviceability, configure the server(s),
service(s), destination(s), and event level(s) for the
applications (services) alarm information that you want
to collect.

e All services can go to the SDI log (but must be
configured in Trace also).

e All services can go to the SysLog Viewer.

e Unified CM and Unified CM BE only: Only the
Cisco CallManager and Cisco CTIManager
services use the SDL log.

e To send syslog messages to the Remote Syslog
Server, check the Remote Syslog destination and
specify a host name. If you do not configure the
remote server name, Cisco Unified Serviceability
does not send the Syslog messages to the remote
syslog server.

Tip Do not configure a Cisco Unified
Communications Manager server as a remote

Syslog server.

e Understanding Alarms, page 3-1
e Configuring an Alarm for a Service, page 4-2

e Alarm Configuration Settings, page 4-4

Step 3

(Optional) Add a definition to an alarm.

e Alarm Definitions, page 3-3
e Viewing and Updating Alarm Definitions, page 5-1

Step 4

If you chose an SDI trace file or SDL trace file (Unified
CM and Unified CM BE only) as the alarm destination,
collect traces and view the information with the Trace

and Log Central option in RTMT.

Cisco Unified Real-Time Monitoring Tool
Administration Guide

Step 5

If you chose local syslog as the alarm destination, view
the alarm information in the SysLog Viewer in RTMT.

Cisco Unified Real-Time Monitoring Tool
Administration Guide

Step 6

See the corresponding alarm definition for the
description and recommended action.

Viewing Alarm Definitions and Adding User-Defined
Descriptions, page 5-1

Where to Find More Information

Related Topics

¢ Configuring the Cisco Syslog Agent Enterprise Parameters, page 4-1
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e Configuring an Alarm for a Service, page 4-2

e Viewing Alarm Definitions and Adding User-Defined Descriptions, page 5-1

e System Alarm Catalog Descriptions, page 5-2

e Unified CM and Unified CM BE only: CallManager Alarm Catalog Descriptions, page 5-3

Additional Cisco Documentation

e Cisco Unified Real-Time Monitoring Tool Administration Guide

e Unified CM BE and Connection only: Cisco Unity Connection Serviceability Administration Guide
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Configuring Alarms

This chapter contains the following topics:
e Configuring the Cisco Syslog Agent Enterprise Parameters, page 4-1
e Configuring an Alarm for a Service, page 4-2
e Service Groups in Alarm Configuration, page 4-3
e Alarm Configuration Settings, page 4-4
¢ Where to Find More Information, page 4-6

Configuring the Cisco Syslog Agent Enterprise Parameters

You can configure the Cisco Syslog Agent enterprise parameters to send system, application, and
security alarms/messages that exceed the configured threshold to a remote syslog server that you
specify. To access the Cisco Syslog Agent parameters, go to the applicable window for your

configuration:

Cisco Unified Communications In Cisco Unified Communications Manager Administration,

Manager choose System > Enterprise Parameters.

Cisco Unified Communications In Cisco Unified Communications Manager Administration,

Manager Business Edition choose System > Enterprise Parameters.

Cisco Unity Connection In Cisco Unity Connection Administration, choose System
Setting > Enterprise Parameters.

Next, configure the remote syslog server name and syslog severity. Then click Save. For the valid values
to enter, click the? button. If the server name is not specified, Cisco Unified Serviceability does not send
the Syslog messages.

Note Do not configure a Cisco Unified Communications Manager as a remote syslog server. The Cisco
Unified Communications Manager server does not accept Syslog messages from another server.

Cisco Unified Serviceability Administration Guide
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Configuring an Alarm for a Service

N

Note

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

This section describes how to add or update an alarm for a feature or network service that you manage
through Cisco Unified Serviceability.

Cisco recommends that you do not change SNMP Trap and Catalog configurations.

Cisco Unity Connection also uses alarms, which are available in Cisco Unity Connection Serviceability.
You cannot configure alarms in Cisco Unity Connection Serviceability. For details, see the Cisco Unity
Connection Serviceability Administration Guide.

Refer to your online OS documentation for more information on how to use your standard registry editor.

Procedure

Choose Alarm > Configuration.
The Alarm Configuration window displays.

From the Server drop-down list box, choose the server for which you want to configure the alarm; then,
click Go.

From the Service Group drop-down list box, choose the category of service, for example, Database and
Admin Services, for which you want to configure the alarm; then, click Go.

Je

Tip For a list of services that correspond to the service groups, see Table 4-1.

From the Service drop-down list box, choose the service for which you want to configure the alarm; then,
click Go.

Only services that support the service group and your configuration display.

Je

Tip The drop-down list box displays active and inactive services.

In the Alarm Configuration window, a list of alarm monitors with the event levels displays for the chosen
service.In addition, the Apply to All Nodes check box displays.

Unified CM only: If you want to do so, you can apply the alarm configuration for the service to all servers
in the cluster by checking the Apply to All Nodes check box, provided your configuration supports
clusters.

Configure the settings, as described in Table 4-2, which includes descriptions for monitors and event
levels.

To save your configuration, click the Save button.

~

Note  To set the default, click the Set Default button; then, click Save.

Cisco Unified Serviceability Administration Guide
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Step 1
Step 2

Step 3
Step 4
Step 5

Step 6

Step 7

Service Groups in Alarm Configuration

Services That Use Cisco Tomcat

The following services use Cisco Tomcat for alarm generation:
e Cisco Extension Mobility Application
e Cisco IP Manager Assistant
e Cisco Extension Mobility
¢ Cisco Web Dialer Web

The system login alarm AuthenticationFailed also uses Cisco Tomcat. To generate alarms for these
services, perform the following procedure.

Procedure

In Cisco Unified Serviceability, choose Alarm > Configuration.

From the Server drop-down list box, choose the server for which you want to configure the alarm; then,
click Go.

From the Services Group drop-down list box, choose Platform Services; then, click Go.
From the Services drop-down list box, choose Cisco Tomcat; then, click Go.

Unified CM only: If you want to do so, you can apply the alarm configuration for the service to all servers
in the cluster by checking the Apply to All Nodes check box, if your configuration supports clusters.

Configure the settings, as described in Table 4-2, which includes descriptions for monitors and event
levels.

To save your configuration, click the Save button.

L

Tip The system sends the alarm if the configured alarm event level for the specific destination in the
Alarm Configuration window is equal to or lower than the severity that is listed in the alarm
definition. For example, if the severity in the alarm definition equals WARNING_ALARM, and,
in the Alarm Configuration window, you configure the alarm event level for the specific
destination as Warning, Notice, Informational, or Debug, which are lower event levels, the
system sends the alarm to the corresponding destination. If you configure the alarm event level
as Emergency, Alert, Critical, or Error, which are higher severity levels, the system does not
send the alarm to the corresponding location.

To access the alarm definitions for the Cisco Extension Mobility Application service, Cisco IP
Manager Assistant service, Cisco Extension Mobility service, and the Cisco Web Dialer Web
Service, choose the JavaApplications catalog in the Alarm Messages Definitions window
described in Chapter 5, “Viewing and Updating Alarm Definitions”.

Additional Information
See the “Related Topics” section on page 4-6.

Service Groups in Alarm Configuration

Table 4-1 lists the services that correspond to the options in the Service Group drop-down list box in the
Alarm Configuration window.

[ oL-18619-01
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N

Note

Table 4-1

Not all listed service groups and services apply to all system configurations.

Service Groups in Alarm Configuration

Service Group

Services

Notes

CM Services

Cisco CTIManager, Cisco CallManager, Cisco CallManager
Cisco IP Phone Service, Cisco DHCP Monitor Service, Cisco
Dialed Number Analyzer, Cisco Extended Functions, Cisco IP
Voice Media Streaming App, Cisco Messaging Interface, and
Cisco Tftp

For a description of these services, see the
“Understanding Services” section on
page 9-1.

CTI Services

Cisco CallManager Attendant Console Server

For a description of these services, see the
“Understanding Services” section on
page 9-1.

CDR Services

Cisco CDR Agent and Cisco CDR Repository Manager

For a description of these services, see the
“Understanding Services” section on
page 9-1.

Database and
Admin Services

Cisco Bulk Provisioning Service, Cisco Database Layer
Monitor, and Cisco License Manager

For a description of these services, see the
“Understanding Services” section on
page 9-1.

Performance Cisco AMC Service and Cisco RIS Data Collector For a description of these services, see the

and Monitoring “Understanding Services” section on

Services page 9-1.

Directory Cisco DirSync For a description of this service, see the

Services “Understanding Services” section on
page 9-1.

Backup and Cisco DRF Local and Cisco DRF Master For a description of these services, see the

Restore “Understanding Services” section on

Services page 9-1.

System Cisco Trace Collection Service For a description of these services, see the

Services “Understanding Services” section on
page 9-1.

Platform Cisco Tomcat For a description of this service, see the

Services “Understanding Services” section on

page 9-1.

Alarm Configuration Settings

Table 4-2 describes all alarm configuration settings, even though the service may not support the
settings. For related procedures, see the “Related Topics” section on page 4-6.

l_ Cisco Unified Serviceability Administration Guide
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Alarm Configuration Settings

Table 4-2 Alarm Configuration Settings
Name Description
Server From the drop-down box, choose the server for which you

want to configure the alarm; then, click Go.

Service Group Cisco Unity Connection supports only the following service
groups: Database and Admin Services, Performance and
Monitoring Services, Backup and Restore Services, System
Services, and Platform Services.

From the drop-down box, choose the category of services, for
example, Database and Admin Services, for which you want to
configure the alarm; then, click Go.

Service From the Service drop-down box, choose the service for which
you want to configure the alarm; then, click Go.

Only services that support the service group and your
configuration display.

Tip The drop-down list box displays active and inactive
services.
Unified CM only: To apply the alarm settings for the service to all servers in a

Apply to All Nodes cluster, check the check box.

Enable Alarm for Local Syslogs The SysLog viewer serves as the alarm destination. The
program logs errors in the Application Logs within SysLog
Viewer and provides a description of the alarm and a
recommended action. You can access the SysLog Viewer from
the Cisco Unified Real-Time Monitoring Tool.

For information on viewing logs with the SysLog Viewer,
refer to the Cisco Unified Real-Time Monitoring Tool
Administration Guide.

Enable Alarm for Remote Syslogs The Syslog file serves as the alarm destination. Check this
check box to enable the Syslog messages to be stored on a
Syslog server and to specify the Syslog server name. If this
destination is enabled and no server name is specified, Cisco
Unified Serviceability does not send the Syslog messages.

Tip In the Server field, enter the name or IP address of the
remote Syslog server that you want to use to accept
Syslog messages. For example, if you want to send the
alarms to CiscoWorks Lan Management Solution,
specify the CiscoWorks Lan Management Solution
server name.

Tip Do not specify a Cisco Unified Communications
Manager server as the destination because the Cisco
Unified Communications Manager server does not
accept Syslog messages from another server.

Cisco Unified Serviceability Administration Guide
[ oL-18619-m .m



Chapter4  Configuring Alarms |

[ | Where to Find More Information

Table 4-2 Alarm Configuration Settings (continued)
Name Description
Enable Alarm for SDI Trace The SDI trace library serves as the alarm destination.

To log alarms in the SDI trace log file, check this check box
and check the Trace On check box in the Trace Configuration
window for the chosen service. For information on
configuring settings in the Trace Configuration window in
Cisco Unified Serviceability, see the “Configuring Trace
Parameters” section on page 7-1.

Unified CM and Unified CM BE only: |The SDL trace library serves as the alarm destination. This
Enable Alarm for SDL Trace destination applies on.ly to the Cisco CgllManager s§rvi?e and
the CTIManager service. Configure this alarm destination by
using Trace SDL configuration.

To log alarms in the SDL trace log file, check this check box
and check the Trace On check box in the Trace Configuration
window for the chosen service. For information on
configuring settings in the Trace Configuration window in
Cisco Unified Serviceability, see the “Configuring Trace
Parameters” section on page 7-1.

Alarm Event Level From the drop-down list box, choose one of the following
options:

¢ Emergency—This level designates system as unusable.

e Alert—This level indicates that immediate action is
needed.

¢ Critical—The system detects a critical condition.
e Error—This level signifies an error condition exists.

e Warning—This level indicates that a warning condition
is detected.

e Notice—This level designates a normal but significant
condition.

e Informational—This level designates information
messages only.

e Debug—This level designates detailed event information
that Cisco TAC engineers use for debugging.

Where to Find More Information

Related Topics
e Configuring the Cisco Syslog Agent Enterprise Parameters, page 4-1

e Configuring an Alarm for a Service, page 4-2
e Service Groups in Alarm Configuration, page 4-3

e Alarm Configuration Settings, page 4-4

Cisco Unified Serviceability Administration Guide
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Where to Find More Information W

e Understanding Alarms, page 3-1

Additional Cisco Documentation
e Cisco Unified Real-Time Monitoring Tool Administration Guide

e Unified CM BE and Connection only: Cisco Unity Connection Serviceability Administration Guide

Cisco Unified Serviceability Administration Guide
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Viewing and Updating Alarm Definitions

This chapter, which provides procedural information to search, view, and create user information for
alarm definitions that display in Cisco Unified Serviceability, contains the following topics:

e Viewing Alarm Definitions and Adding User-Defined Descriptions, page 5-1
e System Alarm Catalog Descriptions, page 5-2

e CallManager Alarm Catalog Descriptions, page 5-3

e Where to Find More Information, page 5-4

Viewing Alarm Definitions and Adding User-Defined
Descriptions

Step 1

Step 2

Step 3

Step 4

This section describes how to search for and view an alarm definition in Cisco Unified Serviceability.

Unified CM BE and Connection only: You can view Cisco Unity Connection alarm definitions in
Cisco Unity Connection Serviceability. You cannot add user-defined descriptions to alarm definitions
in Cisco Unity Connection Serviceability.

Cisco Unity Connection also uses certain alarm definitions in Cisco Unified Serviceability, and they
must be viewed in Cisco Unified Serviceability. Be aware that alarms that are associated with the
catalogs in Table 5-1 are available for viewing.

Procedure

In Cisco Unified Serviceability, choose Alarm > Definitions.
The Alarm Message Definitions window displays.

From the Find alarms where drop-down list box, choose the catalog for which you want to view the
definitions.

From the Equals drop-down list box, choose a catalog of alarm definitions or enter the alarm name in
the Enter Alarm Name field. For a list of System Alarm Catalog options, see Table 5-1. For a list of
CallManager Alarm Catalog options (Unified CM and Unified CM BE only), see Table 5-2.

Click the Find button.

The definitions list displays for the alarm catalog that you chose.

[ oL-18619-01
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| System Alarm Catalog Descriptions

Je

Tip Multiple pages of alarm definitions may exist. To choose another page, click the appropriate
navigation button at the bottom of the Alarm Message Definitions window or enter a page
number in the Page field. To change the number of alarms that display in the window, choose a
different value from the Rows per Page drop-down list box.

Step5  In the list, click the hyperlink alarm definition for which you want to view alarm details, such as a
description, alarm severity, and so on.

The Alarm Information window displays.

Step6  If you want to add information to the alarm, enter text in the User Defined Text pane and click the Save
button.

L

ﬁ To delete the description from the User Defined Text pane, click the Clear All button.

Step 7 To return to the Alarm Message Definitions window, choose Back to Find/List Alarms from the
Related Links drop-down list box; then, click Go.

Additional Information
See the “Related Topics” section on page 5-4.

System Alarm Catalog Descriptions

Table 5-1 contains the System Alarm Catalog alarm descriptions. The System Alarm Catalog supports
Cisco Unified Communications Manager and Cisco Unity Connection.

Table 5-1 System Catalogs

Name Description

ClusterManagerAlarmCatalog All cluster manager alarm definitions that are related to the establishment of
security associations between servers in a cluster.

DBAlarmCatalog All Cisco database (aupair) alarm definitions

DRFAlarmCatalog All Disaster Recovery System alarm definitions

GenericAlarmCatalog All generic alarm definitions that all applications share

Cisco Unified Serviceability Administration Guide
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CallManager Alarm Catalog Descriptions

Table 5-1 System Catalogs (continued)
Name Description
JavaApplications All Java Applications alarm definitions.

Tip Unified CM and Unified CM BE only: Cisco License Manager, which
supports Cisco Unified Communications Manager, uses this catalog.

Tip You cannot configure JavaApplications alarms by using the alarm
configuration GUI. For Cisco Unified Communications Manager and
Cisco Unity Connection, you generally configure these alarms to go to the
Event Logs; for Cisco Unified Communications Manager, you can
configure these alarms to generate SNMP traps to integrate with
CiscoWorks Lan Management Solution. Use the registry editor that is
provided with your operating system to view or change alarm definitions
and parameters.

LoginAlarmCatalog All login-related alarm definitions

LpmTctCatalog All log partition monitoring and trace collection alarm definitions
RTMTAlarmCatalog All Cisco Unified Real-Time Monitoring Tool alarm definitions
SystemAccessCatalog All alarm definitions that are used for tracking whether SystemAccess provides all

thread statistic counters together with all the process statistic counters.

ServiceManagerAlarmCatalogs

All service manager alarm definitions that are related to the activation,
deactivation, starting, restarting, and stopping of services.

TFTPAlarmCatalog

All Cisco TFTP alarm definitions

TestAlarmCatalog

All alarm definitions that are used for sending test alarms through SNMP traps
from the Command Line Interface (CLI). For information on the CLI, refer to the
Command Line Interface Reference Guide for Cisco Unified Solutions.

Tip Cisco Unified Communications Manager supports SNMP traps in Unified
CM and Unified CM BE systems. Cisco Unity Connection SNMP does not
support traps in either Unified CM BE or Connection systems.

CertMonitorAlarmCatalog

All certificate expiration definitions.

IMSAlarmCatalog

All user authentication and credential definitions.

Additional Information

See the “Related Topics” section on page 5-4.

CallManager Alarm Catalog Descriptions

The information in this section does not apply to Cisco Unity Connection.

Table 5-2 contains the CallManager Alarm Catalog descriptions.

Table 5-2 CallManager Alarm Catalog
Name Description
CallManager All Cisco CallManager service alarm definitions
CDRRepAlarmCatalog All CDRRep alarm definitions
Cisco Unified Serviceability Administration Guide
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Table 5-2 CallManager Alarm Catalog (continued)

Name Description

CARAlarmCatalog All CDR analysis and reporting alarm definitions

CEFAlarmCatalog All Cisco Extended Functions alarm definitions

CMIAlarmCatalog All Cisco messaging interface alarm definitions

CtiManagerAlarmCatalog All Cisco computer telephony integration (CTI) manager alarm definitions
IpVmsAlarmCatalog All IP voice media streaming applications alarm definitions
TCDSRVAlarm Catalog All Cisco telephony call dispatcher service alarm definitions

Phone Alarms for phone-related tasks, such as downloads

Additional Information

See the “Related Topics” section on page 5-4.

Where to Find More Information

Related Topics
e Understanding Alarms, page 3-1

e Viewing Alarm Definitions and Adding User-Defined Descriptions, page 5-1
e System Alarm Catalog Descriptions, page 5-2
e Unified CM and Unified CM BE only: CallManager Alarm Catalog Descriptions, page 5-3

Cisco Unified Serviceability Administration Guide
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Understanding Trace

This chapter, which provides information on Cisco Unified Serviceability trace, contains the following
topics:

e Understanding Trace, page 6-1

e Trace Configuration, page 6-2

e Troubleshooting Trace Settings, page 6-2

e Trace Collection, page 6-3

e Trace Configuration and Collection Checklist, page 6-3
¢ Where to Find More Information, page 6-6

Understanding Trace

Cisco Unified Serviceability provides trace tools to assist you in troubleshooting issues with your voice
application. Cisco Unified Serviceability supports SDI (System Diagnostic Interface) trace, SDL
(Signaling Distribution Layer) trace (for Cisco CallManager and Cisco CTIManager services, applicable
to Cisco Unified Communications Manager and Cisco Unified Communications Manager Business
Edition only), and Log4]J trace (for Java applications).

You use the Trace Configuration window to specify the level of information that you want traced as well
the type of information that you want to be included in each trace file.

Unified CM and Unified CM BE only: If the service is a call-processing application such as Cisco
CallManager or Cisco CTIManager, you can configure a trace on devices such as phones and gateway.

(Unified CM and Unified CM BE only: In the Alarm Configuration window, you can direct alarms to
various locations, including SDI trace log files, or SDL trace log files. If you want to do so, you can
configure trace for alerts in the Cisco Unified Real-Time Monitoring Tool (RTMT).

After you have configured information that you want to include in the trace files for the various services,
you can collect and view trace files by using the trace and log central option in the Cisco Unified
Real-Time Monitoring Tool.

[ oL-18619-01
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Trace Configuration

You can configure trace parameters for any feature or network service that displays in Cisco Unified
Serviceability. If you have clusters (Cisco Unified Communications Manager only), you can configure
trace parameters for any feature or network service that is available on any Cisco Unified
Communications Manager server in the cluster. Use the Trace Configuration window to specify the
parameters that you want to trace for troubleshooting problems.

You can configure the level of information that you want traced (debug level), what information you
want to trace (trace fields), and information about the trace files (such as number of files per service,
size of file, and time that the data is stored in the trace files.) If you have clusters (Cisco Unified
Communications Manager only), you can configure trace for a single service or apply the trace settings
for that service to all servers in the cluster.

Unified CM and Unified CM BE only: If the service is a call-processing application such as Cisco
CallManager or Cisco CTIManager, you can configure a trace on devices such as phones and gateways;

for example, you can narrow the trace to all enabled phones with a directory number beginning with 555.

If you want to use predetermined troubleshooting trace settings rather than choosing your own trace
fields, you can use the Troubleshooting Trace window. For more information on troubleshooting trace,
see the “Troubleshooting Trace Settings” section on page 6-2.

After you have configured information that you want to include in the trace files for the various services,
you can collect trace files by using the trace and log central option in RTMT. For more information
regarding trace collection, see the “Trace Collection” section on page 6-3.

Troubleshooting Trace Settings

Note

The Troubleshooting Trace Settings window allows you to choose the services in Cisco Unified
Serviceability for which you want to set predetermined troubleshooting trace settings. In this window,
you can choose a single service or multiple services and change the trace settings for those services to
the predetermined trace settings. If you have clusters (Cisco Unified Communications Manager only),
you can choose the services on different Cisco Unified Communications Manager servers in the cluster,
so the trace settings of the chosen services get changed to the predetermined trace settings. You can
choose specific activated services for a single server, all activated services for the server, specific
activated services for all servers in the cluster, or all activated services for all servers in the cluster. In
the window, N/A displays next to inactive services.

The predetermined troubleshooting trace settings for a Cisco Unified Communications Manager feature
or network service include SDL (Cisco Unified Communications Manager and Cisco Unified
Communications Manager Business Edition only), SDI, and Log4;j trace settings. Before the
troubleshooting trace settings get applied, the system backs up the original trace settings. When you reset
the troubleshooting trace settings, the original trace settings get restored.

When you open the Troubleshooting Trace Settings window after you apply troubleshooting trace
settings to a service, the service that you set for troubleshooting displays as checked. In the
Troubleshooting Trace Settings window, you can reset the trace settings to the original settings.

After you apply Troubleshooting Trace Setting to a service, the Trace Configuration window displays a
message that troubleshooting trace is set for the given service(s). From the Related Links drop-down list
box, you can choose the Troubleshooting Trace Settings option if you want to reset the settings for the

Cisco Unified Serviceability Administration Guide
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Trace Collection W

service. For the given service, the Trace Configuration window displays all the settings as read-only,
except for some parameters of trace output settings; for example, Maximum No. of Files. You can
modify these parameters even after you apply troubleshooting trace settings.

Trace Collection

Tip

Tip

Note

Use Trace and Log Central, an option in the Cisco Unified Real-Time Monitoring Tool, to collect, view,
and zip various service traces and/or other log files. With the Trace and Log Central option, you can
collect SDL/SDI traces, Application Logs, System Logs (such as Event View Application, Security, and
System logs), and crash dump files.

To collect CSA logs, check the Cisco Security Agent check box in the Select System Logs tab in RTMT.
To access user logs that provide information about users that are logging in and out, check the Security
Logs check box in the Select System Logs tab.

Do not use NotePad to view collected trace files.

Unified CM and Unified CM BE only: For devices that support encryption, the SRTP keying material
does not display in the trace file.

For more information on trace collection, refer to the Cisco Unified Real-Time Monitoring Tool
Administration Guide.

Trace Configuration and Collection Checklist

Table 6-1 provides an overview of the steps for configuring and collecting trace for feature and network
services in Cisco Unified Serviceability.

[ oL-18619-01

Cisco Unified Serviceability Administration Guide g



Chapter 6  Understanding Trace

| Trace Configuration and Collection Checklist

Table 6-1

Trace Configuration and Collection Checklist

Configuration Steps

Related Procedures and Topics

Step 1 Do the applicable step: e Unified CM and Unified CM BE only: Cisco Unified
e Unified CM and Unified CM BE only: Choose Communications Manager Administration Guide
System > Enterprise Parameters in Cisco Unified | ® Connection only: System Administration Guide for
Communications Manager Administration and Cisco Unity Connection
configure the maximum number of devices that are
available for tracing. Enter a value in the Max
Number of Device Level Trace field. The default
specifies 12.
e Connection only: Choose System Settings >
Enterprise Parameters in Cisco Unity Connection
Administration and configure the maximum
number of devices that are available for tracing.
Enter a value in the Max Number of Device Level
Trace field. The default specifies 12.
Step 2 If you want to enable trace compression, do the e Configuring Trace and Log Central in RTMT, Cisco
applicable step: Unified Real-Time Monitoring Tool Administration
e Unified CM and Unified CM BE only: Choose Guide
System > Enterprise Parameters in Cisco Unified | ®© Unified CM and Unified CM BE only: Cisco Unified
Communications Manager Administration and set Communications Manager Administration Guide
the value of the Trace Compression parameter to e Connection only: System Administration Guide for
Enabled. Cisco Unity C i
isco Unity Connection
e Connection only: Choose System Settings >
Enterprise Parameters in Cisco Unity Connection
Administration and set the value of the Trace
Compression parameter to Enabled.
Step 3 Configure the values of the TLC Throttling CPU Goal | e Configuring Trace and Log Central in RTMT, Cisco

and TLC Throttling IOWait Goal service parameters
(Cisco RIS Data Collector service) by doing the
applicable step:

e Unified CM and Unified CM BE only: Choose
System > Service Parameters in Cisco Unified
Communications Manager Administration and
configure the values of the TLC Throttling CPU
Goal and TLC Throttling IOWait Goal service
parameters (Cisco RIS Data Collector service).

e Connection only: Choose System Settings >
Service Parameters in Cisco Unity Connection
Administration and configure the values of the TLC
Throttling CPU Goal and TLC Throttling IOWait
Goal service parameters (Cisco RIS Data Collector
service).

Unified Real-Time Monitoring Tool Administration
Guide

e Unified CM and Unified CM BE only: Cisco Unified
Communications Manager Administration Guide

e Connection only: System Administration Guide for
Cisco Unity Connection

Cisco Unified Serviceability Administration Guide
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Table 6-1

Trace Configuration and Collection Checklist

Trace Configuration and Collection Checklist (continued)

Configuration Steps

Related Procedures and Topics

Step 4 Configure the trace setting for the service for which you | ¢ Understanding Trace, page 6-1
want to collect traces. If you have clusters (Cisco —_
o R e Configuring Trace, page 7-1
Unified Communications Manager only), you can o . .
configure trace for the service on one server or on all * Configuring Troubleshooting Trace Settings,
servers in the cluster. page 8-1
To configure trace settings, choose what information
you want to include in the trace log by choosing the
debug level and trace fields.
Unified CM and Unified CM BE only: You can also
configure trace for specific devices if you are
configuring trace for the Cisco CallManager service or
the Cisco CTIManager service.
If you want to run predetermined traces on services, set
troubleshooting trace for those services.
Step 5 Install the Cisco Unified Real-Time Monitoring Tool on |Cisco Unified Real-Time Monitoring Tool
a local PC. Administration Guide
Step 6 If you want to generate an alarm when the specified e Cisco Unified Real-Time Monitoring Tool
search string exists in a monitored trace file, enable the Administration Guide
LogFileSearchStringFound alert in RTMT. e Viewing Alarm Definitions and Adding
You can find the LogFileSearchStringFound alarm in User-Defined Descriptions, page 5-1
the LpmTctCatalog. (In Cisco Unified Serviceability,
choose Alarms > Definitions. In the Find alarms where
drop-down list box, choose the System Alarm Catalog;
in the Equals drop-down list box, choose
LpmTctCatalog.)
Step 7 If you want to automatically capture traces for alerts Cisco Unified Real-Time Monitoring Tool
such as CriticalServiceDownand CodeYellow, check Administration Guide
the Enable Trace Download check box in the Set
Alert/Properties dialog box for the specific alert in
RTMT; configure how often that you want the download
to occur.
Step 8 Collect the traces. Cisco Unified Real-Time Monitoring Tool
Administration Guide
Step 9 View the log file in the appropriate viewer. Cisco Unified Real-Time Monitoring Tool
Administration Guide
Step 10 If you enabled troubleshooting trace, reset the trace Configuring Troubleshooting Trace Settings, page 8-1
settings services, so the original settings get restored.
Note Leaving Troubleshooting trace enabled for a
long time increases the size of the trace files and
may impact the performance of the services.
Cisco Unified Serviceability Administration Guide
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Where to Find More Information

Related Topics
¢ Understanding Alarms, page 3-1

e Alarm Configuration Checklist, page 3-4
e Understanding Trace, page 6-1
e Configuring Troubleshooting Trace Settings, page §8-1

Additional Cisco Documentation

e Cisco Unified Real-Time Monitoring Tool Administration Guide
e Unified CM BE and Connection only: Cisco Unity Connection Serviceability Administration Guide

e Connection only: System Administration Guide for Cisco Unity Connection
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Configuring Trace

Enabling trace decreases system performance; therefore, enable trace only for troubleshooting purposes.
For assistance in using trace, contact your technical support team.

This chapter contains the following topics:
e Configuring Trace Parameters, page 7-1
e Service Groups in Trace Configuration, page 7-4
e Debug Trace Level Settings, page 7-7
e Trace Field Descriptions, page 7-8
e Trace Output Settings Descriptions and Defaults, page 7-18
e  Where to Find More Information, page 7-19

Configuring Trace Parameters

£
Tip

This section describes how to configure trace parameters for feature and network services that you
manage through Cisco Unified Serviceability.

Unified CM BE and Connection only: For Cisco Unity Connection, you may need to run trace in Cisco
Unified Serviceability and Cisco Unity Connection Serviceability to troubleshoot Cisco Unity
Connection issues. To troubleshoot services that are supported in Cisco Unified Serviceability, you run
trace in Cisco Unified Serviceability. Similarly, to troubleshoot Cisco Unity Connection components,
you run trace in Cisco Unity Connection Serviceability. For information on how to run trace in

Cisco Unity Connection Serviceability, refer to the Cisco Unity Connection Serviceability
Administration Guide.

Procedure

Step1  Choose Trace > Configuration.
The Trace Configuration window displays.
Step2  From the Server drop-down list box, choose the server that is running the service for which you want to
configure trace; then, click Go.
Cisco Unified Serviceability Administration Guide
[ oL-18619-01 .m



Chapter 7  Configuring Trace

W Configuring Trace Parameters

Step 3

Step 4

Step 5

Step 6
Step 7
Step 8

Step 9

Step 10

Step 11

From the Service Group drop-down list box, choose the service group for the service that you want to
configure trace; then, click Go.

Je

Tip Table 7-1 lists the services and trace libraries that correspond to the options that display in the
Service Group drop-down list box.

From the Service drop-down list box, choose the service for which you want to configure trace; then,
click Go.

The drop-down list box displays active and inactive services.

L

ﬁ Unified CM and Unified CM BE only: For the Cisco CallManager and CTIManager services, you
can configure SDL trace parameters. To do so, open the Trace Configuration window for one of
those services, and click the Go button that is next to the Related Links drop-down list box.

If you configured Troubleshooting Trace for the service, a message displays at the top of the window
that indicates that the Troubleshooting Traces feature is set, which means that the system disables all
fields in the Trace Configuration window except for Trace Output Settings. To configure the Trace
Output Settings, go to Step 12. To reset Troubleshooting Trace, see the “Configuring Troubleshooting
Trace Settings” section on page 8-1.

The trace parameters display for the service that you chose. In addition, the Apply to All Nodes check
box displays (Cisco Unified Communications Manager only).

Unified CM only: If you want to do so, you can apply the trace settings for the service or trace library to
all servers in the cluster by checking the Apply to All Nodes check box; that is, if your configuration
supports clusters.

Check the Trace On check box.
Unified CM and Unified CM BE only: If you are configuring SDL trace parameters, go to Step 10.

From the Debug Trace Level drop-down list box, choose the level of information that you want traced,
as described in “Debug Trace Level Settings” section on page 7-7.

Check the Trace Fields check box for the service that you chose; for example, Cisco Log Partition
Monitoring Tool Trace Fields.

~

Note  Unified CM and Unified CM BE only: If you are configuring trace for the Cisco CallManager or
the Cisco CTIManager service and you only want trace information for specific Cisco Unified
Communications Manager devices, go to Step 11.

If the service does not have multiple trace settings where you can specify the traces that you want to
activate, check the Enable All Trace check box. If the service that you chose has multiple trace settings,
check the check boxes next to the trace check boxes that you want to enable, as described in Trace Field
Descriptions, page 7-8.

Unified CM and Unified CM BE only: If you are configuring trace for the Cisco CallManager or the
Cisco CTIManager service and you want trace information for specific Cisco Unified Communications
Manager devices, perform the following tasks:

a. Check the Device Name Based Trace Monitoring check box.

The Device Name Based Trace Monitoring option traces only the selected devices, thus narrowing
the number of trace logs that are generated and reducing the impact on call processing.

Cisco Unified Serviceability Administration Guide
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Click the Select Devices button.

The Device Selection for Tracing window displays.

From Cisco Unified Communications Manager Administration, choose System > Enterprise

Parameters; configure the maximum number of devices that are available for tracing. Enter a
value in the Max Number of Device Level Trace field. For help on configuring the parameter,
click the link for the parameter name or the question mark button in the upper, right corner of
the window.

From the Find drop-down list box, choose the device for which you want a trace.

Enter the appropriate search criteria for the device for which you want a trace and click the Find
button.

The window with the search results displays. If more pages of search results to view exist, click the
First, Previous, Next, or Last button.

Click the Trace check box for the device or devices for which you want device-name-based trace
monitoring.

Click the Save button.

When the update finishes, click the browser close button to close the Device Selection for Tracing
window and return to the Trace Configuration window.

If you want trace to apply to non-devices in addition to devices, check the Include Non-device
Traces check box. If check box is checked, set the appropriate debug trace level as described in
“Debug Trace Level Settings” section on page 7-7.

Step12 To limit the number and size of the trace files, specify the trace output setting. See Table 7-18 for
descriptions and default values.

Step13  To save your trace parameters configuration, click the Save button.
The changes to trace configuration take effect immediately for all services except Cisco Messaging
Interface (Cisco Unified Communications Manager and Cisco Unified Communications Manager
Business Edition only). The trace configuration changes for Cisco Messaging Interface take effect in 3
to 5 minutes.
)
Note  To set the default, click the Set Default button.
Additional Information
See the “Related Topics” section on page 7-19.

Cisco Unified Serviceability Administration Guide
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Service Groups in Trace Configuration

Table 7-1 lists the services and trace libraries that correspond to the options in the Service Group
drop-down list box in the Trace Configuration window.

Table 7-1 Service Groups in Trace Configuration

Service Group | Services and Trace Libraries Notes

Unified CM and |Cisco CTIManager, Cisco CallManager, Cisco For a description of these services, see the
Unified CM BE |CallManager Cisco IP Phone Service, Cisco DHCP “Understanding Services” section on page 9-1.
only: Monitor Service, Cisco Dialed Number Analyzer, Cisco

For most services in the CM Services group, you
run trace for specific components, instead of
enabling all trace for the service. The “Trace
Field Descriptions” section on page 7-8 lists the
services for which you can run trace for specific
components.

Extended Functions, Cisco Extension Mobility, Cisco
Extension Mobility Application, Cisco IP Voice Media
Streaming App, Cisco Messaging Interface, Cisco TFTP,
and Cisco Unified Mobile Voice Access Service

CM Services

Unified CM and |Cisco CallManager Attendant Console Server, Cisco IP |For a description of these services, see the
Unified CM BE |Manager Assistant, and Cisco Web Dialer Web Service |“Understanding Services” section on page 9-1.

only: . -
Y For these services, you can run trace for specific

CTI Services components, instead of enabling all trace for the
service; see the “Trace Field Descriptions”
section on page 7-8.

Unified CM and |Cisco CAR Scheduler, Cisco CAR Web Service, Cisco |For a description of these services, see the
Unified CM BE |CDR Agent, and Cisco CDR Repository Manager “Understanding Services” section on page 9-1.

only: You enable all trace for each service, instead of

CDR Services running trace for specific components.

In CAR, when reports are run that call stored
procedures, CAR checks the configured debug
trace level for the Cisco CAR Scheduler service
and the Cisco CAR Web Service in the Trace
Configuration window before stored procedure
logging begins. For pregenerated reports, CAR
checks the level for the Cisco CAR Scheduler
service; for on-demand reports, CAR checks the
level for the Cisco CAR Web Service. If you
choose Debug from the Debug Trace Level
drop-down list box, stored procedure logging
gets enabled and continues until you choose
another option from the drop-down list box. The
following CAR reports use stored procedure
logging: Gateway Utilization report, Route and
Line Group Utilization report, Route/Hunt List
Utilization report, Route Pattern/Hunt Pilot
Utilization report, Conference Call Details
report, Conference Call Summary report,
Conference Bridge Utilization report, Voice
Messaging Utilization report, and the CDR
Search report.

Cisco Unified Serviceability Administration Guide
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Table 7-1 Service Groups in Trace Configuration (continued)

Service Group

Services and Trace Libraries

Notes

Database and
Admin Services

Cisco AXL Web Service, Cisco CCM DBL Web Library,
Cisco CCMAdmin Web Service, Cisco CCMUser Web

Service, Cisco Database Layer Monitor, and Cisco UXL
Web Service

Unified CM and Unified CM BE only: Cisco Bulk
Provisioning Service, Cisco GRT Communications Web
Service, Cisco Role-based Security, Cisco TAPS
Service, and Cisco Unified Reporting Web Service

Unified CM BE only: Cisco License Manager

For a description of these services (not the Cisco
CCM DBL Web Library or Cisco Role-based
Security options), see the “Understanding
Services” section on page 9-1.

Choosing the Cisco CCM DBL Web Library
option activates the trace for database access for
Java applications. For database access for C++
applications, activate trace for Cisco Database
Layer Monitor, as described in the “Cisco
Extended Functions Trace Fields” section on
page 7-15.

Choosing the Cisco Role-based Security option,
which supports Cisco Unified Communications
Manager, activates trace for user-role
authorization.

For most services in the Database and Admin
Services group, you enable all trace for the
service/library, instead of enabling trace for
specific components. For Cisco Database Layer
Monitor, you can run trace for specific
components.

Performance Cisco AMC Service, Cisco CCM NCS Web Library, For a description of these services (not the Cisco
and Monitoring |CCM PD Web Service, Cisco CallManager SNMP CCM NCS Web Library or the Cisco RTMT
Services Service, Cisco Log Partition Monitoring Tool, Cisco RIS |Web Service), see the “Understanding Services”
Data Collector, Cisco RTMT Web Service, Cisco Audit [section on page 9-1.
Event Service, and Cisco RisBean Library. Choosing the Cisco CCM NCS Web Library
Unified CM and Unified CM BE only: Cisco CCM PD  |option activates trace for database change
Web Service notification for the Java client.
Choosing the Cisco RTMT Web Service option
activates trace for the RTMT servlets; running
this trace creates the server-side log for RTMT
client queries.
Unified CM and |Cisco CTL Provider and Cisco Certificate Authority For a description of these services, see the
Unified CM BE |Proxy Function “Understanding Services” section on page 9-1.
only: You enable all trace for each service, instead of
Security running trace for specific components.
Services
Unified CM and |Cisco DirSync For a description of this service, see the
Unified CM BE “Understanding Services” section on page 9-1.
only: You enable all trace for this service, instead of
Directory running trace for specific components.
Services
Cisco Unified Serviceability Administration Guide
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Table 7-1

Service Groups in Trace Configuration (continued)

Service Group

Services and Trace Libraries

Notes

Backup and Cisco DRF Local and Cisco DRF Master For a description of these services, see the

Restore “Understanding Services” section on page 9-1.

Services You enable all trace for each service, instead of
running trace for specific components.

System Cisco CCMRealm Web Service, Cisco CCMService For a description of the Cisco Trace Collection

Services Web Service, Cisco Common User Interface, and Cisco |[service, see the “Understanding Services”

Trace Collection Service

section on page 9-1.

Choosing the Cisco CCMRealm Web Service
option activates trace for login authentication.

Choosing the Cisco Common User Interface
option activates trace for the common code that
multiple applications use; for example, Cisco
Unified Operating System Administration and
Cisco Unified Serviceability.

Choosing the Cisco CCMService Web Service
option activates trace for the Cisco Unified
Serviceability web application (GUI).

You enable all trace for each option/service,

instead of running trace for specific components.

SOAP Services

Cisco SOAP Web Service and Cisco SOAPMessage
Service

Choosing the Cisco SOAP Web Service option
activates the trace for the AXL Serviceability
API.

You enable all trace for this service, instead of
running trace for specific components.

Platform
Services

Cisco Unified OS Admin Web Service

The Cisco Unified OS Admin Web Service
supports Cisco Unified Operating System
Administration, which is the web application
that provides management of platform-related
functionality such as certificate management,
version settings, and installations and upgrades.

You enable all trace for this service, instead of
running trace for specific components.

l_ Cisco Unified Serviceability Administration Guide

0L-18619-01



| Chapter?

Configuring Trace

Debug Trace Level Settings

Debug Trace Level Settings

Table 7-2 describes the debug trace level settings for services.

Table 7-2 Debug Trace Levels for Services

Level Description

Error Traces alarm conditions and events. Used for all traces that
are generated in abnormal path. Uses minimum number of
CPU cycles.

Special Traces all Error conditions plus process and device
initialization messages.

State Transition Traces all Special conditions plus subsystem state transitions
that occur during normal operation. Traces call-processing
events.

Significant Traces all State Transition conditions plus media layer events

that occur during normal operation.

Entry/Exit Note  Not all services use this trace level.

Traces all Significant conditions plus entry and exit points of
routines.

Arbitrary Note Unified CM and Unified CM BE only: Do not use this
trace level with the Cisco CallManager service or the
Cisco IP Voice Media Streaming Application service
during normal operation.

Traces all Entry/Exit conditions plus low-level debugging
information.

Detailed Note Unified CM and Unified CM BE only: Do not use this
trace level with the Cisco CallManager service or the
Cisco IP Voice Media Streaming Application service
during normal operation.

Traces all Arbitrary conditions plus detailed debugging
information.

Table 7-3 describes the debug trace level settings for servlets.

Table 7-3 Debug Trace Levels for Serviets

Level Description

Fatal Traces very severe error events that may cause the application
to abort.

Error Traces alarm conditions and events. Used for all traces that
are generated in abnormal path.

Warn Traces potentially harmful situations.
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Table 7-3 Debug Trace Levels for Serviets (continued)
Level Description
Info Traces the majority of servlet problems and has a minimal

effect on system performance.

Debug Traces all State Transition conditions plus media layer events
that occur during normal operation.

Trace level that turns on all logging.

Additional Information
See the “Related Topics” section on page 7-19.

Trace Field Descriptions

For some services, you can activate trace for specific components, instead of enabling all trace for the
service. The following list includes the services for which you can activate trace for specific
components. Clicking one of the cross-references takes you to the applicable section where a description
displays for each trace field for the service. If a service does not exist in the following list, the Enable
All Trace check box displays for the service in the Trace Configuration window.

The following services are applicable to Cisco Unified Communications Manager, Cisco Unified
Communications Manager Business Edition, and Cisco Unity Connection:

e Cisco Database Layer Monitor Trace Fields, page 7-9
e Cisco RIS Data Collector Trace Fields, page 7-9

The following services are applicable to Cisco Unified Communications Manager and Cisco Unified
Communications Manager Business Edition only:

e Cisco CallManager SDI Trace Fields, page 7-10

e Cisco CallManager SDL Trace Fields, page 7-12

e Cisco CallManager Attendant Console Server Trace Fields, page 7-13
e Cisco CTIManager SDL Trace Fields, page 7-14

e Cisco Extended Functions Trace Fields, page 7-15

¢ Cisco Extension Mobility Trace Fields, page 7-16

e Cisco IP Manager Assistant Trace Fields, page 7-16

e Cisco IP Voice Media Streaming App Trace Fields, page 7-16

e Cisco TFTP Trace Fields, page 7-17

e Cisco Web Dialer Web Service Trace Fields, page 7-18

Cisco Unified Serviceability Administration Guide
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Cisco Database Layer Monitor Trace Fields

Table 7-4 describes the Cisco Database Layer Monitor trace fields. The Cisco Database Layer Monitor
service supports Cisco Unified Communications Manager and Cisco Unity Connection.

Table 7-4 Cisco Database Layer Monitor Trace Fields

Field Name Description

Enable DB Library Trace Activates database library trace for C++
applications.

Enable Service Trace Activates service trace.

Enable DB Change Notification Trace Activates the database change notification traces
for C++ applications.

Enable Unit Test Trace Do not check this check box. Cisco engineering
uses it for debugging purposes.

Additional Information
See the “Related Topics” section on page 7-19.

Cisco RIS Data Collector Trace Fields

Table 7-5 describes the Cisco RIS Data Collector trace fields. The Cisco RIS Data Collector service
supports Cisco Unified Communications Manager and Cisco Unity Connection.

Table 7-5 Cisco RIS Data Collector Trace Fields

Field Name Description

Enable RISDC Trace Activates trace for the RISDC thread of the RIS
data collector service (RIS).

Enable System Access Trace Activates trace for the system access library in the
RIS data collector.

Enable Link Services Trace Activates trace for the link services library in the
RIS data collector.

Enable RISDC Access Trace Activates trace for the RISDC access library in the
RIS data collector.

Enable RISDB Trace Activates trace for the RISDB library in the RIS
data collector.

Enable PI Trace Activates trace for the PI library in the RIS data
collector.

Cisco Unified Serviceability Administration Guide
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Table 7-5 Cisco RIS Data Collector Trace Fields (continued)
Field Name Description
Enable XML Trace Activates trace for the input/output XML

messages of the RIS data collector service.

Enable Perfmon Logger Trace Activates trace for the troubleshooting perfmon
data logging in the RIS data collector. Used to
trace the name of the log file, the total number of
counters that are logged, the names of the
application and system counters and instances,
calculation of process and thread CPU percentage,
and occurrences of log file rollover and deletion.

Additional Information
See the “Related Topics” section on page 7-19.

Cisco CallManager SDI Trace Fields

Table 7-6 describes the Cisco CallManager SDI trace fields. The Cisco CallManager service supports
Cisco Unified Communications Manager.

Table 7-6 Cisco CallManager SDI Trace Fields

Field Name Description

Enable H245 Message Trace Activates trace of H245 messages.

Enable DT-24+/DE-30+ Trace Activates the logging of ISDN type of
DT-24+/DE-30+ device traces.

Enable PRI Trace Activates trace of primary rate interface (PRI)
devices.

Enable ISDN Translation Trace Activates ISDN message traces. Used for normal
debugging.

Enable H225 & Gatekeeper Trace Activates trace of H.225 devices. Used for normal
debugging.

Enable Miscellaneous Trace Activates trace of miscellaneous devices.

Note Do not check this check box during normal
system operation.

Enable Conference Bridge Trace Activates trace of conference bridges. Used for
normal debugging.

Enable Music on Hold Trace Activates trace of music on hold (MOH) devices.
Used to trace MOH device status such as
registered with Cisco Unified Communications
Manager, unregistered with Cisco Unified
Communications Manager, and resource
allocation processed successfully or failed.

Cisco Unified Serviceability Administration Guide
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Cisco CallManager SDI Trace Fields (continued)

Field Name

Description

Enable Unified CMReal-Time Information Server
Trace

Activates Cisco Unified Communications
Manager real-time information traces that the
real-time information server uses.

Enable SIP Stack Trace

Activates trace of SIP stack.

Note  Enabling SIP Stack Trace can cause
extreme performance degradation
especially during high traffic hours.

Enable Annunciator Trace

Activates trace for the annunciator, a SCCP device
that uses the Cisco IP Voice Media Streaming
Application service to enable Cisco Unified
Communications Manager to play prerecorded
announcements (.wav files) and tones to

Cisco Unified IP Phones, gateways, and other
configurable devices.

Enable CDR Trace

Activates traces for CDR.

Enable Analog Trunk Trace

Activates trace of all analog trunk (AT) gateways.

Enable All Phone Device Trace

Activates trace of phone devices. Trace
information includes SoftPhone devices. Used for
normal debugging.

Enable MTP Trace

Activates trace of media termination point (MTP)
devices. Used for normal debugging.

Enable All Gateway Trace

Activates trace of all analog and digital gateways.

Enable Forward and Miscellaneous Trace

Activates trace for call forwarding and all
subsystems that are not covered by another check
box. Used for normal debugging.

Enable MGCP Trace

Activates trace for media gateway control
protocol (MGCP) devices. Used for normal
debugging.

Enable Media Resource Manager Trace

Activates trace for media resource manager
(MRM) activities.

Enable SIP Call Processing Trace

Activates trace for SIP call processing.
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Table 7-6

Cisco CallManager SDI Trace Fields (continued)

Field Name

Description

Enable SCCP Keep Alive Trace

Activates trace for SCCP keepalive trace
information in the Cisco CallManager traces.
Because each SCCP device reports keepalive
messages every 30 seconds, and each keepalive
message creates 3 lines of trace data, the system
generates a large amount of trace data when this
check box is checked.

Enable SIP Keep Alive (REGISTER Refresh)
Trace

Activates trace for SIP keepalive (REGISTER
refresh) trace information in the Cisco
CallManager traces. Because each SIP device
reports keepalive messages every 2 minutes, and
each keepalive message can create multiple lines
of trace data, the system generates a large amount
of trace data when this check box is checked.

Additional Information

See the “Related Topics” section on page 7-19.

Cisco CallManager SDL Trace Fields

Table 7-18 describes the Cisco CallManager SDL trace filter settings. Table 7-8 describes the Cisco
CallManager SDL configuration characteristics. The Cisco CallManager service supports Cisco Unified

Communications Manager.

N

Note
otherwise.

Cisco recommends that you use the defaults unless a Cisco engineer instructs you to do

Table 7-7

Cisco CallManager SDL Configuration Trace Filter Settings

Setting Name

Description

Enable all Layer 1 traces.

Activates traces for Layer 1.

Enable detailed Layer 1 traces.

Activates detailed Layer 1 traces.

Enable all Layer 2 traces.

Activates traces for Layer 2.

Enable Layer 2 interface trace.

Activates Layer 2 interface traces.

Enable Layer 2 TCP trace.

Activates Layer 2 Transmission Control Program
(TCP) traces.

Enable detailed dump Layer 2 trace.

Activates detailed traces for dump Layer 2.

Enable all Layer 3 traces.

Activates traces for Layer 3.

Enable all call control traces.

Activates traces for call control.

Enable miscellaneous polls trace.

Activates traces for miscellaneous polls.

Enable miscellaneous trace (database signals).

Activates miscellaneous traces such as database
signals.
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Cisco CallManager SDL Configuration Trace Filter Settings (continued)

Setting Name

Description

Enable message translation signals trace.

Activates traces for message translation signals.

Enable UUIE output trace.

Activates traces for user-to-user informational
element (UUIE) output.

Enable gateway signals trace.

Activates traces for gateway signals.

Enable CTI trace.

Activates CTI trace.

Enable network service data trace

Activates network service data trace.

Enable network service event trace

Activates network service event trace.

Enable ICCP admin trace

Activates ICCP administration trace.

Enable default trace

Activates default trace.

Table 7-8

Cisco CallManager SDL Configuration Trace Characteristics

Characteristics

Description

Enable SDL link states trace.

Activates trace for intracluster communication
protocol (ICCP) link state.

Enable low-level SDL trace.

Activates trace for low-level SDL.

Enable SDL link poll trace.

Activates trace for ICCP link poll.

Enable SDL link messages trace.

Activates trace for ICCP raw messages.

Enable signal data dump trace.

Activates traces for signal data dump.

Enable correlation tag mapping trace.

Activates traces for correlation tag mapping.

Enable SDL process states trace.

Activates traces for SDL process states.

Disable pretty print of SDL trace.

Disables trace for pretty print of SDL. Pretty print
adds tabs and spaces in a trace file without
performing post processing.

Enable SDL TCP event trace.

Activates SDL TCP event trace.

Additional Information
See the “Related Topics” section on page 7-19.

Cisco CallManager Attendant Console Server Trace Fields

Table 7-9 describes the Cisco CallManager Attendant Console Server trace fields. The Cisco
CallManager Attendant Console service supports Cisco Unified Communications Manager Attendant

Console.
Table 7-9 Cisco CallManager Attendant Console Server Trace Fields
Field Name Description

Enable low level trace

Activates low-level trace.

Enable high level trace

Activates high-level trace.
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Additional Information
See the “Related Topics” section on page 7-19.

Cisco CTIManager SDL Trace Fields

Table 7-10 describes the Cisco CTIManager SDL configuration trace filter settings. Table 7-11
describes the Cisco CTIManager SDL configuration trace characteristics. The Cisco CTIManager
service supports Cisco Unified Communications Manager.

Tip Cisco recommends that you use the defaults unless a Cisco engineer instructs you to do otherwise.

Tip When you choose the CTIManager service from the Service Groups drop-down list box, the Trace
Configuration window displays for SDI traces for this service. To activate SDI trace for the Cisco CTI
Manager service, check the Enable All Trace check box in the Trace Configuration window for the
Cisco CTIManager service. To access the SDL Configuration window, choose SDL Configuration from
the Related Links drop-down list box; the settings that are described in Table 7-10 and Table 7-11

display.

Table 7-10 Cisco CTIManager SDL Configuration Trace Filter Settings

Setting Name Description

Enable miscellaneous polls trace. Activates traces for miscellaneous polls.

Enable miscellaneous trace (database signals). Activates miscellaneous traces such as database
signals.

Enable CTI trace. Activates CTI trace.

Enable Network Service Data Trace Activates network service data trace.

Enable Network Service Event Trace Activates network service event trace.

Enable ICCP Admin Trace Activates ICCP administration trace.

Enable Default Trace Activates default trace.

Table 7-11 Cisco CTIManager SDL Configuration Trace Characteristics

Characteristics Description

Enable SDL link states trace. Activates trace for ICCP link state.

Enable low-level SDL trace. Activates trace for low-level SDL.

Enable SDL link poll trace. Activates trace for ICCP link poll.

Enable SDL link messages trace. Activates trace for ICCP raw messages.

Enable signal data dump trace. Activates traces for signal data dump.

Enable correlation tag mapping trace. Activates traces for correlation tag mapping.

Enable SDL process states trace. Activates traces for SDL process states.
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Cisco CTIManager SDL Configuration Trace Characteristics (continued)

Characteristics

Description

Disable pretty print of SDL trace.

Disables trace for pretty print of SDL. Pretty print
adds tabs and spaces in a trace file without
performing post processing.

Enable SDL TCP Event trace

Activates SDL TCP event trace.

Additional Information
See the “Related Topics” section on page 7-19.

Cisco Extended Functions Trace Fields

Table 7-12 describes the Cisco Extended Functions trace fields. The Cisco Extended Functions service

supports Cisco Unified Communications Manager.

Table 7-12

Cisco Extended Functions Trace Fields

Field Name

Description

Enable QBE Helper TSP Trace

Activates telephony service provider trace.

Enable QBE Helper TSPI Trace

Activates QBE helper TSP interface trace.

Enable QRT Dictionary Trace

Activates quality report tool service dictionary
trace.

Enable DOM Helper Traces

Activates DOM helper trace.

Enable Redundancy and Change Notification
Trace

Activates database change notification trace.

Enable QRT Report Handler Trace

Activates quality report tool report handler trace.

Enable QBE Helper CTI Trace

Activates QBE helper CTI trace.

Enable QRT Service Trace

Activates quality report tool service related trace.

Enable QRT DB Traces

Activates QRT DB access trace.

Enable Template Map Traces

Activates standard template map and multimap
trace.

Enable QRT Event Handler Trace

Activates quality report tool event handler trace.

Enable QRT Real-Time Information Server Trace

Activates quality report tool real-time
information server trace.

Additional Information
See the “Related Topics” section on page 7-19.
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Cisco Extension Mobility Trace Fields

Table 7-13 describes the Cisco Extension Mobility trace fields. The Cisco Extension Mobility service
supports Cisco Unified Communications Manager.

Table 7-13 Cisco Extension Mobility Trace Fields
Field Name Description
Enable EM Service Trace Activates trace for the extension mobility service.

Tip When you activate trace for the Cisco Extension Mobility Application service, you check the Enable All
Trace check box in the Trace Configuration window for the Cisco Extension Mobility Application
service.

Additional Information
See the “Related Topics” section on page 7-19.

Cisco IP Manager Assistant Trace Fields

Table 7-14 describes the Cisco IP Manager Assistant trace fields. The Cisco IP Manager Assistant
service supports Cisco Unified Communications Manager Assistant.

Table 7-14 Cisco IP Manager Assistant Trace Fields

Field Name Description

Enable IPMA Service Trace Activates trace for the Cisco IP Manager Assistant
service.

Enable IPMA Manager Configuration Change Log |Activates trace for the changes that you make to
the manager and assistant configurations.

Enable IPMA CTI Trace Activates trace for the CTI Manager connection.
Enable IPMA CTI Security Trace Activates trace for the secure connection to
CTIManager.

Additional Information
See the “Related Topics” section on page 7-19.

Cisco IP Voice Media Streaming App Trace Fields

The information in this section does not apply to Cisco Unity Connection.

Table 7-15 describes the Cisco IP Voice Media Streaming App trace fields. The Cisco IP Voice Media
Streaming App service supports Cisco Unified Communications Manager.
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Table 7-15 Cisco IP Voice Media Streaming Application Trace Fields

Field Name Description

Enable Service Initialization Trace Activates trace for initialization information.

Enable MTP Device Trace Activates traces to monitor the processed
messages for media termination point (MTP).

Enable Device Recovery Trace Activates traces for device-recovery-related
information for MTP, conference bridge, and
MOH.

Enable Skinny Station Messages Trace Activates traces for skinny station protocol.

Enable WinSock Level 2 Trace Activates trace for high-level, detailed
WinSock-related information.

Enable Music On Hold Manager Trace Activates trace to monitor MOH audio source
manager.

Enable Annunciator Trace Activates trace to monitor annunciator.

Enable DB Setup Manager Trace Activates trace to monitor database setup and
changes for MTP, conference bridge, and MOH.

Enable Conference Bridge Device Trace Activates traces to monitor the processed
messages for conference bridge.

Enable Device Driver Trace Activates device driver traces.

Enable WinSock Level 1 Trace Activates trace for low-level, general,

WinSock-related information.

Enable Music on Hold Device Trace Activates traces to monitor the processed
messages for MOH.

Enable TFTP Downloads Trace Activates trace to monitor the download of MOH
audio source files.

Additional Information
See the “Related Topics” section on page 7-19.

Cisco TFTP Trace Fields

Table 7-16 describes the Cisco TFTP trace fields. The Cisco TFTP service supports Cisco Unified
Communications Manager.

Table 7-16 Cisco TFTP Trace Fields

Field Name Description

Enable Service System Trace Activates trace for service system.
Enable Build File Trace Activates trace for build files.
Enable Serve File Trace Activates trace for serve files.

Additional Information
See the “Related Topics” section on page 7-19.

Cisco Unified Serviceability Administration Guide
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Cisco Web Dialer Web Service Trace Fields

Table 7-17 describes the Cisco Web Dialer Web Service trace fields. The Cisco Web Dialer Web Service
supports Cisco Unified Communications Manager.

Table 7-17 Cisco Web Dialer Web Service Trace Fields

Field Name Description

Enable Web Dialer Servlet Trace Activates trace for Cisco Web Dialer servlet.
Enable Redirector Servlet Trace Activates trace for the Redirector servlet.

Additional Information
See the “Related Topics” section on page 7-19.

Trace Output Settings Descriptions and Defaults

Table 7-18 contains the trace log file descriptions and defaults.

A

Caution  When you change either the Maximum No. of Files or the Maximum File Size settings in the Trace
Configuration window, the system deletes all service log files except for the current file, that is, if the
service is running; if the service has not been activated, the system deletes the files immediately after
you activate the service. Before you change the Maximum No. of Files setting or the Maximum File Size
setting, download and save the service log files to another server if you want to keep a record of the log
files; to perform this task, use Trace and Log Central in RTMT.

Table 7-18 Trace Output Settings

Field Description

Maximum number of files This field specifies the total number of trace files
for a given service.

Cisco Unified Serviceability automatically
appends a sequence number to the file name to
indicate which file it is; for example, cus299.txt.
When the last file in the sequence is full, the trace
data begins writing over the first file. The default
varies by service.

Maximum file size (MB) This field specifies the maximum size of the trace
file in megabytes. The default varies by service.

Additional Information
See the “Related Topics” section on page 7-19.
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Where to Find More Information

Related Topics

e Configuring Trace Parameters, page 7-1

e Service Groups in Trace Configuration, page 7-4

e Debug Trace Level Settings, page 7-7

e Trace Field Descriptions, page 7-8

e Trace Output Settings Descriptions and Defaults, page 7-18
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Configuring Troubleshooting Trace Settings

The Troubleshooting Trace Settings window allows you to choose the services for which you want to
set predetermined troubleshooting trace settings. This chapter contains information on how to set and
reset troubleshooting trace settings for services that exist in Cisco Unified Serviceability.

N

Note Leaving Troubleshooting Trace enabled for a long time increases the size of the trace files and
may impact the performance of the services.

Procedure

In Cisco Unified Serviceability, choose Trace > Troubleshooting Trace Settings.

From the Server drop-down list box, choose the server where you want to troubleshoot trace settings;
then, click Go.

A

Note A list of services displays. The services that are not activated display as N/A.

Perform one of the following tasks:

e To check specific services for the server that you chose in the Server drop-down list box, check the
service(s) check box(es) in the Services pane; for example, the Database and Admin Services,
Performance and Monitoring Services, or the Backup and Restore Services pane (and so on).

This task affects only the server that you chose in the Server drop-down list box.
¢ Check one of the following check boxes:

— Check All Services—Automatically checks all check boxes for the services on the current
server that you chose in the Server drop-down list box.

— Unified CM clusters only: Check Selected Services on All Nodes—Allows you to check
specific service check boxes in the Troubleshooting Trace Setting window. This setting applies
for all servers in the cluster where the service is activated.

— Unified CM clusters only: Check All Services on All Nodes —Automatically checks all check
boxes for all services for all servers in the cluster. When you check this check box, the Check
All Services and Check Selected Services on All Nodes check boxes automatically get
checked.

Click the Save button.

After you configure troubleshooting trace for one or more services, you can restore the original trace
settings. If you want to restore the original trace settings, click one of the following buttons:

[ oL-18619-01
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¢ Reset Troubleshooting Traces—Restores the original trace settings for the services on the server
that you chose in the Server drop-down list box; also displays as an icon that you can click.

e Unified CM clusters only: Reset Troubleshooting Traces On All Nodes—Restores the original
trace settings for the services on all servers in the cluster.

After you click the reset button, the window refreshes, and the service check boxes display as unchecked.

Additional Information
See the “Related Topics” section on page 8-2.

Where to Find More Information

Related Topics
e Configuring Trace, page 7-1
e Understanding Trace, page 6-1
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Understanding Services

Cisco Unified Serviceability service management includes working with feature and network services
and servlets, which are associated with the Tomcat Java Webserver. Feature services allow you to use
application features, such as Serviceability Reports Archive, while network services are required for
your system to function.

If something is wrong with a service or servlet, an alarm gets written to an alarm monitor. After viewing
the alarm information, you can run a trace on the service. Be aware that services and servlets display
different trace levels in the Trace Configuration window.

This chapter, which provides a description of services/servlets, Service Activation, and Control Center,
contains information on the following topics:

e Feature Services, page 9-1

e Network Services, page 9-9

e Service Activation, page 9-16

e Control Center, page 9-17

e Services Configuration Checklist, page 9-18
¢ Where to Find More Information, page 9-18

Feature Services

In Cisco Unified Serviceability, you can activate, start, and stop feature services. Activation turns on
and starts the service. After you activate a service in the Service Activation window, you do not need to
start it in the Control Center—Feature Services window. If the service does not start for any reason, you
must start it in the Control Center—Features Services window.

After the system is installed, it does not automatically activate feature services, which are related
services that are required if you want to use your configuration features; for example, the Serviceability
Reports Archive feature.

Unified CM and Unified CM BE only: After you activate feature services, you can modify associated
service parameters in Cisco Unified Communications Manager Administration.

Connection only: After you activate feature services, you can modify associated settings in Cisco Unity
Connection Administration.

Unified CM only: If you are upgrading Cisco Unified Communications Manager, those services that you
activated on the system prior to the upgrade automatically activate and start after the upgrade.
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In the Service Activation window, Cisco Unified Serviceability categorizes feature services into the
following groups:

e Database and Admin Services, page 9-2

e Performance and Monitoring Services, page 9-3
e CM Services, page 9-4

e CTI Services, page 9-6

e CDR Services, page 9-7

e Security Services, page 9-7

e Directory Services, page 9-8

e Voice Quality Reporter Services, page 9-9

In the Control Center—Feature Services window, Cisco Unified Serviceability categorizes services into
the same groups that display in the Service Activation window.

pe
Tip

For service activation recommendations, see the “Service Activation” section on page 9-16 and the
“Activating and Deactivating Feature Services” section on page 11-1.

Database and Admin Services

This section describes the Database and Admin Services.

Cisco AXL Web Service

The Cisco AXL Web Service allows you to modify database entries and execute stored procedures from
client-based applications that use AXL.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco UXL Web Service

The TabSync client in Cisco IP Phone Address Book Synchronizer uses the Cisco UXL Web Service for
queries to the Cisco Unified Communications Manager database, which ensures that Cisco IP Phone
Address Book Synchronizer users have access only to end-user data that pertains to them. The Cisco
UXL Web Service performs the following functions:

¢ Conducts authentication checks by verifying the end user name and password when an end user logs
in to Cisco IP Phone Address Book Synchronizer.

e Conducts a user authorization check by only allowing the user that is currently logged in to Cisco
IP Phone Address Book Synchronizer to perform functions such as listing, retrieving, updating,
removing, and adding contacts.

Cisco Bulk Provisioning Service
This service does not support Cisco Unity Connection.

If your configuration supports clusters (Cisco Unified Communications Manager only), you can activate
the Cisco Bulk Provisioning Service only on the first server. If you use the Cisco Unified
Communications Manager Bulk Administration Tool (BAT) to administer phones and users, you must
activate this service.

Cisco Unified Serviceability Administration Guide
m. 0L-18619-01 |



| Chapter9

Understanding Services

o

Feature Services W

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco TAPS Service
This service does not support Cisco Unity Connection.

The Cisco TAPS Service supports the Cisco Unified Communications Manager Auto-Register Phone
Tool, which allows a user to upload a customized configuration on an auto registered phone after a user
responds to Interactive Voice Response (IVR) prompts.

If your configuration supports clusters (Cisco Unified Communications Manager only), you activate this
service on the first server. When you want to create dummy MAC addresses for the tool, ensure that the
Cisco Bulk Provisioning Service is activated on the same server.

The Cisco Unified Communications Manager Auto-Register Phone Tool relies on Cisco Customer
Response Solutions (CRS). Before the tool can work as designed, verify that the CRS server is
configured and running, as described in the CRS documentation.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Performance and Monitoring Services

This section describes the Performance Monitoring Services.

Cisco Serviceability Reporter

The Cisco Serviceability Reporter service generates the daily reports that are described in
“Understanding Serviceability Reports Archive” section on page 10-1.

If your configuration supports clusters (Cisco Unified Communications Manager only), this service gets
installed on all the Cisco Unified Communications Manager servers in the cluster. Reporter generates

reports once a day based on logged information. You can access the reports that Reporter generates in
Cisco Unified Serviceability from the Tools menu. Each summary report comprises different charts that
display the statistics for that particular report. After you activate the service, report generation may take
up to 24 hours.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco CallManager SNMP Service
This service does not support Cisco Unity Connection.

This service, which implements the CISCO-CCM-MIB, provides SNMP access to provisioning and
statistics information that is available for Cisco Unified Communications Manager.

If your configuration supports clusters (Cisco Unified Communications Manager only), activate this
service on all servers in the cluster.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager.
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This section describes the CM Services and does not apply to Cisco Unity Connection.

Cisco CallManager

The Cisco CallManager service provides software-only call processing as well as signaling and call
control functionality for Cisco Unified Communications Manager.

Unified CM clusters only: Before you activate this service, verify that the Cisco Unified
Communications Manager server displays in the Find and List Cisco Unified CMs window in Cisco
Unified Communications Manager Administration. If the server does not display, add the Cisco Unified
Communications Manager server before you activate this service. For information on how to find and
add the server, refer to the Cisco Unified Communications Manager Administration Guide.

Unified CM clusters only: If you deactivate the Cisco CallManager or CTIManager services in Service
Activation, the Cisco Unified Communications Manager server where you deactivated the service no
longer exists in the database, which means that you cannot choose that Cisco Unified Communications
Manager server for configuration operations in Cisco Unified Communications Manager Administration
because it does not display in the graphical user interface (GUI). If you then reactivate the services on
the same Cisco Unified Communications Manager server, the database creates an entry for Cisco Unified
Communications Manager again and adds a “CM_” prefix to the server name or IP address; for example,
if you reactivate the Cisco CallManager or CTIManager service on a server with an IP address of
172.19.140.180, then CM_172.19.140.180 displays in Cisco Unified Communications Manager
Administration. You can now choose the server, with the new “CM_" prefix, in Cisco Unified
Communications Manager Administration.

The following services rely on Cisco CallManager service activation:
e Cisco CTIManager, page 9-5
e CDR Services, page 9-7

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco TFTP

Cisco Trivial File Transfer Protocol (TFTP) builds and serves files that are consistent with the trivial file
transfer protocol, a simplified version of FTP. Cisco TFTP serves embedded component executable,
ringer files, and device configuration files.

Unified CM only: A configuration file includes a list of Cisco Unified Communications Managers to
which devices (telephones and gateways) make connections. When a device boots, the component
queries a Dynamic Host Configuration Protocol (DHCP) server for its network configuration
information. The DHCP server responds with an IP address for the device, a subnet mask, a default
gateway, a Domain Name System (DNS) server address, and a TFTP server name or address. The device
requests a configuration file from the TFTP server. The configuration file contains a list of Cisco Unified
Communications Managers and the TCP port through which the device connects to those Cisco Unified
Communications Managers. The configuration file contains a list of Cisco Unified Communications
Managers and the TCP port through which the device connects to those Cisco Unified Communications
Managers.
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In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco Messaging Interface

The Cisco Messaging Interface allows you to connect a simplified message desk interface
(SMDI)-compliant external voice-messaging system with the Cisco Unified Communications Manager.
The SMDI defines a way for a phone system to provide a voice-messaging system with the information
that is needed to intelligently process incoming calls.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco Unified Mobile Voice Access Service

The Cisco Unified Voice Access Service starts the mobile voice access capability within Cisco Unified
Mobility; mobile voice access, which is an integrated voice response (IVR) system, allows Cisco Unified
Mobility users to perform the following tasks:

e Make calls from the cellular phone as if the call originated from the desk phone.
e Turn Cisco Unified Mobility on.
e Turn Cisco Unified Mobility off.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco IP Voice Media Streaming App

The Cisco IP Voice Media Streaming Application service provides voice media streaming functionality
for Cisco Unified Communications Manager for use with MTP, conferencing, music on hold (MOH),
and annunciator. The Cisco IP Voice Media Streaming Application relays messages from Cisco Unified
Communications Manager to the IP voice media streaming driver, which handles RTP streaming.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco CTIManager

The Cisco CTI Manager contains the CTI components that interface with applications. This service
allows applications to monitor/control phones and virtual devices to perform call control functionality.

Unified CM clusters only: With CTI Manager, applications can access resources and functionality of all
Cisco Unified Communications Managers in the cluster and have improved failover capability. Although
one or more CTI Managers can be active in a cluster, only one CTI Manager can exist on an individual
server. An application (JTAPI/TAPI) can have simultaneous connections to multiple CTI Managers;

however, an application can only use one connection at a time to open a device with media termination.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco Extension Mobility
This service, which supports the Cisco Extension Mobility feature, performs the login and automatic
logout functionality for the feature.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager.
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CTI Services

Cisco Dialed Number Analyzer

The Cisco Dialed Number Analyzer service supports Cisco Unified Communications Manager Dialed
Number Analyzer. When activated, this application consumes a lot of resources, so activate this service
only during off-peak hours when minimal call-processing interruptions may occur.

Unified CM clusters only: Cisco does not recommend that you activate the service on all the servers in
a cluster. Cisco recommends that you activate this service only on one of the servers of a cluster where
call-processing activity is the least.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco DHCP Monitor Service

Cisco DHCP Monitor Service monitors IP address changes for IP phones in the database tables. When
a change is detected, it modifies the /etc./dhcpd.conf file and restarts the DHCPD daemon.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

This section describes the CTI Services and does not apply to Cisco Unity Connection.

Cisco CallManager Attendant Console Server

The Cisco CallManager Attendant Console Server service provides centralized services for Cisco
Unified Communications Manager Attendant Console clients and pilot points. For attendant console
clients, this service provides call-control functionality, line state information for any accessible line
within the Cisco Unified Communications Manager domain, and caching of directory information. For
pilot points, this service provides automatic redirection to directory numbers that are listed in hunt
groups.

Unified CM only: For pilot points, this service also provides failover during a Cisco Unified
Communications Manager failure.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco IP Manager Assistant

This service supports Cisco Unified Communications Manager Assistant. After service activation, Cisco
Unified Communications Manager Assistant enables managers and their assistants to work together
more effectively. Cisco Unified Communications Manager Assistant supports two modes of operation:
proxy line support and shared line support.

The feature comprises a call-routing service, enhancements to phone capabilities for the manager, and
desktop interfaces that are primarily used by the assistant.

The service intercepts calls that are made to managers and routes them to selected assistants, to
managers, or to other targets on the basis of preconfigured call filters. The manager can change the call
routing dynamically; for example, by pressing a softkey on the phone, the manager can instruct the
service to route all calls to the assistant and can receive status on these calls.

Cisco Unified Communications Manager users comprise managers and assistants. The routing service
intercepts manager calls and routes them appropriately. An assistant user handles calls on behalf of a
manager.
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In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco WebDialer Web Service for Cisco Unified Communications Manager Systems

Cisco Web Dialer provides click-to-dial functionality. It allows users inside a Cisco Unified
Communications Manager cluster to initiate a call to other users inside or outside the cluster by using a
web page or a desktop application. Cisco Web Dialer provides a web page that enables users to call each
other within a cluster. Cisco Web Dialer comprises two components: Web Dialer servlet and Redirector
servlet.

The Redirector servlet provides the ability for third-party applications to use Cisco Web Dialer. The
Redirector servlet finds the appropriate Cisco Unified Communications Manager cluster for the Cisco
Web Dialer user and redirects the request to the Cisco Web Dialer in that cluster. The Redirector
functionality only applies for HTTP/HTML-based Web Dialer client applications because it is not
available for Simple Object Access Protocol (SOAP)-based Web Dialer applications.

Cisco WebDialer Web Service for Cisco Unified Communications Manager Business Edition Systems

Cisco Web Dialer, which is used in conjunction with Cisco Unified Communications Manager, allows
Cisco Unified IP Phone users to make calls from web and desktop applications. For example, Cisco
Web Dialer uses hyperlinked telephone numbers in a company directory to allow users to make calls
from a web page by clicking on the telephone number of the person that they are trying to call.

This service supports Cisco Unified Communications Manager.

This section describes the CDR Services and does not apply to Cisco Unity Connection.

Cisco SOAP - CDRonDemand Service

The Cisco SOAP - CDRonDemand Service, a SOAP/HTTPS-based service, runs on the CDR Repository
server.It receives SOAP requests for CDR file name lists that are based on a user-specified time interval
(up to a maximum of 1 hour) and returns a list of file names that fit the time duration that is specified in
the request. This service also receives requests for delivery of a specific CDR/CMR file with the file
name and the transfer method (SFTP/FTP, server name, login info, directory) that is specified in the
request.

If you are using a third-party billing application that accesses CDR data via an HTTPS/SOAP interface,
activate this service.

CAR Web Service

The Cisco CAR Web Service loads the user interface for CAR, a web-based reporting application that
generates either CSV or PDF reports by using CDR data.

Security Services

This section describes the Security Services and does not apply to Cisco Unity Connection.

Cisco CTL Provider

Unified CM only: The Cisco CTL Provider service, which runs with local system account privileges,
works with the Cisco CTL Provider Utility, a client-side plug-in, to change the security mode for the
cluster from nonsecure to mixed mode. When you install the plug-in, the Cisco CTL Provider service
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retrieves a list of all Cisco Unified Communications Manager and Cisco TFTP servers in the cluster for
the CTL file, which contains a list of security tokens and servers in the cluster. You must install and
configure the Cisco CTL Client and activate this service for the clusterwide security mode to change
from nonsecure to secure.

Unified CM BE only: The Cisco CTL Provider service, which runs with local system account privileges,
works with the Cisco CTL Provider Utility, a client-side plug-in, to change the clusterwide security
mode for the server from nonsecure to mixed mode. You must install and configure the Cisco CTL Client
and activate this service for the security mode to change from nonsecure to secure.

After you activate the service, the Cisco CTL Provider service reverts to the default CTL port, which
is 2444. If you want to change the port, refer to the Cisco Unified Communications Manager Security
Guide for more information.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco Certificate Authority Proxy Function (CAPF)

Working in conjunction with the CAPF application, the Cisco Certificate Authority Proxy Function
(CAPF) service can perform the following tasks, depending on your configuration:

e Issue locally significant certificates to supported Cisco Unified IP Phone models.

e Using SCEP, request certificates from third-party certificate authorities on behalf of supported
Cisco Unified IP Phone models.

e Upgrade existing certificates on the phones.
e Retrieve phone certificates for troubleshooting.

e Delete locally significant certificates on the phone.

Note  Unified CM only: When you view real-time information in RTMT, the Cisco Certificate Authority Proxy
Function (CAPF) service displays only for the first server.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager.

Directory Services

This section describes the Directory Services and does not apply to Cisco Unity Connection.

Cisco DirSync

Cisco does not support this service for the Cisco Unified Communications Manager Business Edition.
This service displays in Cisco Unified Serviceability, but the system does not save the configuration for
the activation; after you attempt to activate the service, a message displays in the Service Activation
window to tell you that you cannot activate this service for Cisco Unified Communications Manager
Business Edition.

Unified CM only: The Cisco DirSync service ensures that the Cisco Unified Communications Manager
database stores all user information. If you use an integrated corporate directory, for example, Microsoft
Active Directory or Netscape/iPlanet Directory, with Cisco Unified Communications Manager, the
Cisco DirSync service migrates the user data to the Cisco Unified Communications Manager database.
The Cisco DirSync service does not synchronize the passwords from the corporate directory.
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Voice Quality Reporter Services

This section describes the Voice Quality Reporter Services and does not apply to Cisco Unity
Connection.

Cisco Extended Functions

The Cisco Extended Functions service provides support for Cisco Unified Communications Manager
voice-quality features, including Quality Report Tool (QRT). For more information about individual

features, refer to the Cisco Unified Communications Manager System Guide and the Cisco Unified IP
Phone Administration Guide for Cisco Unified Communications Manager.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Network Services

Installed automatically, network services include services that the system requires to function; for
example, database and platform services. Because these services are required for basic functionality, you
cannot activate them in the Service Activation window. If necessary, for example, for troubleshooting
purposes, you may need to stop and start (or restart) a network service in the Call Control—Network
Services window.

After the installation of your application, network services start automatically, as noted in the Call
Control—Network Services window. In the Control Center—Network Services window, Cisco Unified
Serviceability categorizes services into the following groups:

e Performance and Monitoring Services, page 9-9
e Backup and Restore Services, page 9-11

e System Services, page 9-11

e Platform Services, page 9-12

e DB Services, page 9-14

e SOAP Services, page 9-14

e CM Services, page 9-15

e CDR Services, page 9-7

e Admin Services, page 9-16

Performance and Monitoring Services

This section describes the Performance and Monitoring Services.

Cisco CallManager Serviceability RTMT

The Cisco CallManager Serviceability RTMT servlet supports the Cisco Unified Real-Time Monitoring
Tool (RTMT), which allows you to collect and view traces, view performance monitoring objects, work
with alerts, and monitor devices, system performance, CTI applications, and so on.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.
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Cisco RTMT Reporter Servlet
The Cisco RTMT Reporter servlet allows you to publish reports for RTMT.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco Log Partition Monitoring Tool
The Cisco Log Partition Monitoring Tool service supports the Log Partition Monitoring feature, which
monitors the disk usage of the log partition on a server (or all servers in the cluster) by using configured
thresholds and a polling interval.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco Tomcat Stats Servlet

The Cisco Tomcat Stats Servlet allows you to monitor the Tomcat perfmon counters by using RTMT or
the Command Line Interface. Do not stop this service unless you suspect that this service is using too
many resources, such as CPU time.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco RIS Data Collector

The Real-time Information Server (RIS) maintains real-time information such as device registration
status, performance counter statistics, critical alarms generated, and so on. The Cisco RIS Data Collector
service provides an interface for applications, such as the Cisco Unified Real-Time Monitoring Tool
(RTMT), SOAP applications, and so on, to retrieve the information that is stored in the RIS server (or
in all RIS servers in the cluster).

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco AMC Service

Used for the Cisco Unified Communications Manager Cisco Unified Real-Time Monitoring Tool
(RTMT), this service, Alert Manager and Collector service, allows RTMT to retrieve real-time
information that exists on the server (or on all servers in the cluster).

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco Audit Event Service
The Cisco Audit Event Service monitors and logs any configuration change to the Cisco Unified
Communications Manager system by a user or as a result of the user action.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco RisBean Library
Cisco RisBean Library comprises a library that some webapps use to communicate with other internal
services.

You should leave trace settings at default level unless you are instructed by TAC to change them to
debug an issue.
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Backup and Restore Services

This section describes the Backup and Restore Services.

Cisco DRF Master

The CiscoDRF Master Agent service supports the DRF Master Agent, which works with the Disaster
Recovery System graphical user interface (GUI) or command line interface (CLI) to schedule backups,
perform restorations, view dependencies, check status of jobs, and cancel jobs, if necessary. The Cisco
DRF Master Agent also provides the storage medium for the backup and restoration process.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco DRF Local

The Cisco DRF Local service supports the Cisco DRF Local Agent, which acts as the workhorse for the
DRF Master Agent. Components register with the Cisco DRF Local Agent to use the disaster recovery
framework. The Cisco DRF Local Agent executes commands that it receives from the Cisco DRF Master
Agent. Cisco DRF Local Agent sends the status, logs, and command results to the Cisco DRF Master
Agent.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

System Services

This section describes the System Services.

Cisco CallManager Serviceability

The Cisco CallManager Serviceability service supports Cisco Unified Serviceability, the web
application/interface that you use to troubleshoot issues and manage services. This service, which is
installed automatically, allows you access to the Cisco Unified Serviceability graphical user interface
(GUD). If you stop this service, you cannot access the Cisco Unified Serviceability GUI when you browse
into that server.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco CDP

Cisco CDP advertises the voice application to other network management applications, so the network
management application, for example, SNMP or CiscoWorks Lan Management Solution, can perform
network management tasks for the voice application.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection

Cisco Trace Collection Servlet

The Cisco Trace Collection Servlet, along with the Cisco Trace Collection Service, supports trace
collection and allows users to view traces by using RTMT. If you stop this service on a server, you
cannot collect or view traces on that server.

For SysLog Viewer and Trace and Log Central to work in RTMT, the Cisco Trace Collection Servlet
and the Cisco Trace Collection Service must run on the server.
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In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco Trace Collection Service

The Cisco Trace Collection Service, along with the Cisco Trace Collection Servlet, supports trace
collection and allows users to view traces by using the RTMT client. If you stop this service on a server,
you cannot collect or view traces on that server.

For SysLog Viewer and Trace and Log Central to work in RTMT, the Cisco Trace Collection Servlet
and the Cisco Trace Collection Service must run on the server.

If necessary, Cisco recommends that, to reduce the initialization time, you restart the Cisco Trace
Collection Service before restarting Cisco Trace Collection Servlet.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Platform Services

This section describes the Platform Services.

A Cisco DB

A Cisco DB service supports the Progres database engine.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

A Cisco DB Replicator

Unified CM only: The A Cisco DB Replicator service ensures database configuration and data
synchronization between the first and subsequent servers in the cluster.

Cisco Tomcat
The Cisco Tomcat service supports the web server.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

SNMP Master Agent

This service, which acts as the agent protocol engine, provides authentication, authorization, access
control, and privacy functions that relate to SNMP requests.

After you complete SNMP configuration in Cisco Unified Serviceability, you must restart the SNMP
Master Agent service in the Control Center—Network Features window.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco Unified Serviceability Administration Guide
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MIB2 Agent
This service provides SNMP access to variables, which are defined in RFC 1213, that read and write

variables; for example, system, interfaces, IP, and so on.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager and Cisco Unity Connection.

Host Resources Agent
This service provides SNMP access to host information, such as storage resources, process tables, device
information, and installed software base. This service implements the HOST-RESOURCES-MIB.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Native Agent Adaptor
This service, which supports vendor MIBs, allows you to forward SNMP requests to another SNMP
agent that runs on the system.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

System Application Agent
This service provides SNMP access to the applications that are installed and executing on the system.
This implements the SYSAPPL-MIB.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco CDP Agent

This service uses the Cisco Discovery Protocol to provide SNMP access to network connectivity
information on the Cisco Unified Communications Manager or Cisco Unity Connection server. This
service implements the CISCO-CDP-MIB.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco Syslog Agent
This service supports gathering of syslog messages that various components generate. This service
implements the CISCO-SYSLOG-MIB.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Caution

Stopping any SNMP service may result in loss of data because the network management system no
longer monitors the network. Do not stop the services unless the your technical support team tells you
to do so.

Cisco Certificate Expiry Monitor

This service periodically checks the expiration status of certificates that the system generates and sends
notification when a certificate gets close to its expiration date. You manage the certificates that use this
service in Cisco Unified Operating System Administration.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.
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DB Services

Cisco License Manager

This service is not supported by Cisco Unity Connection.

Cisco License Manager keeps track of the Cisco Unified Communications Manager-related licenses that
a customer purchases and uses. It controls license checkins and checkouts, and it takes responsibility for
issuing and reclaiming Cisco Unified Communications Manager-related licenses. For Cisco Unified
Communications Manager, Cisco License Manager manages the Cisco Unified Communications
Manager application and the number of IP phone unit licenses. When the number of phones exceeds the
number of licenses, it issues alarms.

Unified CM clusters only: This service runs on all the servers, but the service on the first server has the
responsibility for issuing and reclaiming licenses.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Unified CM BE only: For information on issuing Cisco Unity Connection licenses, refer to the Cisco
Unified Communications Manager System Guide.

This section describes the DB Services.

Cisco Database Layer Monitor
The Cisco Database Layer Monitor service monitors aspects of the database layer. This service takes
responsibility for change notification and monitoring.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

SOAP Services

This section describes the SOAP Services.

Cisco SOAP-Real-Time Service APIs
The Cisco SOAP-Real-Time Service APIs allow you to collect real-time information for devices and

CTI applications. This service also provides APIs for activating, starting, and stopping services.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco SOAP-Performance Monitoring APls

The Cisco SOAP-Performance Monitoring APIs service allows you to use performance monitoring
counters for various applications through SOAP APIs; for example, you can monitor memory
information per service, CPU usage, performance monitoring counters, and so on.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

Cisco Unified Serviceability Administration Guide
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Cisco SOAP-Log Collection APIs

The Cisco SOAP-Log Collection APIs service allows you to collect log files and to schedule collection
of log files on a remote SFTP server. Examples of log files that you can collect include syslog, core dump
files, Cisco application trace files, and so on.

In a Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

This section describes the CM Services and does not apply to Cisco Unity Connection.

Cisco CallManager Personal Directory
The Cisco CallManager Personal Directory service supports Cisco Personal Directory.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco Extension Mobility Application

The Cisco Extension Mobility Application service allows you to define login settings such as duration
limits on phone configuration for the Cisco Extension Mobility feature.

Unified CM only: The Cisco Extension Mobility feature allows users within a Cisco Unified
Communications Manager cluster to temporarily configure another phone in the cluster as their own
phone by logging in to that other phone. After a user logs in, the phone adopts the personal phone
number(s), speed dials, services links, and other user-specific properties of the user. After logout, the
phone adopts the original user profile.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco CallManager Cisco IP Phone Services
The Cisco CallManager Cisco IP Phone Service initializes the service URLs for the Cisco Unified IP
Phone services that you configured in Cisco Unified Communications Manager Administration.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

This section describes the CDR Services and does not apply to Cisco Unity Connection.

Cisco CDR Repository Manager

This service maintains and moves the generated CDRs that are obtained from the Cisco CDR Agent
service. In a system that supports clusters (Cisco Unified Communications Manager only), the service
exists on the first server.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.
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Cisco CDR Agent

Cisco Unified Communications Manager supports Cisco CDR Agent in Cisco Unified Communications
Manager and Cisco Unified Communications Manager Business Edition systems. This service does not
support Cisco Unity Connection.

This service does not support Cisco Unity Connection.

The Cisco CDR Agent service transfers CDR and CMR files that are generated by Cisco Unified
Communications Manager from the local host to the CDR repository server, where the CDR Repository
Manager service runs over a SFTP connection.

This service transfers CDR and CMR files generated from the local host to the CDR repository server
in a cluster. The CDR Agent in the CDR Repository Node/Standalone server (Files generated in the
Standalone server itself) transfers the files to the Cisco CDR Repository Manager, over a SFTP
connection, which maintains /moves the files.

For this service to work, activate the Cisco CallManager service on the server and ensure that it is
running. If your configuration supports clusters (Cisco Unified Communications Manager only),
activate the Cisco CallManager service on the first server.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Cisco CAR Scheduler

This service does not support Cisco Unity Connection.

The Cisco CAR Scheduler service allows you to schedule CAR-related tasks; for example, you can
schedule report generation or CDR file loading into the CAR database.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Admin Services

This section describes the Admin Services and does not apply to Cisco Unity Connection.

Cisco CallManager Admin

The Cisco CallManager Admin service supports Cisco Unified Communications Manager
Administration, the web application/interface that you use to configure Cisco Unified Communications
Manager settings. After the Cisco Unified Communications Manager installation, this service starts
automatically and allows you to access the graphical user interface (GUI). If you stop this service, you
cannot access the Cisco Unified Communications Manager Administration graphical user interface
when you browse into that server.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco
Unified Communications Manager only.

Service Activation

You can activate or deactivate multiple feature services or choose default services to activate from the
Service Activation window in Cisco Unified Serviceability.

Cisco Unified Serviceability Administration Guide
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Starting with Cisco Unified Communications Manager Release 6.1.1, end users can no longer access
Cisco Unified Serviceability to start and stop services.

Cisco Unified Serviceability activates feature services in automatic mode and checks for service
dependencies. When you choose to activate a feature service, Cisco Unified Serviceability prompts you
to select all the other services, if any, that depend on that service to run. When you click the Set Default
button, Cisco Unified Serviceability chooses those services that are required to run on the server.

Unified CM only: Even in a configuration that supports clusters, this process is based on a single-server
configuration.

Activating a service automatically starts the service. You start/stop services from Control Center.

Control Center

A

From Control Center in Cisco Unified Serviceability, you can view status and start and stop one service
at a time. In a cluster configuration (Cisco Unified Communications Manager only), you can perform
these functions for one server in the cluster. To perform these tasks, Cisco Unified Serviceability
provides two Control Center windows. To start, stop, and restart network services, access the Control
Center—Network Services window. To start, stop, and restart feature services, access the Control
Center—Feature Services window.

Use the Related Links drop-down list box and the Go button to navigate to Control Center and Service
Activation windows.

Unified CM only: Starting and stopping a feature service causes all Cisco Unified IP Phones and
gateways that are currently registered to that service to fail over to their secondary service. Devices and
phones need to restart only if they cannot register with their secondary service. Starting and stopping a
service may cause other installed applications (such as a conference bridge or Cisco Messaging
Interface) that are homed to that Cisco Unified Communications Manager to start and stop as well.

Caution

Unified CM and Unified CM BE only: Stopping a service also stops call processing for all devices that
the service controls. When a service is stopped, calls from an IP phone to another IP phone stay up; calls
in progress from an IP phone to a Media Gateway Control Protocol (MGCP) gateway also stay up, but
other types of calls drop.

[ oL-18619-01

Cisco Unified Serviceability Administration Guide g



Chapter9  Understanding Services |

M Services Configuration Checklist

Services Configuration Checklist

Table 9-1 lists the steps for working with services.

Table 9-1 Services Configuration Checklist

Configuration Steps

Procedures and Related Topics

Step 1 Activate the feature services that you want to run.

e Feature Services, page 9-1

e Activating and Deactivating
Feature Services, page 11-1

Step 2 Configure the appropriate service parameters.

e Unified CM and Unified CM BE
only: All service parameters for the
services in Cisco Unified
Serviceability display in Cisco
Unified Communications Manager
Administration. For service
parameter configuration, see the
Cisco Unified Communications
Manager Administration Guide.

e Connection only: You configure
service parameters in Cisco Unity
Connection Administration. For
service parameter configuration,
see the System Administration
Guide for Cisco Unity Connection.

Step 3 If necessary, troubleshoot problems by using the Cisco Unified
Serviceability trace tools.

e Configuring Trace, page 7-1

e Cisco Unified Real-Time
Monitoring Tool Administration
Guide

Where to Find More Information

Related Topics
e Control Center, page 9-17

e Feature Services, page 9-1

e Network Services, page 9-9

Additional Cisco Documentation

e Unified CM and Unified CM BE only: Cisco Unified Communications Manager System Guide
e Unified CM and Unified CM BE only: Cisco Unified Communications Manager Administration

Guide

e Unified CM and Unified CM BE only: Cisco Unified Communications Manager Features and

Services Guide

e Unified CM and Unified CM BE only: Cisco Unified Communications Manager Security Guide

l_ Cisco Unified Serviceability Administration Guide
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e Unified CM and Unified CM BE only: Troubleshooting Guide for Cisco Unified Communications
Manager

e Unified CM BE and Connection only: Cisco Unity Connection Serviceability Administration Guide
e Connection only: System Administration Guide for Cisco Unity Connection

e  Command Line Interface Reference Guide for Cisco Unified Solutions

Cisco Unified Serviceability Administration Guide
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Understanding Serviceability Reports Archive

The Cisco Serviceability Reporter service generates daily reports in Cisco Unified Serviceability. Each
report provides a summary that comprises different charts that display the statistics for that particular
report. Reporter generates reports once a day on the basis of logged information.

The following sections provide additional information, including detailed information about each report
that Serviceability Reporter generates:

e Serviceability Reporter Service Parameters, page 10-2

e Device Statistics Report, page 10-2

e Server Statistics Report, page 10-5

e Service Statistics Report, page 10-7

e (Call Activities Report, page 10-10

e Alert Summary Report, page 10-14

e Performance Protection Report, page 10-17

e Serviceability Reports Archive Configuration Checklist, page 10-18
¢ Where to Find More Information, page 10-18

Unified CM clusters only: Because the Cisco Serviceability Reporter is only active on the first server, at
any time, Reporter generates reports only on the first server, not the other servers.

You view reports from Cisco Unified Serviceability > Tools > Serviceability Reports Archive. You
must activate the Cisco Serviceability Reporter service before you can view reports. After you activate
the service, report generation may take up to 24 hours.

The reports contain 24-hour data for the previous day. A suffix that is added to the report names shows
the date for which Reporter generated them; for example, AlertRep_mm_dd_yyyy.pdf. The
Serviceability Reports Archive window uses this date to display the reports for the relevant date only.
The reports generate from the data that is present in the log files, with the timestamp for the previous
day. The system considers log files for the current date and the previous two days for collecting data.
For cluster configurations (Cisco Unified Communications Manager only), this takes into account the
time zone differences between the server locations.

The time that is shown in the report reflects the server “System Time.” In cluster configurations (Cisco
Unified Communications Manager only), the time that is shown in the report reflects the first server
“System Time.” If the first server and subsequent server(s) are in different time zones, the first server
“System Time” shows in the report.
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You can pick up log files from the server while you are generating reports, or in a cluster configuration
(Cisco Unified Communications Manager only), from all servers in the cluster.

The Cisco Unified Reporting web application provides snapshot views of data into one output and runs
data checks. In a cluster configuration (Cisco Unified Communications Manager only), this includes
cluster data from all accessible servers. The application also allows you to archive generated reports. See
the Cisco Unified Reporting Administration Guide for more information.

Serviceability Reporter Service Parameters

Note

Cisco Serviceability Reporter uses the following service parameters:

e RTMT Reporter Designated Node—Specifies the designated node on which RTMT Reporter runs.
This default equals the IP address of the server on which the Cisco Serviceability Reporter service
is first activated.

Unified CM only: Because the Serviceability Reporter service is CPU intensive, Cisco recommends
that you specify a non-call processing node.

e Report Generation Time—Specifies the number of minutes after midnight. Reports generate at this
time for the most recent day. The minimum value equals 0 and the maximum value equals 1439.

e Report Deletion Age—Specifies the number of days that the report must be kept on the disk. The
system deletes reports that are older than the specified age. The minimum value equals 0, and the
maximum value equals 30.

Tip You can disable reports by setting the service parameter Report Deletion Age to a value of 0.

For more information about service parameter configuration, refer to the following guides:

e Unified CM and Unified CM BE only: Cisco Unified Communications Manager Administration
Guide

e Connection only: System Administration Guide for Cisco Unity Connection

Unified CM only: If a node gets removed completely from the network (the node should be removed from
the network and also from the list of servers in Cisco Unified Communications Manager
Administration), Reporter does not consider this node while it is generating reports, even if the log file
contains the data for that node.

Device Statistics Report

The Device Statistics Report does not apply to Cisco Unity Connection.
The Device Statistics Report provides the following line charts:

e Number of Registered Phones per Server, page 10-3

e Number of H.323 Gateways in the Cluster, page 10-4
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e Number of Trunks in the Cluster, page 10-4

In a Cisco Unified Communications Manager Business Edition system, the Device Statistics Report
supports Cisco Unified Communications Manager only.

Number of Registered Phones per Server

A line chart displays the number of registered phones for each Cisco Unified Communications Manager
server (and cluster in a Cisco Unified Communications Manager cluster configuration). Each line in the
chart represents the data for a server for which data is available, and one extra line displays the
clusterwide data (Cisco Unified Communications Manager clusters only). Each data value in the chart
represents the average number of phones that are registered for a 15-minute duration. If a server shows
no data, Reporter does not generate the line that represents that server. If no data exists for the server (or
for all servers in a Cisco Unified Communications Manager cluster configuration), for registered phones,
Reporter does not generate the chart. The message “No data for Device Statistics report available”
displays.

Figure 10-1 shows an example of a line chart that represents the number of registered phones per Cisco
Unified Communications Manager server in a Cisco Unified Communications Manager cluster
configuration.

Figure 10-1 Line Chart That Depicts Number of Registered Phones Per Server
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Number of MGCP Gateways Registered in the Cluster

A line chart displays the number of registered MGCP FXO, FXS, PRI, and TICAS gateways. Each line
represents data only for the Cisco Unified Communications Manager server (or cluster in a Cisco
Unified Communications Manager cluster configuration); so, four lines show server (or clusterwide)
details for each gateway type. Each data value in the chart represents the average number of MGCP
gateways that are registered for a 15-minute duration. If no data exists for a gateway for the server (or
all the servers in a cluster), Reporter does not generate the line that represents data for that particular
gateway. If no data exists for all gateways for the server (or for all servers in a cluster), Reporter does
not generate the chart.

Figure 10-2 shows an example of a line chart that represents the number of registered gateways per
cluster, in a Cisco Unified Communications Manager cluster configuration.
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Figure 10-2 Line Chart That Depicts Number of Registered Gateways Per Cluster
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Number of H.323 Gateways in the Cluster

A line chart displays the number of H.323 gateways. One line represents the details of the H.323
gateways (or the clusterwide details in a Cisco Unified Communications Manager cluster configuration).
Each data value in the chart represents the average number of H.323 gateways for a 15-minute duration.
If no data exists for H.323 gateways for the server (or for all servers in a cluster), Reporter does not
generate the chart.

Figure 10-3 shows an example line chart that represents the number of H.323 gateways per cluster in a
Cisco Unified Communications Manager cluster configuration.

Figure 10-3 Line Chart That Depicts Number of Registered H.323 Gateways Per Cluster

Number of HAZ3 Gateways in the Cluster

H323 Devices

L | T 3 4 5 & T B 9 1% 11 12 13 M4 I5 1& IT 1B M N N 2 B M

Tirme

93300

Number of Trunks in the Cluster

A line chart displays the number of H.323 and SIP trunks. Two lines represent the details of the H.323
trunks and SIP trunks (or the clusterwide details in a Cisco Unified Communications Manager cluster
configuration). Each data value in the chart represents the average number of H.323 and SIP trunks for
a 15-minute duration. If no data exists for H.323 trunks for the server (or for all servers in a cluster),
Reporter does not generate the line that represents data for the H.323 trunks. If no data exists for SIP
trunks for the server (or for all servers in the cluster), Reporter does not generate the line that represents
data for SIP trunks. If no data exists for trunks at all, Reporter does not generate the chart.
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Figure 10-4 shows an example line chart that represents the number of trunks per cluster in a Cisco
Unified Communications Manager cluster configuration.

Figure 10-4 Line Chart That Depicts Number of Trunks Per Cluster
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The server (or each server in the cluster) contains log files that match the file name pattern
DeviceLog_mm_dd_yyyy_hh_mm.csv. The following information exists in the log file:

e Number of registered phones on the server (or on each server in a Cisco Unified Communications
Manager cluster)

e Number of registered MGCP FXO, FXS, PRI, and TICAS gateways on the server (or on each server
in a Cisco Unified Communications Manager cluster)

e Number of registered H.323 gateways on the server (or on each server in a Cisco Unified
Communications Manager cluster)

e Number of SIP trunks and H.323 trunks

Server Statistics Report

The Server Statistics Report provides the following line charts:
e Percentage of CPU per Server, page 10-5
e Percentage of Memory Usage per Server, page 10-6
e Percentage of Hard Disk Usage of the Largest Partition per Server, page 10-7

In a Cisco Unified Communications Manager Business Edition system, the Server Statistics Report
supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Percentage of CPU per Server

A line chart displays the percentage of CPU usage for the server (or for each server in a Cisco Unified
Communications Manager cluster). The line in the chart represents the data for the server (or one line
for each server in a Cisco Unified Communications Manager cluster) for which data is available. Each
data value in the chart represents the average CPU usage for a 15-minute duration. If no data exists for
the server (or for any one server in a Cisco Unified Communications Manager cluster), Reporter does
not generate the line that represents that server. If there are no lines to generate, Reporter does not create
the chart. The message “No data for Server Statistics report available” displays.

Cisco Unified Serviceability Administration Guide
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Figure 10-5 shows a line chart example that represents the percentage of CPU usage per server in a Cisco
Unified Communications Manager cluster configuration.

Figure 10-5
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Percentage of Memory Usage per Server

A line chart displays the percentage of Memory Usage for the Cisco Unified Communications Manager
server (%MemoryInUse). In a Cisco Unified Communications Manager cluster configuration, there is

one line per server in the cluster for which data is available. Each data value in the chart represents the
average memory usage for a 15-minute duration. If no data exists, Reporter does not generate the chart.
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If no data exists for any server in a Cisco Unified Communications Manager cluster configuration,

Reporter does not generate the line that represents that server.

Figure 10-6 shows a line chart example that represents the percentage of memory usage per Cisco
Unified Communications Manager server in a Cisco Unified Communications Manager cluster

configuration.

Figure 10-6
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Percentage of Hard Disk Usage of the Largest Partition per Server

A line chart displays the percentage of disk space usage for the largest partition on the server
(%DiskSpacelnUse), or on each server in a Cisco Unified Communications Manager cluster
configuration. Each data value in the chart represents the average disk usage for a 15-minute duration.
If no data exists, Reporter does not generate the chart. If no data exists for any one server in a cluster
configuration, Reporter does not generate the line that represents that server.

Figure 10-7 shows a line chart example that represents the percentage of hard disk usage for the largest
partition per server in a Cisco Unified Communications Manager cluster configuration.

Figure 10-7 Line Chart That Depicts Percentage of Hard Disk Usage of the Largest Partition Per
Server
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The server (or each server in a Cisco Unified Communications Manager cluster configuration) contains
log files that match the file name pattern ServerLog_mm_dd_yyyy_hh_mm.csv. The following
information exists in the log file:

* 9% CPU usage on the server (or each server in a Cisco Unified Communications Manager cluster)

* 9% Memory usage (%MemoryInUse) on the server (or on each server in a Cisco Unified
Communications Manager cluster)

* 9% Hard disk usage of the largest partition (%DiskSpacelnUse) on the server (or on each server in a
Cisco Unified Communications Manager cluster)

Service Statistics Report

The Service Statistics Report does not support Cisco Unity Connection.
The Service Statistics Report provides the following line charts:

e (Cisco CTI Manager: Number of Open Devices, page 10-8

e Cisco CTI Manager: Number of Open Lines, page 10-8

e Cisco TFTP: Number of Requests, page 10-9

e Cisco TFTP: Number of Aborted Requests, page 10-9

In a Cisco Unified Communications Manager Business Edition system, the Service Statistics Report
supports Cisco Unified Communications Manager only.
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Cisco CTI Manager: Number of Open Devices

A line chart displays the number of CTI Open Devices for the CTI Manager (or for each CTI Manager
in a Cisco Unified Communications Manager cluster configuration). Each line chart represents the data
for the server (or on each server in a Cisco Unified Communications Manager cluster) on which service
is activated. Each data value in the chart represents the average number of CTI open devices for a
15-minute duration. If no data exists, Reporter does not generate the chart. If no data exists for any one
server in a Cisco Unified Communications Manager cluster configuration, Reporter does not generate
the line that represents that server. The message “No data for Service Statistics report available”
displays.

Figure 10-8 shows a line chart example that represents the number of open devices per Cisco CTI
Manager in a Cisco Unified Communications Manager cluster configuration.

Figure 10-8 Line Chart That Depicts Cisco CTI Manager: Number of Open Devices

Cisco CT1 Monager: Number of Open Devices

[l
L

a0t

]
0 1 X 3 4 s & T ¥ % 1@ I 03I 13 04 15 @16 U7 MW 1% 30 11 31 3 M

Tirme

937594

Cisco CTI Manager: Number of Open Lines

A line chart displays the number of CTI open lines for the CTI Manager (or per CTI Manager in a Cisco
Unified Communications Manager cluster configuration). A line in the chart represents the data for the
server (or one line for each server in a Cisco Unified Communications Manager cluster configuration)
where the Cisco CTI Manager service is activated. Each data value in the chart represents the average
number of CTI open lines for a 15-minute duration. If no data exists, Reporter does not generate the
chart. If no data exists for any one server in a Cisco Unified Communications Manager cluster
configuration, Reporter does not generate the line that represents that server.

Figure 10-9 shows a line chart example that represents the number of open lines per Cisco CTI Manager
in a Cisco Unified Communications Manager cluster configuration.

Cisco Unified Serviceability Administration Guide
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Figure 10-9 Line Chart That Depicts Cisco CTI Manager: Number of Open Lines
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Cisco TFTP: Number of Requests

A line chart displays the number of Cisco TFTP requests for the TFTP server (or per TFTP server in a
Cisco Unified Communications Manager cluster configuration). A line in the chart represents the data
for the server (or one line for each server in a Cisco Unified Communications Manager cluster) where
the Cisco TFTP service is activated. Each data value in the chart represents the average number of TFTP
requests for a 15-minute duration. If no data exists, Reporter does not generate the chart. If no data exists
for any one server in a Cisco Unified Communications Manager cluster configuration, Reporter does not
generate the line that represents that server.

Figure 10-10 shows a line chart example that represents the number of Cisco TFTP requests per TFTP
server.

Figure 10-10 Line Chart That Depicts Cisco TFTP: Number of Requests
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Cisco TFTP: Number of Aborted Requests

A line chart displays the number of Cisco TFTP requests that were aborted for the TFTP server (or per
TFTP server in a Cisco Unified Communications Manager cluster configuration). A line in the chart
represents the data for the server (or one line for each server in a Cisco Unified Communications
Manager cluster) where the Cisco TFTP service is activated. Each data value in the chart represents the

Cisco Unified Serviceability Administration Guide
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average of TFTP requests that were aborted for a 15-minute duration. If no data exists, Reporter does
not generate the chart. If no data exists for any one server in a Cisco Unified Communications Manager
cluster configuration, Reporter does not generate the line that represents that server.

Figure 10-11 shows a line chart example that represents the number of Cisco TFTP requests that were
aborted per TFTP server.

Figure 10-11 Line Chart That Depicts Cisco TFTP: Number of Aborted Requests
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The server (or each server in a Cisco Unified Communications Manager cluster) contains log files that
match the file name pattern ServiceLog_mm_dd_yyyy_hh_mm.csv. The following information exists in
the log file:

e For each CTI Manager - Number of open devices

e For each CTI Manager - Number of open lines

e For each Cisco TFTP server - TotalTftpRequests

e For each Cisco TFTP server - TotalTftpRequestsAborted

Call Activities Report

The Call Activities Report does not support Cisco Unity Connection.
The Call Activities Report provides the following line charts:
¢ (Cisco Unified Communications Manager Call Activity for the Cluster, page 10-10
e H.323 Gateways Call Activity for the Cluster, page 10-11
¢ MGCP Gateways Call Activity for the Cluster, page 10-12
e MGCP Gateways, page 10-12
e Trunk Call Activity for the Cluster, page 10-13

In a Cisco Unified Communications Manager Business Edition system, the Server Statistics Report
supports Cisco Unified Communications Manager only.

Cisco Unified Communications Manager Call Activity for the Cluster

A line chart displays the number of Cisco Unified Communications Manager calls that were attempted
and calls that were completed. In a Cisco Unified Communications Manager cluster configuration, the
line chart displays the number of calls attempted and completed for the entire cluster. The chart

Cisco Unified Serviceability Administration Guide
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comprises two lines, one for the number of calls that were attempted and another for the number of calls
that were completed. For a Cisco Unified Communications Manager cluster configuration, each line
represents the cluster value, which is the sum of the values for all the servers in the cluster (for which
data is available). Each data value in the chart represents the total number of calls that were attempted
or calls that were completed for a 15-minute duration.

If no data exists for Cisco Unified Communications Manager calls that were completed, Reporter does
not generate the line that represents data for the calls that were completed. If no data exists for Cisco
Unified Communications Manager calls that were attempted, Reporter does not generate the line that
represents data for the calls that were attempted. In a Cisco Unified Communications Manager cluster
configuration, if no data exists for a server in the cluster, Reporter does not generate the line that
represents calls attempted or completed on that server. If no data exists for Cisco Unified
Communications Manager call activities at all, Reporter does not generate the chart. The message “No
data for Call Activities report available” displays.

Figure 10-12 shows a line chart example that represents the number of attempted and completed calls
for a Cisco Unified Communications Manager cluster.

Figure 10-12 Line Chart That Depicts Cisco Unified Communications Manager Call Activity for a
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H.323 Gateways Call Activity for the Cluster

A line chart displays the number of calls that were attempted and calls that were completed for H.323
gateways. In a Cisco Unified Communications Manager cluster configuration, the line chart displays the
number of calls attempted and completed for the entire cluster. The chart comprises two lines, one for
the number of calls that were attempted and another for the number of calls that were completed. For a
Cisco Unified Communications Manager cluster configuration, each line represents the cluster value,
which equals the sum of the values for all the servers in the cluster (for which data is available). Each
data value in the chart represents the total number of calls that were attempted or calls that were
completed for a 15-minute duration. If no data exists for H.323 gateways calls that were completed,
Reporter does not generate the line that represents data for calls that were completed. If no data exists
for H.323 gateways calls that were attempted, Reporter does not generate the line that represents data
for calls that were attempted. In a Cisco Unified Communications Manager cluster configuration, if no
data exists for a server in the cluster, Reporter does not generate the line that represents calls attempted
or completed on that server. If no data exists for H.323 gateways call activities at all, Reporter does not
generate the chart.

Figure 10-13 shows a line chart example that represents the H.323 gateway call activity for a Cisco
Unified Communications Manager cluster.
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Figure 10-13 Line Chart That Depicts H.323 Gateways Call Activity for the Cluster
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MGCP Gateways Call Activity for the Cluster

A line chart displays the number of calls that were completed in an hour for MGCP FXO, FXS, PRI, and
T1CAS gateways. In a Cisco Unified Communications Manager cluster configuration, the chart displays
the number of calls that were completed for the entire Cisco Unified Communications Manager cluster.
The chart comprises four lines at the most, one for the number of calls that were completed for each of
the gateway types (for which data is available). Each data value in the chart represents the total number
of calls that were completed for a 15-minute duration. If no data exists for a gateway, Reporter does not
generate the line that represents data for calls that were completed for a particular gateway. If no data
exists for all gateways, Reporter does not generate the chart.

Figure 10-14 shows a line chart example that represents the MGCP gateways call activity for a Cisco
Unified Communications Manager cluster.

Figure 10-14 Line Chart That Depicts MGCP Gateways Call Activity for the Cluster
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MGCP Gateways

A line chart displays the number of Ports In Service and Active Ports for MGCP FXO, FXS gateways
and the number of Spans In Service or Channels Active for PRI, TICAS gateways. For a Cisco Unified
Communications Manager cluster configuration, the chart displays the data for the entire Cisco Unified
Communications Manager cluster. The chart comprises eight lines, two lines each for the number of
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Ports In Service for MGCP FXO and FXS, and two lines each for the number of Active Ports for MGCP
FXO and FXS. Four more lines for the number of Spans In Service and Channels Active for PRI and
T1CAS gateways exist. For a Cisco Unified Communications Manager cluster configuration, each line
represents the cluster value, which is the sum of the values for all servers in the cluster (for which data
is available). Each data value in the chart represents the total Number of Ports In Service, Number of
Active Ports, Spans In Service or Channels Active for a 15-minute duration. If no data exists for the
number of Spans In Service or the Channels Active for a gateway (MGCP PRI, T1CAS) for all servers,
Reporter does not generate the line that represents data for that particular gateway.

Figure 10-15 shows a line chart example that represents the MGCP gateways.

Figure 10-15 Line Chart That Depicts MGCP Gateways
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Trunk Call Activity for the Cluster

A line chart displays the number of calls that were completed and calls that were attempted in an hour
for SIP trunk and H.323 trunk. For a Cisco Unified Communications Manager cluster configuration, the
chart displays the number of calls that were completed and calls that were attempted for the entire Cisco
Unified Communications Manager cluster. The chart comprises four lines, two for the number of calls
that were completed for each SIP and H.323 trunk (for which data is available) and two for the number
of calls that were attempted. For a Cisco Unified Communications Manager cluster configuration, each
line represents the cluster value, which is the sum of the values for all nodes in the cluster (for which
data is available). Each data value in the chart represents the total number of calls that were completed
or number of calls that were attempted for a 15-minute duration. If no data exists for a trunk, Reporter
does not generate the line that represents data for the calls that were completed or the calls that were
attempted for that particular trunk. If no data exists for both trunk types, Reporter does not generate the
chart.

Figure 10-16 shows a line chart example that represents the trunk call activity for a Cisco Unified
Communications Manager cluster.
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Figure 10-16 Line Chart That Depicts Trunk Call Activity for the Cluster
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The server (or each server in a Cisco Unified Communications Manager cluster configuration) contains
log files that match the file name pattern CallLog_mm_dd_yyyy_hh_mm.csv. The following
information exists in the log file:

e (alls that were attempted and calls that were completed for Cisco Unified Communications
Manager (or for each server in a Cisco Unified Communications Manager cluster)

e (alls that were attempted and calls that were completed for the H.323 gateways (or for the gateways
in each server in a Cisco Unified Communications Manager cluster)

e (alls that were completed for the MGCP FXO, FXS, PRI, and TICAS gateways (or for the gateways
in each server in a Cisco Unified Communications Manager cluster)

e Ports in service, active ports for MGCP FXO and FXS gateways and spans in service, channels
active for PRI, and TICAS gateways (in each server in a Cisco Unified Communications Manager
cluster)

e (Calls that were attempted and calls that were completed for H.323 trunks and SIP trunks

Alert Summary Report

The Alert Summary Report provides the details of alerts that are generated for the day. The Alert report
comprises the following charts:

e Number of Alerts per Server, page 10-14
e Number of Alerts per Severity for the Cluster, page 10-15
e Top 10 Alerts in the Cluster, page 10-16

In a Cisco Unified Communications Manager Business Edition system, the Server Statistics Report
supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Number of Alerts per Server

Unified CM only: A pie chart provides the number of alerts per Cisco Unified Communications Manager
node. The chart displays the serverwide details of the alerts that are generated. Each sector of the pie
chart represents the number of alerts generated for a particular server in the Cisco Unified
Communications Manager cluster. The chart includes as many number of sectors as there are servers (for
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which Reporter generates alerts in the day) in the cluster. If no data exists for a server, no sector in the
chart represents that server. If no data exists for all servers, Reporter does not generate the chart. The
message “No alerts were generated for the day” displays.

Unified CM BE and Connection only: A pie chart provides the number of alerts for the server. The chart
displays the serverwide details of the alerts that are generated. If no data exists for the server, Reporter
does not generate the chart. The message “No alerts were generated for the day” displays.

Figure 10-17 shows a pie chart example that represents the number of alerts per server in a Cisco Unified
Communications Manager cluster.

Figure 10-17 Pie Chart That Depicts Number of Alerts Per Server
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Number of Alerts per Severity for the Cluster

A pie chart displays the number of alerts per alert severity. The chart displays the severity details of the
alerts that are generated. Each sector of the pie chart represents the number of alerts that are generated
of a particular severity type. The chart provides as many number of sectors as there are severities (for
which Reporter generates alerts in the day). If no data exists for a severity, no sector in the chart
represents that severity. If no data exists, Reporter does not generate the chart.

Figure 10-18 shows a pie chart example that represents the number of alerts per severity for a Cisco
Unified Communications Manager cluster.
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Figure 10-18 Pie Chart That Depicts Number of Alerts Per Severity for the Cluster
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Top 10 Alerts in the Cluster

A bar chart displays the number of alerts of a particular Alert Type. The chart displays the details of the
alerts that are generated on the basis of the alert type. Each bar represents the number of alerts for an
alert type. The chart displays details only for the first 10 alerts based on the highest number of alerts in
descending order. If no data exists for a particular alert type, no bar represents that alert. If no data exists
for any alert type, RTMT does not generate the chart.

Figure 10-19 shows a bar chart example that represents the top 10 alerts in a Cisco Unified
Communications Manager cluster.

Figure 10-19 Bar Chart That Depicts Top 10 Alerts in the Cluster
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The server (or each server in a Cisco Unified Communications Manager cluster) contains log files that
match the file name pattern AlertLog_mm_dd_yyyy_hh_mm.csv. The following information exists in
the log file:

e Time—Time at which the alert occurred
e Alert Name—Descriptive name
e Node Name—Server on which the alert occurred

e Monitored object—The object that is monitored
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e Severity—Severity of this alert

Performance Protection Report

The Performance Protection Report does not apply to Cisco Unity Connection.

The Performance Protection Report provides trend analysis information on default monitoring objects
that allows you to track overall system health. The report includes information for the last seven days.

The Performance Protection report comprises the following charts:
e Cisco Unified Communications Manager Call Activity, page 10-17
e Number of registered phones and MGCP gateways, page 10-17
e System Resource Utilization, page 10-17
e Device and Dial Plan Quantities, page 10-17

For a Cisco Unified Communications Manager Business Edition system, the Server Statistics Report
supports Cisco Unified Communications Manager only.

Cisco Unified Communications Manager Call Activity

A line chart displays the hourly rate of increase or decrease for number of calls that were attempted and
calls that were completed as the number of active calls. For a Cisco Unified Communications Manager
cluster configuration, the data is charted for each server in the cluster. The chart comprises three lines,
one for the number of calls that were attempted, one for the calls that were completed, and one for the
active calls. If no data exists for call activity, Reporter does not generate the chart.

Number of registered phones and MGCP gateways

A line chart displays the number of registered phones and MGCP gateways. For a Cisco Unified
Communications Manager cluster configuration, the chart displays the data for each server in the
cluster.The chart comprises two lines, one for the number of registered phones and another for the
number of MGCP gateways. If no data exists for phones or MGCP gateways, Reporter does not generate
the chart.

System Resource Utilization

A line chart displays the CPU load percentage and the percentage of memory that is used (in bytes) for
the server (or for the whole cluster in a Cisco Unified Communications Manager cluster configuration).
The chart comprises two lines, one for the CPU load and one for the memory usage. In a Cisco Unified
Communications Manager cluster, each line represents the cluster value, which is the average of the
values for all the servers in the cluster (for which data is available). If no data exists for phones or MGCP
gateways, Reporter does not generate the chart.

Device and Dial Plan Quantities

Two tables display information from the Cisco Unified Communications Manager database about the
numbers of devices and number of dial plan components. The device table shows the number of IP
phones, Unity connection ports, H.323 clients, H.323 gateways, MGCP gateways, MOH resources, and
MTP resources. The dial plan table shows the number of directory numbers and lines, route patterns, and
translation patterns.
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Serviceability Reports Archive Configuration Checklist

Table 10-1

Table 10-1 provides a configuration checklist for configuring the serviceability report archive feature.

Serviceability Reports Archive Configuration Checklist

Configuration Steps

Related Procedures and Topics

Step 1 Activate the Cisco Serviceability Reporter service. Activating and Deactivating Feature Services,
page 11-1
Step 2 Configure the Cisco Serviceability Reporter service e Unified CM and Unified CM BE only: Cisco Unified
parameters. Communications Manager Administration Guide
e Connection only: System Administration Guide for
Cisco Unity Connection
e Serviceability Reporter Service Parameters,
page 10-2
Step 3 View the reports that the Cisco Serviceability Reporter |Configuring Serviceability Reports Archive, page 12-1

service generates.

Where to Find More Information

Related Topics

¢ Configuring Serviceability Reports Archive, page 12-1

Additional Cisco Documentation

e Cisco Unified Real-Time Monitoring Tool Administration Guide

e Cisco Unified Reporting Administration Guide

l_ Cisco Unified Serviceability Administration Guide
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Configuring Services

This chapter contains information on the following topics:
e Activating and Deactivating Feature Services, page 11-1
e Cluster Service Activation Recommendations, page 11-2
e Starting, Stopping, Restarting, and Refreshing Status of Services in Control Center, page 11-4

e Using a Command Line Interface to Start and Stop Services, page 11-6

Activating and Deactivating Feature Services

Step 1

Step 2

Step 3

You activate and deactivate feature services in the Service Activation window in Cisco Unified
Serviceability. Services that display in the Service Activation window do not start until you activate
them.

Cisco Unified Serviceability allows you to activate and deactivate only features services (not network
services). You may activate or deactivate as many services as you want at the same time. Some feature
services depend on other services, and the dependent services get activated before the feature service
activates.

Unified CM only: Before you activate services in the Service Activation window, review Table 11-1.

To activate or deactivate feature services in Cisco Unified Serviceability, perform the following
procedure:

Procedure

Choose Tools > Service Activation.
The Service Activation window displays.

From the Server drop-down list box, choose the server where you want to activate the service; then, click
Go.

For the server that you chose, the window displays the service names and the activation status of the
services.

To activate all services in the Service Activation window, check the Check All Services check box.
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Step4  Youcan choose all services that are required to run on a single server by clicking the Set Default button.
This action not only chooses all required services but also checks for service dependencies. To activate
services for a single-server configuration, click the Set Default button or activate the services that you
want to use.

Step5  Unified CM only: For a cluster configuration, review Table 11-1 for service activation
recommendations; then, check the check boxes next to the services that you want to activate.

Step6  After you check the check boxes for the services that you want to activate, click Save.

ye

Tip To deactivate services that you activated, uncheck the check boxes next to the services that you
want to deactivate; then, click Save.

To obtain the latest status of the services, click the Refresh button.

Additional Information
See the “Related Topics” section on page 11-6.

Cluster Service Activation Recommendations

This section does not apply to Cisco Unified Communications Manager Business Edition or Cisco Unity
Connection.

Before you activate services in a cluster, review Table 11-1, which provides service recommendations
for multiserver configurations.

Table 11-1 Service Activation Recommendations

Service/Servlet Activation Recommendations

CM Services

Cisco CallManager This service supports Cisco Unified Communications Manager.

In the Control Center—Network Services, ensure that the Cisco RIS Data
Collector service and Database Layer Monitor service are running on the
node.

Tip Before you activate this service, verify that the Cisco Unified
Communications Manager server displays in the Cisco Unified
Communications Manager Find/List window in Cisco Unified
Communications Manager Administration. If the server does not
display, add the Cisco Unified Communications Manager server
before you activate this service. For information on how to add the
Cisco Unified Communications Manager server, refer to the Cisco
Unified Communications Manager Administration Guide.

Cisco TFTP If you have more than one node in the cluster, activate this service on one
node that is dedicated specifically for the Cisco TFTP service. Configure
Option 150 if you activate this service on more than one node in the cluster.

Cisco Messaging Activate on only one node in the cluster. Do not activate this service if you
Interface plan to use Cisco Unity voice-messaging system.
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Table 11-1

Cluster Service Activation Recommendations W

Service Activation Recommendations (continued)

Service/Servlet

Activation Recommendations

Cisco Unified Mobile
Voice Access Service

For mobile voice access to work, you must activate this service on the first
node in the cluster after you configure the H.323 gateway to point to the
first VXML page. In addition, make sure that the Cisco CallManager and
the Cisco TFTP services run on one server in the cluster, not necessarily
the same server where the Cisco Unified Mobile Voice Access Service
runs.

Cisco IP Voice Media
Streaming App

If you have more than one node in the cluster, activate on one or two
servers per cluster. You may activate on a node that is dedicated
specifically for music on hold. This service requires that you activate Cisco
TFTP on one node in the cluster. Do not activate this service on the first
node or on any nodes that run the Cisco CallManager service.

Cisco CTIManager

Activate on each node to which JTAPI/TAPI applications will connect.
CTIManager activation requires the Cisco CallManager service also to be
activated on the node. See the “Cisco CallManager” section on page 9-4
for more information on CTIManager and Cisco CallManager services
interaction.

Cisco Extension Mobility

Activate on all nodes in the cluster.

Cisco Extended
Functions

Activate this service, which supports the Quality Report Tool (QRT), on
one or more servers that run the Cisco RIS Data Collector. Make sure that
you activate the Cisco CTIManager service on a node in the cluster.

Cisco Dialed Number
Analyzer

If you are planning to use Cisco Unified Communications Manager Dialed
Number Analyzer, activate this service. This service may consume a lot of
resources, so only activate this service on the node with the least amount
of call-processing activity or during off-peak hours.

Cisco DHCP Monitor
Service

When the DHCP Monitor service is enabled, it detects changes in the
database that affect IP addresses for the IP phones, modifies the
/etc/dhcpd.conf file, and stops and restarts the DHCPD daemon with the
updated configuration file. Activate this service on the node that has DHCP
enabled.

CTI Services

Cisco CallManager
Attendant Console Server

To use Cisco Unified Communications Manager Attendant Console,
activate on every node in the cluster that runs the Cisco CallManager
service.

Cisco IP Manager
Assistant

If you are planning to use Cisco Unified Communications Manager
Assistant, activate this service on any two servers (Primary and Backup) in
the cluster. Ensure that Cisco CTI Manager service is activated in the
cluster. Refer to Cisco Unified Communications Manager Features and
Services Guide for other recommendations.

Cisco WebDialer Web
Service

Activate on one node per cluster.

CDR Services

Cisco
SOAP-CDRonDemand
Service

You can activate the Cisco SOAP-CDROnDemand Service only on the
first server, and it requires that the Cisco CDR Repository Manager and
Cisco CDR Agent services are running on the same server.
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Table 11-1 Service Activation Recommendations (continued)

Service/Servlet Activation Recommendations

Cisco CAR Web Service |You can activate the Cisco CAR Web Service only on the first server, and
it requires that the Cisco CAR Scheduler service is activated and running
on the same server and that the CDR Repository Manager service also is
running on the same server.

Database and Admin Services

Cisco AXL Web Service |Activate on the first node only. Failing to activate this service causes the
inability to update Cisco Unified Communications Manager from
client-based applications that use AXL.

Cisco Bulk Provisioning |You can activate the Cisco Bulk Provisioning Service only on the first
Service node. If you use the Bulk Administration Tool (BAT) to administer phones
and users, you must activate this service.

Cisco TAPS Service Before you can use the Cisco Unified Communications Manager
Auto-Register Phone Tool, you must activate this service on the first node.
When you create dummy MAC addresses for the Cisco Unified
Communications Manager Auto-Register Phone Tool, ensure that the
Cisco Bulk Provisioning Service is activated on the same node.

Performance and Monitoring Services

Cisco Serviceability Activate on only the first node.

Reporter Note  The service only generates reports on the first node even if you

activate the service on other nodes.

Cisco CallManager If you use SNMP, activate this service on all servers in the cluster.
SNMP Service

Security Services

Cisco CTL Provider Activate on all servers in the cluster.
Cisco Certificate Activate on only the first node.
Authority Proxy Function

(CAPF)

Directory Services

Cisco DirSync ‘Activate only on the first node.

Starting, Stopping, Restarting, and Refreshing Status of Services
in Control Center

Unified CM only: Control Center in Cisco Unified Serviceability allows you to view status, refresh the
status, and to start, stop, and restart feature and network services.

Unified CM only: Starting, stopping, or restarting a service causes all Cisco Unified IP Phones and
gateways that are currently registered to that service to fail over to their secondary Cisco CallManager
service. Devices and phones need to restart only if they cannot register with another service.

Unified CM and Unified CM BE only: Starting, stopping, or restarting a service causes other installed
applications (such as conference bridge or Cisco Messaging Interface) that are homed to the Cisco
Unified Communications Manager to start and stop as well.

Cisco Unified Serviceability Administration Guide
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Note

A

Starting, Stopping, Restarting, and Refreshing Status of Services in Control Center

Unified CM only: If you are upgrading Cisco Unified Communications Manager, those services that
were already started on your system automatically start after the upgrade.

Caution  Unified CM and Unified CM BE only: Stopping a service also stops call processing for all devices that
the service controls. When a service is stopped, calls from an IP phone to another IP phone stay up; calls
in progress from an IP phone to a Media Gateway Control Protocol (MGCP) gateway also stay up, and
other types of calls get dropped.

Perform the following procedure to start, stop, restart, or view the status of services for a server (or for
a server in a cluster in a Cisco Unified Communications Manager cluster configuration). You can start,
stop, or refresh only one service at a time. Be aware that when a service is stopping, you cannot start it
until after the service is stopped. Likewise, when a service is starting, you cannot stop it until after the
service is started.
Procedure
Step1  Depending on the service type that you want to start/stop/restart/refresh, perform one of the following
tasks:
¢ Choose Tools > Control Center—Feature Services.
Tip Before you can start/stop/restart a feature service, it must be activated. To activate a service, see
the “Activating and Deactivating Feature Services” section on page 11-1.
e Choose Tools > Control Center—Network Services.
Step 2 From the Server drop-down list box, choose the server; then, click Go.
The window displays the following items:
e The service names for the server that you chose.
e The service group.
e The service status; for example, Started, Running, Not Running, and so on. (Status column)
e The exact time that the service started running. (Start Time column)
e The amount of time that the service has been running. (Up Time column)
Step3  Perform one of the following tasks:
e Click the radio button next to the service that you want to start and click the Start button.
The Status changes to reflect the updated status.
e Click the radio button next to the service that you want to stop and click the Stop button.
The Status changes to reflect the updated status.
e Click the radio button next to the service that you want to restart and click the Restart button.
A message indicates that restarting may take a while. Click OK.
e To get the latest status of the services, click the Refresh button.
Cisco Unified Serviceability Administration Guide
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To go to the Service Activation window or to the other Control Center window, choose an option
from the Related Links drop-down list box and click Go.

Additional Information

See the “Related Topics” section on page 11-6.

Using a Command Line Interface to Start and Stop Services

You can start and stop some services through the Command Line Interface (CLI). For a list of services
that you can start and stop through the CLI and for information on how to perform these tasks, refer to
the Command Line Interface Reference Guide for Cisco Unified Solutions.

Tip You must start and stop most services from Control Center in Cisco Unified Serviceability.

Additional Information

See the “Related Topics” section on page 11-6.

Where to Find More Information

Related Topics

Understanding Services, page 9-1

Activating and Deactivating Feature Services, page 11-1

Unified CM only: Cluster Service Activation Recommendations, page 11-2

Starting, Stopping, Restarting, and Refreshing Status of Services in Control Center, page 11-4

Using a Command Line Interface to Start and Stop Services, page 11-6

Cisco Unified Serviceability Administration Guide
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Configuring Serviceability Reports Archive

The Cisco Serviceability Reporter service generates daily reports in Cisco Unified Serviceability. Each
report provides a summary that comprises different charts that display the statistics for that particular
report. Reporter generates reports once a day on the basis of logged information.

This section describes how to use the Serviceability Reports Archive window.

Before you Begin

Activate the Cisco Serviceability Reporter service, which is CPU intensive. After you activate the
service, report generation may take up to 24 hours.

Unified CM only: Cisco recommends that you activate the service on a non-callprocessing server.

Procedure

Choose Tools > Serviceability Reports Archive.

The Serviceability Reports Archive window displays the month and year for which the reports are
available.

From the Month-Year pane, choose the month and year for which you want to display reports.
A list of days that correspond to the month displays.

To view reports, click the link that corresponds to the day for which reports were generated.
The report files for the day that you chose display.

To view a particular PDF report, click the link of the report that you want to view.

L

ﬁ If you browsed into Cisco Unified Serviceability by using the server name, you must log in to
Cisco Unified Serviceability before you can view the report.

L

Tip If your network uses Network Address Translation (NAT) and you are trying to access
serviceability reports inside the NAT, enter the IP address for the private network that is
associated with the NAT in the browser URL. If you are trying to access the reports outside the
NAT, enter the public IP address, and NAT will accordingly translate/map to the private IP
address.
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[ | Where to Find More Information

Je

ﬁ To view PDF reports, you must install Acrobat ® Reader on your machine. To download
Acrobat Reader, click the link at the bottom of the Serviceability Reports Archive window.

A window opens and displays the PDF file of the report that you chose.

Additional Information
See the “Related Topics” section on page 12-2.

Where to Find More Information

Related Topics
e Understanding Serviceability Reports Archive, page 10-1

Additional Cisco Documentation
Cisco Unified Real-Time Monitoring Tool Administration Guide

Cisco Unified Serviceability Administration Guide
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Configuring CDR Repository Manager

Use the CDR Management Configuration window to set the amount of disk space to allocate to call detail
record (CDR) and call management record (CMR) files, configure the number of days to preserve files
before deletion, and configure up to three billing application server destinations for CDRs. The CDR
repository manager service repeatedly attempts to deliver CDR and CMR files to the billing servers that
you configure in the CDR Management Configuration window until it delivers the files successfully,
until you change or delete the billing application server on the CDR Management Configuration
window, or until the files fall outside the preservation window and are deleted.

Unified CM BE only: The CDR and CMR files get offloaded to the external billing application servers
by using the time interval that you have previously specified in the CDR File Time Interval enterprise
parameter in Cisco Unified Communications Manager. After the Communications Manager generates
the files, the CDR Agent and CDR Repository Manager take over. On each Communications Manager
server, the CDR agent pushes the CDR flat files to the publisher. The CDR Repository Manager pushes
the files to the external billing application servers.

To access the Enterprise Parameters Configuration window, open Cisco Unified Communications
Manager Administration and choose System -> Enterprise Parameters. The CDR File Time Interval
parameter specifies the time interval for collecting CDR data. For example, if this value is set to 1, each
file will contain 1 minute of CDR data (CDRs and CMRs, if enabled). The external billing server and
CAR database will not receive the data in each file until the interval has expired, so consider how quickly
you want access to the CDR data when you decide what interval to set for this parameter. For example,
setting this parameter to 60 means that each file will contain 60 minutes worth of data, but that data will
not be available until the 60-minute period has elapsed, and the records are written to the CAR database.
and the CDR files are sent to the configured billing server(s). The default value equals 1. The minimum
value specifies 1, and the maximum value specifies 1440. The unit of measure for this required field
represents a minute.

Both the CDR Agent and the CDR Repository Manager process files with an interval that is independent
of the CDR File Time Interval. The CDR Repository Manager sends all existing CDR files to the billing
application servers, sleeps for 6 seconds before checking the new files to send, and continues that
6-second interval. If the destination (the external billing application servers) does not respond, the
system attempts the process again by using a doubled length of the sleep interval (12 seconds). Each
delivery failure results in double the sleep time (6, 12, 24, 48,and so on, seconds) until 2 minutes occurs,
then stays at 2-minute intervals until successful delivery occurs. After successful delivery, the 6-second
interval automatically resumes.

Users cannot configure the 6-second processing time, with the sleep time interval doubling in case of
failure. Users can configure only the CDR File Time Interval enterprise parameter. No alert gets sent
after the first file delivery failure. By default, the system generates the CDRFileDeliveryFailed alert
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after the second delivery failure of the Cisco CDR Repository Manager service to deliver files to any
billing application server. You can configure the alert to send you an e-mail or to page you. For
information on configuring alerts, see the “Working with Alerts” chapter in the Cisco Unified Real-Time
Monitoring Tool Administration Guide.

The system generates the CDRFileDeliveryFailureContinues syslog alarm upon subsequent failures to
deliver the files to the billing application servers.

The CDR Agent behaves in almost the same manner. First, it sends all the existing CDR files to the
publisher. If no additional files to send exist, the CDR Agent sleeps for 6 seconds before checking for
new files. Each delivery failure results in the immediate change of the sleep interval to 1 minute, then
says at 1-minute intervals until successful delivery. After the first successful delivery of files, the
6-second interval resumes.

The system sends no alert after the first file delivery failure by the CDR Agent. By default, the system
generates the CDRAgentSendFileFailed alert after the second delivery failure of the CDR Agent. You
can configure the alert to send you an e-mail or to page you. For information on configuring alerts, see
the “Working with Alerts” chapter in the Cisco Unified Real-Time Monitoring Tool Administration
Guide

The system generates the CDRAgentSendFileFailedContinues syslog alarm upon subsequent failures to
deliver the files.

If you need to start or restart the file transfer timer for any reason, you can restart the Cisco CDR
Repository Manager or CDR Agent process by going to the Cisco Unified Serviceability window and
selecting Tools -> Control Center -> Network Services.

When you enable the file deletion based on high water mark parameter, the CDR repository manager
service monitors the amount of disk space that CDR and CMR files use. If disk usage exceeds the high
water mark that you configure, the system purges the CDR and CMR files that have been successfully
delivered to all destinations and loaded into the CAR database (if CAR is activated) until the disk space
reaches the low water mark or the system deletes all successfully delivered files. If disk usage still
exceeds the high water mark after the system deletes all successfully delivered files, it does not delete
any more files, unless the disk usage still exceeds the disk allocation that you configure. If the disk usage
still exceeds the disk allocation that you configure, the system purges files beginning with the oldest,
regardless of whether the files fall within the preservation window or have been successfully delivered,
until the disk usage falls below the high water mark.

Note  Regardless of whether you enable the deletion of files based on the high water mark parameter, if disk
usage exceeds the disk allocation that you configure, the CDR repository manager service deletes CDR
and CMR files, beginning with the oldest files, until disk utilization falls below the high water mark.

The Cisco Log Partition Monitoring Tool service monitors the disk usage of CDR and CMR flat files
that have not been delivered to the CDR repository manager.

Unified CM only: If the disk usage of the log partition on a server exceeds the configured limit and the
service has deleted all other log and trace files, the log partition monitor service deletes CDR/CMR files
on the subsequent nodes that have not been delivered to the CDR repository manager.

For more information on log partition monitoring, refer to the Cisco Unified Real-Time Monitoring Tool
Administration Guide.

This chapter contains the following topics:
e Configuring the CDR Repository Manager General Parameters, page 13-3
¢ Configuring Application Billing Servers, page 13-6
e Application Billing Server Parameter Settings, page 13-7
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Configuring the CDR Repository Manager General Parameters W

e Deleting Application Billing Servers, page 13-7
e Where to Find More Information, page 13-8

Configuring the CDR Repository Manager General Parameters

To set disk utilization and file preservation parameters for CDRs, perform the following procedure:

Procedure

Step 1 Choose Tools > CDR Management.
The CDR Management window displays.
Step2  Click the CDR Manager general parameter value that you want to change.
Step3  Enter the appropriate parameters, as described in Table 13-1.
Step4  Click Update.

L

ﬁ At any time, you can click Set Default to specify the default values. After you set the defaults,
click Update to save the default values.

Additional Information
See the “Related Topics” section on page 13-8.

Cisco Unified Serviceability Administration Guide
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CDR Repository Manager General Parameter Settings

Table 13-1 describes the available settings in the General Parameters section of the CDR Management
Configuration window. For related procedures, see the “Related Topics” section on page 13-8.

Table 13-1 CDR Repository Manager General Parameter Settings
Field Description
Disk Allocation (MB) Choose the number of megabytes that you want to allocate to CDR and

CMR flat file storage.

The default disk allocation and range vary depending on the size of the
server hard drive.

Note The maximum CAR database size equals 6 GB for a Cisco
Unified Communications Manager server and 3 GB for a Cisco
Unified Communications Manager Business Edition server.

Note If disk usage exceeds the allocated maximum disk space for CDR
files, the system generates the
CDRMaximumDiskSpaceExceeded alert and deletes all
successfully processed files (those delivered to billing servers
and loaded to CAR). If disk usage still exceeds the allocated disk
space, the system deletes undelivered files and files within the
preservation duration, starting with the oldest, until disk
utilization falls below the high water mark.

Note If you have alarge system and do not allocate enough disk space,
the system may delete the CDR and CMR files before the CAR
Scheduler loads the files into the CAR database. For example, if
you configure the CAR Scheduler to run once a day and you set
the disk allocation to a value that is not large enough to hold the
CDR and CMR files that are generated in a day, the system will
delete the files before they are loaded into the CAR database.

Cisco Unified Serviceability Administration Guide
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CDR Repository Manager General Parameter Settings

Table 13-1 CDR Repository Manager General Parameter Settings (continued)
Field Description
High Water Mark (%) This field specifies the maximum percentage of the allocated disk space

for CDR and CMR files. For example, if you choose 2000 megabytes
from the Disk Allocation field and 80% from the High Water Mark (%)
field, the high water mark equals 1600 megabytes. In addition to the high
water mark percentage, the number of CDRs in the CAR database cannot
exceed two million records for a Cisco Unified Communications
Manager server and one million records for a Cisco Unified
Communications Manager Business Edition server.

When the disk usage exceeds the percentage that you specify, or the total
number of CDRs is exceeded, and the Disable CDR/CMR Files Deletion
Based on HWM check box is unchecked, the system automatically
purges all successfully processed CDR and CMR files (those delivered to
billing servers and loaded to CAR) beginning with the oldest files to
reduce disk usage to the amount that you specify in the Low Water Mark
(%) drop-down list box.

If the disk usage still exceeds the low water mark or high water mark, the
system does not delete any undelivered or unloaded files, unless the disk
usage exceeds the disk allocation.

If you check the Disable CDR/CMR Files Deletion Based on HWM
check box, the system does not delete CDRs and CMRs based on the
percentage that you specify in this field.

Note If CDR disk space exceeds the high water mark, the system
generates the CDRHWMExceeded alert.

Low Water Mark (%) This field specifies the percentage of disk space that is allocated to CDR
and CMR files that is always available for use. For example, if you
choose 2000 megabytes from the Disk Allocation field and 40% from the
Low Water Mark (%) field, the low water mark equals 800 megabytes.

CDR / CMR Files Choose the number of days that you want to retain CDR and CMR files.
Preservation Duration The CDR Repository Manager deletes files that fall outside the
(Days) preservation window.

Note If you continuously receive the
CDRMaximumDiskSpaceExceeded alarm, you either must
increase the disk allocation or lower the number of preservation
days.

Cisco Unified Serviceability Administration Guide
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Table 13-1 CDR Repository Manager General Parameter Settings (continued)

Field Description

Disable CDR/CMR Files Note Regardless of whether you enable the deletion of files based on
Deletion Based on HWM the high-water mark parameter, if disk usage exceeds the disk

allocation that you configure, the maximum database size, or the
maximum number of records for your installation, the CDR
repository manager service deletes CDR and CMR files,
beginning with the oldest files, until disk utilization falls below
the high water mark.

If you do not want to delete CDRs and CMRs even if disk usage exceeds
the percentage that you specify in the High Water Mark (%) field, check
this check box. By default, this check box remains unchecked, so the
system deletes CDRs and CMRs if disk usage exceeds the high water
mark.

CDR Repository Manager |This field lists the host name of the CDR repository manager server.
Host Name

CDR Repository Manager |This field lists the IP address of the CDR repository manager server.
Host Address

Configuring Application Billing Servers

Step 1

Step 2

Step 3
Step 4

Use the following procedure to configure application billing servers to which you want to send CDRs.

You can configure up to three billing servers.

Procedure

Choose Tools > CDR Management Configuration.
The CDR Management Configuration window displays.
Perform one of the following tasks:
e To add a new application billing server, click the Add New button.
e To update an existing application billing server, click the server host name/IP address.
Enter the appropriate settings, as described in Table 13-2.
Click Add or Update.

Additional Information
See the “Related Topics” section on page 13-8.
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Application Billing Server Parameter Settings

Table 13-2 describes the available settings in the Billing Application Server Parameters section of the
CDR Management Configuration window. For related procedures, see the “Related Topics™ section on

page 13-8.
Table 13-2 Application Billing Server Parameter Settings
Field Description

Host Name/IP Address

Enter the host name or IP address of the application billing server to
which you want to send CDRs.

If you change the value in this field, a prompt asks whether you want to
send the undelivered files to the new destination.

Perform one of the following tasks:
e To deliver the files to the new server, click Yes.

e To change the server host name/IP address without sending
undelivered files, click No. The CDR Management service marks the
CDR and CMR files as successfully delivered.

User Name

Enter the user name of the application billing server.

Protocol

Choose the protocol, either FTP or SFTP, that you want to use to send the
CDR files to the configured billing servers.

Directory Path

Enter the directory path on the application billing server to which you
want to send the CDRs. You should end the path that you specify with a
“/” or “\”, depending on the operating system that is running on the
application billing server.

Note  Make sure the FTP user has write permission to the directory.

Resend on Failure

When you check the Resend on Failure box, this option informs CDRM
to send outdated CDR and CMR files to the billing server after the FTP
or SFTP connection is restored. When the box is checked, the Resend on
Failure flag is set to True. When the box is not checked, the Resend on
Failure flag is set to False.'

Generate New Key

Click on the Reset button to generate new keys and reset the connection
to the SFTP server.

1. There are several different scenarios that can occur. When the billing server Resend on Failure flag is set to True, all CDR
files get moved to the billing server. When the Resend On Failure flag is set to False, CDR files that get generated during
shutdown of the billing server get moved to the processed folder, but do not get moved to the billing server. When the Resend
on Failure flag gets set to True at the beginning, and then gets changed several times, the result is that the CDR files get moved
to the billing server whenever the Resend on Failure box gets checked.

Deleting Application Billing Servers

Use the following procedure to delete an application billing server.

Step 1 Choose Tools > CDR Management.

The CDR Management Configuration window displays.
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Step 2

Step 3

Check the check box next to the application billing server that you want to delete and click Delete
Selected.

A message displays that indicates that if you delete this server, any CDR or CMR files that have not been

sent to this server will not be delivered to this server and will be treated as successfully delivered files.

ye

Tip When you delete a server, the system does not generate the CDRFileDeliveryFailed alert for the
files that are not sent to that server.

To complete the deletion, click OK.

Additional Information
See the “Related Topics” section on page 13-8.

Where to Find More Information

Related Topics
e Configuring the CDR Repository Manager General Parameters, page 13-3

¢ CDR Repository Manager General Parameter Settings, page 13-4
e Configuring Application Billing Servers, page 13-6

e Application Billing Server Parameter Settings, page 13-7

e Deleting Application Billing Servers, page 13-7

Additional Cisco Documentation

e Cisco Unified Real-Time Monitoring Tool Administration Guide

e Cisco Unified Communications Manager CDR Analysis and Reporting Administration Guide
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Configuring the Audit Log

With audit logging, configuration changes to the Cisco Unified Communications Manager system gets
logged in separate log files for auditing. This chapter contains the following topics:

e Understanding Audit Logging, page 14-1

e Configuring the Audit Log, page 14-3

e Audit Log Configuration Settings, page 14-4
e Where to Find More Information, page 14-7

Understanding Audit Logging

With audit logging, configuration changes to the Cisco Unified Communications Manager system gets
logged in separate log files for auditing. The Cisco Audit Event Service, which displays under Control
Center—Network Services in Cisco Unified Serviceability, monitors and logs any configuration change
to the Cisco Unified Communications Manager system by a user or as a result of the user action. For a
Cisco Unified Communications Manager Business Edition system, this service supports both Cisco
Unified Communications Manager and Cisco Unity Connection.

You access the Audit Log Configuration window in Cisco Unified Serviceability to configure the settings
for the audit logs.

Audit logging contains the following parts:

e Audit logging framework—The framework comprises an API that uses an alarm library to write
audit events into audit logs. An alarm catalog that is defined as GenericAlarmCatalog.xml applies
for these alarms. Different Cisco Unified Communications Manager components provide their own

logging.
The following example displays an API that a Cisco Unified Communications Manager component
can use to send an alarm:

User ID: CCMAdministrator

Client IP Address: 172.19.240.207

Severity: 3

EventType: ServiceStatusUpdated

ResourceAccessed: CCMService

EventStatus: Successful

Description: CallManager Service status is stopped

e Audit event logging—An audit event represents any event that is required to be logged. The
following example displays a sample audit event:

Cisco Unified Serviceability Administration Guide
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CCM_TOMCAT-GENERIC-3-AuditEventGenerated: Audit Event Generated
UserID:CCMAdministrator Client IP Address:172.19.240.207 Severity:3
EventType:ServiceStatusUpdated ResourceAccessed: CCMService EventStatus:
Successful Description: Call Manager Service status is stopped App ID:Cisco Tomcat
Cluster ID:StandAloneCluster Node ID:sa-cml-3

)o

Tip Be aware that audit event logging is centralized and enabled by default. An alarm monitor called Syslog
Audit writes the logs. By default, the logs are configured to rotate. If the AuditLogAlarmMonitor cannot
write an audit event, the AuditLogAlarmMonitor logs this failure as a critical error in the syslog file. The
Alert Manager reports this error as part of a SeverityMatchFound alert. The actual operation continues
even if the event logging fails. All audit logs get collected, viewed and deleted from Trace and Log
Central in the Cisco Unified Real-Time Monitoring Tool.

The following Cisco Unified Communications Manager components generate audit events:
e Cisco Unified Serviceability, page 14-2
¢ Cisco Unified Real-Time Monitoring Tool, page 14-2
e Cisco Unified Communications Manager CDR Analysis and Reporting, page 14-3

¢ (Cisco Unified Communications Manager Administration, page 14-3

Cisco Unified Serviceability

Cisco Unified Serviceability logs the following events:
e Activation, deactivation, start, or stop of a service.
e Changes in trace configurations and alarm configurations.
e Changes in SNMP configurations.
¢ Changes in CDR management.

e Review of any report in the Serviceability Reports Archive. This log gets viewed on the reporter
node.

Cisco Unified Real-Time Monitoring Tool
Cisco Unified Real-Time Monitoring Tool logs the following events with an audit event alarm:

e Alert configuration.
e Alert suspension.

e E-mail configuration.
e Set node alert status.
e Alert addition.

e Add alert action.

e (lear alert.

e Enable alert.

e Remove alert action.

e Remove alert.
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Cisco Unified Communications Manager CDR Analysis and Reporting

Cisco Unified Communications Manager CDR Analysis and Reporting (CAR) creates audit logs for
these events:

e Loader scheduling.

¢ Daily, weekly, and monthly reports scheduling.

e Mail parameters configuration.

e Dial plan configuration.

e Gateway configuration.

e System preferences configuration.

e Autopurge configuration.

e Rating engine configurations for duration, time of day, and voice quality.
* QoS configurations.

e Automatic generation/alert of pregenerated reports configurations.

e Notification limits configuration.

Cisco Unified Communications Manager Administration

The following events get logged for various components of Cisco Unified Communications Manager
Administration:

e User logging (user logins and user logouts).

e User role membership updates (user added, user deleted, user role updated).
e Role updates (new roles added, deleted, or updated).

e Device updates (phones and gateways).

¢ Server configuration updates (changes to alarm or trace configurations, service parameters,
enterprise parameters, IP addresses, host names, Ethernet settings, and Cisco Unified
Communications Manager server additions or deletions).

Configuring the Audit Log
To configure the audit log, perform the following procedure:

Procedure

Step1  In Cisco Unified Serviceability, choose Tools > Audit Log Configuration.
The Audit Log Configuration window displays.

Step2  Configure the settings in Table 14-1.

Step3  Click Save.

Je

Tip At any time, you can click Set to Default to specify the default values. After you set the defaults,
click Save to save the default values.

Cisco Unified Serviceability Administration Guide
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Additional Information
See the “Related Topics” section on page 14-7.

Audit Log Configuration Settings

Table 14-1 describes the settings that you can configure in the Audit Log Configuration window in Cisco
Unified Serviceability. For more information on audit logging, see the “Where to Find More
Information” section on page 14-7.

Before You Begin

Be aware that only a user with an audit role can change the audit log settings. By default, the
CCMAdministrator possesses the audit role after fresh installs and upgrades. The CCM Administrator
can assign any user that has auditing privileges to the Standard Audit Users group in the User Group
Configuration window in Cisco Unified Communications Manager Administration. If you want to do so,
you can then remove CCMAdministrator from the Standard Audit Users group.

The Standard Audit Log Configuration role provides the ability to delete audit logs and to read/update
access to Cisco Unified Real-Time Monitoring Tool, Trace Collection Tool, RTMT Alert Configuration,
Control Center—Network Services in Cisco Unified Serviceability, RTMT Profile Saving, Audit
Configuration in Cisco Unified Serviceability, and a resource that is called Audit Traces.

For information on roles, users, and user groups, refer to the Cisco Unified Communications Manager
Administration Guide.

Table 14-1 Audit Log Configuration Settings

Field Description

Select Server

Server Choose the server where you want to configure audit logs; then, click Go.

Apply to All Nodes If you want to apply the audit log configuration to all nodes in the cluster,
check the Apply to all Nodes box.

Application Audit Log Settings

Enable Audit Log When you enable this check box, an audit log gets created for the application
audit log, which supports configuration updates for Cisco Unified
Communications Manager graphical user interfaces (GUIs), such as Cisco
Unified Communications Manager Administration, Cisco Unified
Real-Time Monitoring Tool, Cisco Unified Communications Manager CDR
Analysis and Reporting, and Cisco Unified Serviceability. This setting
displays as enabled by default.
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Table 14-1 Audit Log Configuration Settings (continued)

Field

Description

Enable Purging

The Log Partition Monitor (LPM) looks at the Enable Purging option to
determine whether it needs to purge audit logs. When you check this check
box, LPM purges all the audit log files in RTMT whenever the common
partition disk usage goes above the high water mark; however, you can
disable purging by unchecking the check box.

If purging is disabled, the number of audit logs continues to increase until
the disk is full. This action could cause a disruption of the system. A message
that describes the risk of disabling the purge displays when you uncheck the
Enable Purging check box. Be aware that this option is available for audit
logs in an active partition. If the audit logs reside in an inactive partition, the
audit logs get purged when the disk usage goes above the high water mark.

You can access the audit logs by choosing Trace and Log Central > Audit
Logs in RTMT.

Enable Log Rotation

The system reads this option to determine whether it needs to rotate the audit
log files or it needs to continue to create new files. The maximum number of
files cannot exceed 5000. When the Enable Rotation option is checked, the
system begins to overwrite the oldest audit log files after the maximum
number of files gets reached.

Tip When log rotation is disabled (unchecked), audit log ignores the
Maximum No. of Files setting.

Maximum No. of Files

Enter the maximum number of files that you want to include in the log. The
default setting specifies 250. The maximum number specifies 5000.

Maximum File Size

Enter the maximum file size for the audit log. The file size value must remain
between 1 MB and 10 MB. You must specify a number between 1 and 10.

Database Audit Log Filter

Settings

Enable Audit Log

When you enable this check box, an audit log gets created for the database.
Use this setting in conjunction with the Debug Audit Level setting, which
allows you create a log for certain aspects of the database.
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Table 14-1 Audit Log Configuration Settings (continued)

Field

Description

Debug Audit Level

This setting allows you to choose which aspects of the database you want to
audit in the log. From the drop-down list box, choose one of the following
options. Be aware that each audit log filter level is cumulative.

e Schema—Tracks changes to the setup of the audit log database (for
example, the columns and rows in the database tables).

¢ Administrative Tasks—Tracks all administrative changes to the Cisco
Unified Communications Manager system (for example, any changes to
maintain the system) plus all Schema changes.

Tip Most administrators will leave the Administrative Tasks setting
disabled. For users who want auditing, use the Database Updates
level.

e Database Updates—Tracks all changes to the database plus all schema
changes and all administrative tasks changes.

e Database Reads—Tracks every read to the Cisco Unified
Communications Manager system, plus all schema changes,
administrative tasks changes, and database updates changes.

Tip Choose the Database Reads level only when you want to get a quick
look at the Cisco Unified Communications Manager system. This
level uses significant amounts of system resources and only should
be used for a short time.

Enable Audit Log
Rotation

The system reads this option to determine whether it needs to rotate the
database audit log files or it needs to continue to create new files. When the
Audit Enable Rotation option is checked, the system begins to overwrite the
oldest audit log files after the maximum number of files gets reached.

When this setting is unchecked, audit log ignores the Maximum No. of Files
setting.

Maximum No. of Files

Enter the maximum number of files that you want to include in the log.
Ensure that the value that you enter for the Maximum No. of Files setting is
greater than the value that you enter for the No. of Files Deleted on Log
Rotation setting.

You can enter a number from 4 (minimum) to 40 (maximum).

No. of Files Deleted on
Log Rotation

Enter the maximum number of files that the system can delete when database
audit log rotation occurs.

The minimum that you can enter in this field is 1. The maximum value is 2
numbers less than the value that you enter for the Max No. of Files setting;
for example, if you enter 40 in the Maximum No. of Files field, the highest
number that you can enter in the No. of Files Deleted on Log Rotation field
is 38.
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Where to Find More Information

Related Topics

Understanding Audit Logging, page 14-1

Configuring the Audit Log, page 14-3

Audit Log Configuration Settings, page 14-4
Configuring Trace, page 7-1

Configuring Troubleshooting Trace Settings, page 8-1

Network Services, page 9-9

Additional Cisco Documentation

Cisco Unified Real-Time Monitoring Tool Administration Guide
Cisco Unified Communications Manager CDR Analysis and Reporting Administration Guide

Cisco Unified Communications Manager Administration Guide
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This chapter provides information on the following topics:

e Simple Network Management Protocol Support, page 15-1
e SNMP Basics, page 15-2

e SNMP Configuration Requirements, page 15-3

e SNMP Version 1 Support, page 15-3

e SNMP Version 2c Support, page 15-4

e SNMP Version 3 Support, page 15-4

e SNMP Services, page 15-4

e SNMP Community Strings and Users, page 15-5

e SNMP Traps and Informs, page 15-5

e SNMP Management Information Base (MIB), page 15-8
e SNMP Trace Configuration, page 15-15

e SNMP Configuration Checklist, page 15-15

Simple Network Management Protocol Support

SNMP, an application layer protocol, facilitates the exchange of management information among
network devices, such as nodes, routers, and so on. As part of the TCP/IP protocol suite, SNMP enables
administrators to remotely manage network performance, find and solve network problems, and plan for
network growth.

Cisco allows you to use any SFTP server product but recommends SFTP products that have been
certified with Cisco through the Cisco Technology Developer Partner program (CTDP). CTDP partners,
such as GlobalSCAPE, certify their products with specified version of Cisco Unified Communications
Manager. For information on which vendors have certified their products with your version of Cisco
Unified Communications Manager, refer to the following URL:

http://www.cisco.com/pcgi-bin/ctdp/Search.pl

For information on using GlobalSCAPE with supported Cisco Unified Communications versions, refer
to the following URL:

http://www.globalscape.com/gsftps/cisco.aspx

Cisco Unified Serviceability Administration Guide
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SNMP Basics

Cisco uses the following servers for internal testing. You may use one of the servers, but you must
contact the vendor for support:

e Open SSH (refer to http://sshwindows.sourceforge.net/)
e Cygwin (refer to http://www.cygwin.com/)

e Titan (refer to http://www.titanftp.com/)

For issues with third-party products that have not been certified through the CTDP process, contact the
third-party vendor for support.

You use Cisco Unified Serviceability to configure SNMP-associated settings, such as community
strings, users, and notification destinations for V1, V2c, and V3. The settings that you configure in Cisco
Unified Serviceability apply to the local node; however, if your Cisco Unified Communications Manager
or Cisco Unity Connection configuration supports clusters, you can apply settings to all servers in the
cluster with the “Apply to All Nodes” option in the SNMP configuration windows.

Unified CM only: SNMP configuration parameters that you specified in Cisco Unified CallManager or
Cisco Unified Communications Manager 4.X do not migrate during a Cisco Unified Communications

Manager 6.0 and later upgrade. You must perform the SNMP configuration procedures again in Cisco
Unified Serviceability.

SNMP supports [Pv4, although the CISCO-CCM-MIB includes columns and storage for IPv6 addresses,
preferences, and so on.

This section contains information on the following topics:
e SNMP Basics, page 15-2
e SNMP Configuration Requirements, page 15-3
e SNMP Version 1 Support, page 15-3
e SNMP Version 2c Support, page 15-4
e SNMP Version 3 Support, page 15-4
e SNMP Services, page 15-4
e SNMP Community Strings and Users, page 15-5
e SNMP Trace Configuration, page 15-15
e SNMP Management Information Base (MIB), page 15-8

An SNMP-managed network comprises three key components: managed devices, agents, and network
management systems.

e Managed device—A network node that contains an SNMP agent and resides on a managed network.
Managed devices collect and store management information and make it available by using SNMP.

Unified CM BE only: The server where Cisco Unified Communications Manager is installed acts as
the managed device.

Unified CM only: In a configuration that supports clusters, the first node in the cluster acts as the
managed device.

Cisco Unified Serviceability Administration Guide
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Agent—A network-managed software module that resides on a managed device. An agent contains
local knowledge of management information and translates it into a form that is compatible with
SNMP.

Cisco Unified Communications Manager and Cisco Unity Connection use a master agent and
subagent components to support SNMP. The master agent acts as the agent protocol engine and
performs the authentication, authorization, access control, and privacy functions that relate to
SNMP requests. Likewise, the master agent contains a few MIB variables that relate to MIB-II. The
master agent also connects and disconnects subagents after the subagent completes necessary tasks.
The SNMP master agent listens on port 161 and forwards SNMP packets for Vendor MIBs.

The Cisco Unified Communications Manager subagent interacts with the local Cisco Unified
Communications Manager only. The Cisco Unified Communications Manager subagents send trap
and information messages to the SNMP Master Agent, and the SNMP Master Agent communicates
with the SNMP trap receiver (notification destination).

Network Management System (NMS)—A SNMP management application (together with the PC on
which it runs) that provides the bulk of the processing and memory resources that are required for
network management. An NMS executes applications that monitor and control managed devices.
Cisco Unified Communications Manager works with the following NMS:

— CiscoWorks Lan Management Solution

— HP OpenView

— Third-party applications that support SNMP and Cisco Unified Communications Manager
SNMP interfaces

SNMP Configuration Requirements

The system provides no default SNMP configuration. You must configure SNMP settings after
installation to access MIB information. Cisco supports SNMP V1, V2¢, and V3 versions.

SNMP agent provides security with community names and authentication traps. You must configure a
community name to access MIB information. Table 15-1 provides the required SNMP configuration

settings.

Table 15-1 SNMP Configuration Requirements

Configuration Cisco Unified Serviceability Page

V1/V2c¢c Community String SNMP > V1/V2¢ >Community String

V3 Community String SNMP > V3 > User

System Contact and Location for MIB2 SNMP > SystemGroup > MIB2 System Group
Trap Destinations (V1/V2c) SNMP > V1/V2c > Notification Destination
Trap Destinations (V3) SNMP > V3 > Notification Destination

SNMP Version 1 Support

SNMP version 1 (SNMPv1), the initial implementation of SNMP that functions within the specifications
of the Structure of Management Information (SMI), operates over protocols, such as User Datagram
Protocol (UDP) and Internet Protocol (IP).
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The SNMPv1 SMI defines highly structured tables (MIBs) that are used to group the instances of a
tabular object (that is, an object that contains multiple variables). Tables contain zero or more rows,
which are indexed, so SNMP can retrieve or alter an entire row with a supported command.

With SNMPv1, the NMS issues a request, and managed devices return responses. Agents use the Trap
operation to asynchronously inform the NMS of a significant event.

In Cisco Unified Serviceability, you configure SNMP v1 support in the V1/V2c Configuration window.

SNMP Version 2¢ Support

As with SNMPv1, SNMPv2c functions within the specifications of the Structure of Management
Information (SMI). MIB modules contain definitions of interrelated managed objects. The operations
that are used in SNMPv1 are similar to those that are used in SNMPv2. The SNMPv2 Trap operation,
for example, serves the same function as that used in SNMPv1, but it uses a different message format
and replaces the SNMPv1 Trap.

The Inform operation in SNMPv2c allows one NMS to send trap information to another NMS and to then
receive a response from the NMS.

In Cisco Unified Serviceability, you configure SNMP v2c support in the V1/V2c Configuration window.

SNMP Version 3 Support

SNMP version 3 provides security features such as authentication (verifying that the request comes from
a genuine source), privacy (encryption of data), authorization (verifying that the user allows the
requested operation), and access control (verifying that the user has access to the objects requested.) To

prevent SNMP packets from being exposed on the network, you can configure encryption with SNMPv3.

Instead of using community strings like SNMP v1 and v2, SNMP v3 uses SNMP users, as described in
the “SNMP Community Strings and Users” section on page 15-5.

In Cisco Unified Serviceability, you configure SNMP v3 support in the V3 Configuration window.

SNMP Services

The services in Table 15-2 support SNMP operations. For a description of each service, see the
“Understanding Services” section on page 9-1.

SNMP Master Agent serves as the primary service for the MIB interface. You must manually activate
Cisco CallManager SNMP service; all other SNMP services should be running after installation.

Cisco Unified Serviceability Administration Guide
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Table 15-2 SNMP Services

Cisco Unified Serviceability
MIB Service Window

CISCO-CCM-MIB Cisco CallManager SNMP service |Tool > Control Center - Feature
Services. Choose a server; then,
choose Performance and
Monitoring category.

SNMP Agent SNMP Master Agent Tool > Control Center -

CISCO-CDP-MIB Cisco CDP Agent Network Services. Choose a
server; then, choose Platform

SYSAPPL-MIB System Application Agent Services category.

MIB-II MIB2 Agent

HOST-RESOURCES-MIB |Host Resources Agent

CISCO-SYSLOG-MIB Cisco Syslog Agent

Hardware MIBs Native Agent Adaptor

A

Caution  Stopping any SNMP service may result in loss of data because the network management system no
longer monitors the Cisco Unified Communications Manager network. Do not stop the services unless
your technical support team tells you to do so.

SNMP Community Strings and Users

Although SNMP community strings provide no security, they authenticate access to MIB objects and
function as embedded passwords. You configure SNMP community strings for SNMP V1 and V2c only.

SNMP V3 does not use community strings. Instead, version 3 uses SNMP users. These users serve the
same purpose as community strings, but users provide security because you can configure encryption or
authentication for them.

In Cisco Unified Serviceability, no default community string or user exists.

SNMP Traps and Informs

An SNMP agent sends notifications to NMS in the form of traps or informs to identify important system
events. Traps do not receive acknowledgments from the destination whereas informs do receive
acknowledgments. You configure the notification destinations by using the SNMP Notification
Destination Configuration windows in Cisco Unified Serviceability.

Note  Cisco Unified Communications Manager supports SNMP traps in Cisco Unified Communications
Manager and Cisco Unified Communications Manager Business Edition systems. Cisco Unity
Connection SNMP does not support traps.

Cisco Unified Serviceability Administration Guide
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Note

For all notifications, the system sends traps immediately if the corresponding trap flags are enabled. In
the case of the syslog agent, the CallManager alarms and system level log messages get sent to syslog
daemon for logging. Also, some standard third-party applications send the log messages to syslog
daemon for logging. These log messages get logged locally in the syslog files and also get converted into
SNMP traps/notifications.

The following list contains Cisco Unified Communications Manager SNMP trap/inform messages that
are sent to a configured trap destination:

¢ (Cisco Unified Communications Manager failed
e Phone failed

e Phones status update

e Gateway failed

e Media resource list exhausted

¢ Route list exhausted

e Gateway layer 2 change

e Quality report

e Malicious call

¢ Syslog message generated

Before you configure notification destination, verify that the required SNMP services are activated and
running. Also, make sure that you configured the privileges for the community string/user correctly.

You configure the SNMP trap destination by choosing SNMP > V1/V2 > Notification Destination or
SNMP > V3> Notification Destination in Cisco Unified Serviceability.

Table 15-3 comprises information about Cisco Unified Communications Manager trap/inform
parameters that you configure on the Network Management System (NMS). You can configure the
values in Table 15-3 by issuing the appropriate commands on the NMS, as described in the SNMP
product documentation that supports the NMS.

All the parameters that are listed in Table 15-3 are part of CISCO-CCM-MIB except for the last two
parameters. The last two, clogNotificationsEnabled and clogMaxSeverity, comprise part of
CISCO-SYSLOG-MIB.
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Table 15-3 Cisco Unified Communications Manager Trap/Inform Configuration Parameters
Default Configuration
Parameter Name Value Generated Traps Recommendations
ccmCallManagerAlarmEnable True ccmCallManagerFailed Keep the default
specification.

ccmMediaResourceListExhausted
ccmRouteListExhausted

ccmTLSConnectionFailure

ccmGatewayAlarmEnable True ccmGatewayFailed None. The default specifies

ccmGatewayLayer2Change this trap as enabled.

Note  Although you can
configure a Cisco ATA
186 device as a phone in
Cisco Unified
Communications Manager
Administration, when
Cisco Unified
Communications Manager
sends SNMP traps for the
Cisco ATA device, it
sends a gateway type trap;
for example,
ccmGatewayFailed.

ccmPhoneStatusUpdateStorePeriod 1800 ccmPhoneStatusUpdate Set the
ccmPhoneStatusUpdateAla
rmlinterval to a value
between 30 and 3600. See
Configuring
CISCO-CCM-MIB Trap
Parameters, page 19-2.

ccmPhoneFailedStorePeriod 1800 ccmPhoneFailed Set the
ccmPhoneFailedAlarmInte

ccmPhoneStatusUpdate AlarmInterval 0

ccmPhoneFailedAlarmInterval 0
rval to a value between 30
and 3600. See Configuring
CISCO-CCM-MIB Trap
Parameters, page 19-2.
ccmMaliciousCallAlarmEnable True ccmMaliciousCall None. The default specifies

this trap as enabled.

Cisco Unified Serviceability Administration Guide
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Table 15-3 Cisco Unified Communications Manager Trap/Inform Configuration Parameters (continued)

Default Configuration
Parameter Name Value Generated Traps Recommendations
ccmQualityReportAlarmEnable True Note  This trap gets generated None. The default specifies

only if the Cisco Extended |this trap as enabled.
Functions service is
activated and running on
the server; or, in the case
of a cluster configuration
(Cisco Unified
Communications Manager
only), on the local Cisco
Unified Communications
Manager server.

ccmQualityReport

clogNotificationsEnabled False clogMessageGenerated To enable trap generation,
set
clogNotificationsEnable to
True. See Configuring
CISCO-SYSLOG-MIB
Trap Parameters,

page 19-1.

clogMaxSeverity Warning [clogMessageGenerated When you set
clogMaxSeverity to
warning, a SNMP trap
generates when Cisco
Unified Communications
Manager applications
generate a syslog message
with at least a warning
severity level.Configuring
CISCO-SYSLOG-MIB
Trap Parameters,

page 19-1.

SNMP Management Information Base (MIB)

SNMP allows access to Management Information Base (MIB), which is a collection of information that
is organized hierarchically. MIBs comprise managed objects, which are identified by object identifiers.
A MIB object, which contains specific characteristics of a managed device, comprises one or more
object instances (variables).

Note  Cisco Unified Communications Manager supports the following MIBs in Cisco Unified
Communications Manager and Cisco Unified Communications Manager Business Edition systems.
Cisco Unity Connection supports the following MIBs except for CISCO-CCM-MIB.
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The SNMP interface provides these Cisco Standard MIBs:
e CISCO-CCM-MIB
e CISCO-CDP-MIB
e CISCO-SYSLOG-MIB

The Simple Network Management Protocol (SNMP) extension agent resides in the server and exposes
the CISCO-CCM-MIB, which provides detailed information about devices that are known to the server.
In the case of a cluster configuration, the SNMP extension agent resides in each server in the cluster.
The CISCO-CCM-MIB provides device information such as device registration status, IP address,
description, and model type for the server (not the cluster, in a configuration that supports clusters).

The SNMP interface also provides these Industry Standard MIBs:
e SYSAPPL-MIB
e MIB-II (RFC 1213)
e HOST-RESOURCES-MIB
For vendor-specific supported hardware MIBS, refer to the “Vendor-Specific MIBs” section.

Cisco Unified Communications Manager SNMP Interface supports the following MIBs.

CISCO-CDP-MIB

Use the Cisco Unified Communications Manager CDP subagent to read the Cisco Discovery Protocol
MIB, CISCO-CDP-MIB. This MIB enables Cisco Unified Communications Manager to advertise itself
to other Cisco devices on the network.

The CDP subagent implements the CDP-MIB. The CDP-MIB contains the following objects:
e cdplnterfacelfIndex
e cdplnterfaceMessagelnterval
¢ cdplnterfaceEnable
e cdplnterfaceGroup
e cdplnterfacePort
e cdpGlobalRun
e cdpGlobalMessagelnterval
e cdpGlobalHoldTime
¢ cdpGlobalLastChange
e cdpGobalDeviceld
e cdpGlobalDeviceldFormat
e cdpGlobalDeviceldFormatCpd

SYSAPPL-MIB

Use the System Application Agent to get information from the SYSAPPL-MIB, such as installed
applications, application components, and processes that are running on the system.

System Application Agent supports the following object groups of SYSAPPL-MIB:
¢ sysAppllnstallPkg
e sysApplRun
e sysApplMap
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e sysAppllnstallEImt
e sysApplElmtRun

Use MIB2 agent to get information from MIB-II. The MIB2 agent provides access to variables that are
defined in RFC 1213, such as interfaces, IP, and so on, and supports the following groups of objects:

* system

¢ interfaces
e at

e ip

e icmp

* ftcp

e udp

e snmp

HOST-RESOURCES MIB

Use Host Resources Agent to get values from HOST-RESOURCES-MIB. The Host Resources Agent
provides SNMP access to host information, such as storage resources, process tables, device
information, and installed software base. The Host Resources Agent supports the following groups of
objects:

e hrSystem

e hrStorage

e hrDevice

e hrSWRun

e hrSWRunPerf
¢ hrSWinstalled

CISCO-SYSLOG-MIB

Syslog tracks and logs all system messages, from informational through critical. With this MIB, network
management applications can receive syslog messages as SNMP traps:

The Cisco Syslog Agent supports trap functionality with the following MIB objects:
¢ clogNotificationsSent
¢ clogNotificationsEnabled
e clogMaxSeverity
e clogMsglgnores
e clogMsgDrops

CISCO-CCM-MIB/CISCO-CCM-CAPABILITY MIB

The CISCO-CCM-MIB contains both dynamic (real-time) and configured (static) information about the
Cisco Unified Communications Manager and its associated devices, such as phones, gateways, and so

on, that are visible on this Cisco Unified Communications Manager node. Simple Network Management
Protocol (SNMP) tables contain information such as IP address, registration status, and model type.
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SNMP supports IPv4, although the CISCO-CCM-MIB includes columns and storage for IPv6 addresses,
preferences, and so on.

Note  Cisco Unified Communications Manager supports this MIB in Cisco Unified Communications Manager
and Cisco Unified Communications Manager Business Edition systems. Cisco Unity Connection does
not support this MIB.

To view the support lists for the CISCO-CCM-MIB and MIB definitions, go to the following link:
ftp://ftp.cisco.com/pub/mibs/supportlists/callmanager/callmanager-supportlist.html

To view MIB dependencies and MIB contents, including obsolete objects, across Cisco Unified
Communications Manager releases, go to the following link:
http://tools.cisco.com/Support/SNMP/do/BrowseMIB.do?local=en&step=2&mibName=CISCO-CCM-
CAPABILITY

Dynamic tables (see Table 15-4) get populated only if the Cisco CallManager service is up and running
(or the local Cisco CallManager service in the case of a Cisco Unified Communications Manager cluster
configuration); static tables (see Table 15-5) get populated when the Cisco CallManager SNMP Service
is running.

Table 15-4 Cisco-CCM-MIB Dynamic Tables

Table(s) Contents

ccmTable This table stores the version and installation ID for the local Cisco
Unified Communications Manager. The table also stores information
about all the Cisco Unified Communications Manager in a cluster that
the local Cisco Unified Communications Manager knows about but
shows “unknown” for the version detail. If the local Cisco Unified
Communications Manager is down, the table remains empty, except for
the version and installation ID values.

ccmPhoneFailed, For the Cisco Unified IP Phone, the number of registered phones in
ccmPhoneStatusUpdate, ccmPhoneTable should match Cisco Unified Communications
ccmPhoneExtn, ccmPhone, |Manager/RegisteredHardware Phones perfmon counter. The
ccmPhoneExtension ccmPhoneTable includes one entry for each registered, unregistered, or

rejected Cisco Unified IP Phone. The ccmPhoneExtnTable uses a
combined index, ccmPhonelndex and ccmPhoneExtnIndex, for relating
the entries in the ccmPhoneTable and ccmPhoneExtnTable.

ccmCTIDevice, The ccmCTIDeviceTable stores each CTI device as one device. Based
ccmCTIDeviceDirNum on the registration status of the CTI Route Point or CTI Port, the
ccmRegisteredCTIDevices, ccmUnregisteredCTIDevices, and
ccmRejectedCTIDevices counters in the Cisco Unified
Communications Manager MIB get updated.

ccmSIPDevice The CCMSIPDeviceTable stores each SIP trunk as one device.

Cisco Unified Serviceability Administration Guide
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Table 15-4 Cisco-CCM-MIB Dynamic Tables (continued)
Table(s) Contents
ccmH323Device The ccmH323DeviceTable contains the list of H323 devices for which

Cisco Unified Communications Manager contains information (or the
local Cisco Unified Communications Manager in the case of a cluster
configuration). For H.323 phones or H.323 gateways, the
ccmH.323DeviceTable contains one entry for each H.323 device. (The
H.323 phone and gateway do not register with Cisco Unified
Communications Manager. Cisco Unified Communications Manager
generates the H.323Started alarm when it is ready to handle calls for the
indicated H.323 phone and gateway.) The system provides the
gatekeeper information as part of the H323 trunk information.

ccmVoiceMailDevice,
ccmVoiceMailDirNum

For Cisco uOne, ActiveVoice, the ccmVoiceMailDeviceTable includes
one entry for each voice-messaging device. Based on the registration
status, the ccmRegisteredVoiceMailDevices,
ccmUnregisteredVoiceMailDevices, and
ccmRejectedVoiceMailDevices counters in the Cisco Unified
Communications Manager MIB get updated.

ccmGateway

The ccmRegisteredGateways, ccmUnregistered gateways, and
ccmRejectedGateways keep track of the number of registered gateway
devices or ports, number of unregistered gateway devices or ports, and
number of rejected gateway devices or ports, respectively.

Cisco Unified Communications Manager generates alarms at the device
or port level. The ccmGatewayTable, based on CallManager alarms,
contains device- or port-level information. Each registered,
unregistered, or rejected device or port has one entry in
ccmGatewayTable. The VG200 with two FXS ports and one T1 port has
three entries in ccmGatewayTable. The ccmActiveGateway and
ccmInActiveGateway counters track number of active (registered) and
lost contact with (unregistered or rejected) gateway devices or ports.

Based on the registration status, ccmRegisteredGateways,
ccmUnregisteredGateways, and ccmRejectedGateways counters get
updated.

ccmMediaDevicelnfo

The table contains a list of all media devices which have tried to register
with the local CallManager at least once.

ccmGroup

This tables contains the Cisco Unified CM groups in a Cisco Unified
Communications Manager cluster.

ccmGroupMapping

This table maps all Cisco Unified CMs in a cluster to a Cisco Unified
CM group. The table remains empty when the local Cisco Unified CM
node is down
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Note

Simple Network Management Protocol Support

Table 15-5 CISCO-CCM-MIB Static Tables

Table(s) Content

ccmProductType The table contains the list of product types that are
supported with Cisco Unified Communications
Manager (or cluster, in the case of a Cisco Unified
Communications Manager cluster configuration),
including phone types, gateway types, media
device types, H323 device types, CTI device
types, voice-messaging device types, and SIP
device types.

ccmRegion, ccmRegionPair ccmRegionTable contains the list of all
geographically separated regions in a Cisco
Communications Network (CCN) system. The
ccmRegionPairTable contains the list of
geographical region pairs for a Cisco Unified
Communications Manager cluster. Geographical
region pairs are defined by Source region and
Destination region.

ccmTimeZone The table contains the list of all time zone groups
in a Cisco Unified Communications Manager
cluster.

ccmDevicePool The tables contains the list of all device pools in a

Cisco Unified Communications Manager cluster.
Device pools are defined by Region, Date/Time
Group, and Cisco Unified CM Group.

“The “ccmAlarmConfigInfo” and “ccmQualityReportAlarmConfigInfo” groups in the
CISCO-CCM-MIB define the configuration parameters that relate to the notifications that the “SNMP
Management Information Base (MIB)” section on page 15-8 describes.

Vendor-Specific MIBs

The following MIBs exist on various Cisco MCS, depending on vendor and model number. To query
these MIBS, you can use the standard MIB browsers that the hardware vendors develop; for example,
HP Systems Insight Manager (SIM) and IBM Director Server+Console. For information on using the
MIB browsers, refer to the documentation that the hardware vendor provides.

To review the vendor-specific MIB information, see the following tables:
e Table 15-6—Describes supported IBM MIBs
e Table 15-7—Describes supported HP MIBs
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Cisco Unified Serviceability Administration Guide g



Chapter15  Understanding Simple Network Management Protocol |

Simple Network Management Protocol Support

Table 15-6 IBM MIBs

0ID

Description

Supported for browsing only

IBM-SYSTEM-HEALTH-MIB

1.3.6.1.4.1.2.6.159.1.1.30

Provides temperature, voltage,
and fan status

IBM-SYSTEM-ASSETID-MIB

1.3.6.1.4.1.2.6.159.1.1.60

Provides hardware component
asset data

IBM-SYSTEM-LMSENSOR-MIB

1.3.6.1.4.1.2.6.159.1.1.80

Provides temperature, voltage,
and fan details

IBM-SYSTEM-NETWORK-MIB

1.3.6.1.4.1.2.6.159.1.1.110

Provides Network Interface Card
(NIC) status

IBM-SYSTEM-MEMORY-MIB

1.3.6.1.4.1.2.6.159.1.1.120

Provides physical memory details

IBM-SYSTEM-POWER-MIB

1.3.6.1.4.1.2.6.159.1.1.130

Provides power supply details

IBM-SYSTEM-PROCESSOR-MIB

1.3.6.1.4.1.2.6.159.1.1.140

Provides CPU asset/status data

Supported for system traps

IBM-SYSTEM-TRAP

1.3.6.1.4.1.2.6.159.1.1.0

Provides temperature, voltage,
fan, disk, NIC, memory, power
supply, and CPU details

IBM-SYSTEM-RAID-MIB

1.3.6.1.4.1.2.6.167.2

Provides RAID status

Table 15-7 HP MIBs

oD

Description

Supported for browsing and system traps

CPQSTDEQ-MIB

1.3.6.1.4.1.232.1

Provides hardware component
configuration data

CPQSINFO-MIB

1.3.6.1.4.1.232.2

Provides hardware component
asset data

CPQIDA-MIB

1.3.6.1.4.1.232.3

Provides RAID status/events

CPQHLTH-MIB

1.3.6.1.4.1.232.6

Provides hardware components
status/events

CPQSTSYS-MIB

1.3.6.1.4.1.232.8

Provides storage (disk) systems
status/events

CPQSM2-MIB

1.3.6.1.4.1.232.9

Provides iLO status/events

CPQTHRSH-MIB

1.3.6.1.4.1.232.10

Provides alarm threshold
management

CPQHOST-MIB

1.3.6.1.4.1.232.11

Provides operating system
information

CPQIDE-MIB 1.3.6.1.4.1.232.14 Provides IDE (CD-ROM) drive
status/events
CPQNIC-MIB 1.3.6.1.4.1.232.18 Provides Network Interface Card

(NIC) status/events
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SNMP Trace Configuration

For Cisco Unified Communications Manager, you can configure trace for the Cisco CallManager SNMP
agent in the Trace Configuration window in Cisco Unified Serviceability by choosing the Cisco
CallManager SNMP Service in the Performance and Monitoring Services service group. A default
setting exists for all the agents. For Cisco CDP Agent and Cisco Syslog Agent, you use the CLI to change
trace settings, as described in the Command Line Interface Reference Guide for Cisco Unified Solutions.

SNMP Trace Configuration

For Cisco Unity Connection, you can configure trace for the Connection SNMP agent in the Trace
Configuration window in Cisco Unity Connection Serviceability by choosing the Connection SNMP

Agent component.

SNMP Configuration Checklist

Table 15-8 provides an overview of the steps for configuring SNMP.

Table 15-8

SNMP Configuration Checklist

Configuration Steps

Related Procedures and Topics

Step 1 Install and configure the SNMP NMS. SNMP product documentation that supports the NMS
Step 2 In the Control Center—Network Services window, e SNMP Services, page 15-4
verify that the system started the SNMP services. e Understanding Services, page 9-1
e Configuring Services, page 11-1
Step 3 Unified CM and Unified CM BE only: In the Service e SNMP Services, page 15-4
Activation window, activate the Cisco CallManager . .
. e Understanding Services, page 9-1
SNMP service.
e Activating and Deactivating Feature Services,
Connection only: The Connection SNMP Agent service page 1 l-lg 5
automatically activates.
Step 4 If you are using SNMP V1/V2c, configure the Configuring a Community String, page 16-2
community string.
Step 5 If you are using SNMP V3, configure the SNMP user. |Configuring the SNMP User, page 17-2
Step 6 Configure the notification destination for traps or e For SNMP v1/v2c—Configuring a Notification
informs. Destination for SNMP V1/V2c, page 16-6
e For SNMP v3—Configuring a Notification
Destination for SNMP V3, page 17-6
e SNMP Management Information Base (MIB),
page 15-8
Step 7 Configure the system contact and location for the MIB2 |Configuring the MIB2 System Group, page 18-1
system group.
Step 8 Unified CM and Unified BE only: Configure trap ¢ Configuring CISCO-SYSLOG-MIB Trap
settings for CISCO-SYSLOG-MIB and Parameters, page 19-1
CISCO-CCM-MIB. ¢ Configuring CISCO-CCM-MIB Trap Parameters,
page 19-2
Cisco Unified Serviceability Administration Guide
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[ | Where to Find More Information

Table 15-8 SNMP Configuration Checklist (continued)
Configuration Steps Related Procedures and Topics
Step 9 Restart the Master Agent service. e SNMP Services, page 15-4
e Understanding Services, page 9-1
e Understanding Services, page 9-1
Step 10 On the NMS, configure the Cisco Unified e SNMP Management Information Base (MIB),
Communications Manager trap parameters. page 15-8
e SNMP product documentation that supports the
NMS

Where to Find More Information

Related Topics

e Understanding Services, page 9-1

e Configuring Services, page 11-1

e Configuring SNMP V1/V2c, page 16-1

e Configuring SNMP V3, page 17-1

e Configuring SNMP System Group, page 18-1

e Configuring SNMP Trap/Inform Parameters, page 19-1

e Cisco Unified Communications Manager Troubleshooting Guide (for SNMP troubleshooting
information)

Cisco Unified Serviceability Administration Guide
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This chapter, which describes how to configure SNMP versions 1 and 2c, so the network management
system can monitor Cisco Unified Communications Manager, contains the following topics:

¢ Finding a Community String, page 16-1

e Configuring a Community String, page 16-2

e Community String Configuration Settings, page 16-3

e Deleting a Community String, page 16-4

¢ SNMP Notification Destination, page 16-5

e Finding a Notification Destination for SNMP V1/V2c, page 16-5

¢ Configuring a Notification Destination for SNMP V1/V2c, page 16-6

e Notification Destination Configuration Settings for SNMP V1/V2c, page 16-7
e Deleting a Notification Destination for SNMP V1/V2c, page 16-7

e Where to Find More Information, page 16-8

If you use SNMP version 3, see the “Configuring SNMP V3” section on page 17-1.

Finding a Community String

pe

Tip

Step 1

Step 2

The Add New button does not display in the SNMP Community String Configuration window until you
click the Find button. If no community strings exist and you want to add a community string, click the
Find button and wait for the window to refresh. The Add New button displays.

To find a community string, perform the following procedure:

Procedure

Choose Snmp > V1/V2¢ > Community String.
The Find/List window displays.

From the Find Community Strings where Name drop-down list box, choose the specific search criteria
that you want to use for the community string.
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| Configuring a Community String

Step 3
Step 4
Step 5

Step 6

Step 7
Step 8

Enter the community string for which you want to search.
In the Server field, enter the hostname or IP address of the server where the community string exists.
Click Find.

After you click the Find button, the Add New button displays. After the search results display, the Apply
to All Nodes check box displays.

Unified CM clusters only: If you want to apply the configuration from one of the options in the search
results to all nodes in the cluster, check the check box next to the name of the option and check the Apply
to All Nodes check box.

From the list of results, click the community string that you want to view.

To add or update a community string, see the “Configuring a Community String” section on page 16-2.

Additional Information
See the “Where to Find More Information” section on page 16-8.

Configuring a Community String

Step 1
Step 2

Step 3

Step 4

Step 5

Because the SNMP agent provides security by using community strings, you must configure the
community string to access any management information base (MIB) in a Cisco Unified
Communications Manager system. Change the community string to limit access to the Cisco Unified
Communications Manager system. To add, modify, and delete community strings, access the SNMP
Community String configuration window.

Procedure

Perform the procedure in the “Finding a Community String” section on page 16-1.
Perform one of the following tasks:
¢ To add a new community string, click the Add New button and go to Step 3.

e To modify an existing community string, locate the community string, as described in the “Finding
a Community String” section on page 16-1; click the name of the community string that you want
to edit and go to Step 3.

You cannot change the name of the community string or the server.
e To delete a community string, see the “Deleting a Community String” section on page 16-4.

Enter the configuration settings, as described in Table 16-1.

pe

Tip Before you save the configuration, you can click the Clear All button at any time to delete all
information that you entered for all settings in the window.

After you complete the configuration, click Add New to save a new community string or click Save to
save changes to an existing community string.

A message indicates that changes will not take effect until you restart the SNMP master agent. To
continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP
master agent service, click OK.

Cisco Unified Serviceability Administration Guide
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Community String Configuration Settings

)

Note  Cisco recommends that you wait until you finish all the SNMP configuration before you restart
the SNMP master agent service. For information on how to restart the service, see the
“Configuring Services” section on page 11-1.

The system refreshes and displays the SNMP Community String Configuration window. The community
string that you created displays in the window.

Additional Information

See the “Where to Find More Information” section on page 16-8.

Community String Configuration Settings

Table 16-1 describes the community string configuration settings. For related procedures, see the
“Where to Find More Information” section on page 16-8.

Table 16-1 Community String Configuration Settings
Field Description
Server This setting in the Community String configuration window displays as

read only because you specified the server choice when you performed
the procedure in the “Finding a Community String” section on
page 16-1.

To change the server for the community string, perform the procedure
in the “Finding a Community String” section on page 16-1.

Community String Enter a name for the community string. The name can contain up to 32
characters and can contain any combination of alphanumeric characters,
hyphens (-), and underscore characters (_).

Tip Choose community string names that will be hard for outsiders

to figure out.

When you edit a community string, you cannot change the name of the
community string.

Accept SNMP Packets from |To accept SNMP packets from any host, click this radio button.
any host

Accept SNMP Packets only |To accept SNMP only from specified hosts, click this radio button.

from these hosts Tip In the Host IP Address field, enter a host from which you want

to accept packets and click Insert. Repeat this process for each
host from which you want to accept packets. To delete a host,
choose that host from the Host IP Addresses list box and click
Remove.

[ oL-18619-01
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| Deleting a Community String

Table 16-1 Community String Configuration Settings (continued)
Field Description
Access Privileges From the drop-down list box, choose the appropriate access level from

the following list:

e ReadOnly—The community string can only read the values of MIB
objects.

e ReadWrite—The community string can read and write the values
of MIB objects.

e ReadWriteNotify—The community string can read and write the
values of MIB objects and send MIB object values for a trap and
inform messages.

¢ NotifyOnly—The community string can only send MIB object
values for a trap and inform messages.

¢ ReadNotifyOnly—The community string can read values of MIB
objects and also send the values for trap and inform messages.

e None—The community string cannot read, write, or send trap
information.

Tip To change the trap configuration parameters, you need to
configure a community string with NotifyOnly,
ReadNotifyOnly, or ReadWriteNotify privileges.

Unified CM clusters only: To apply the community string to all nodes in the cluster, check this
Apply To All Nodes check box.

Deleting a Community String

To delete a community string, perform the following procedure:

Procedure

Step1  Locate the community string, as described in the “Finding a Community String” section on page 16-1.

Step2  From the list of matching records, check the check box next to the community string that you want to
delete.

Step3  Click Delete Selected.

Step4 A message indicates that the system will delete notification entries that relate to this community string.
To continue the deletion, click OK.

Step5 A message indicates that changes will not take effect until you restart the SNMP master agent. To
continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP
master agent service, click OK.

L

Tip Cisco recommends that you wait until you finish all the SNMP configuration before you restart
the SNMP master agent service. For information on how to restart the service, see the “Starting,
Stopping, Restarting, and Refreshing Status of Services in Control Center” section on page 11-4.

Cisco Unified Serviceability Administration Guide
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SNMP Notification Destination W

After the window refreshes, the string that you deleted no longer displays in the results.

Additional Information
See the “Where to Find More Information” section on page 16-8.

SNMP Notification Destination

The following sections apply to SNMP V1/V2c notification destination configuration.
¢ Finding a Notification Destination for SNMP V1/V2c, page 16-5
e Configuring a Notification Destination for SNMP V1/V2c, page 16-6
e Notification Destination Configuration Settings for SNMP V1/V2c, page 16-7
e Deleting a Notification Destination for SNMP V1/V2c, page 16-7

Finding a Notification Destination for SNMP V1/V2c
je

Tip The Add New button does not display in the SNMP Notification Destination Configuration window until
you click the Find button. If no notification destinations exist and you want to add a notification
destination, click the Find button and wait for the window to refresh. The Add New button displays.

To find a notification destination for V1/V2c, perform the following procedure:

Procedure

Step 1 Choose Snmp > V1/V2c¢ > Notification Destination.
The Find/List window displays.

Step2  From the Find Notification where Destination IP drop-down list box, choose the specific search criteria
that you want to use to find the notification destination.

Step3  Enter the notification destination for which you want to search.

Step4  In the Server field, enter the hostname or IP address of the server that supports the notification
destination.

Step5  Click Find.

After you click the Find button, the Add New button displays. After the search results display, the Apply
to All Nodes check box displays.

Step6  Unified CM clusters only: If you want to apply the configuration from one of the options in the search
results to all nodes in the cluster, check the check box next to the name of the option and check the Apply
to All Nodes check box.

Step 7 To view the configuration for one of the items in the search results, click the item.

Cisco Unified Serviceability Administration Guide
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Step 8

Configuring a Notification Destination for SNMP V1/V2¢

To add or update a notification string, see the “Configuring a Notification Destination for SNMP
V1/V2c” section on page 16-6.

Additional Information
See the “Where to Find More Information” section on page 16-8.

Configuring a Notification Destination for SNMP V1/V2c

Step 1

Step 2

Step 3

Step 4

Step 5

To configure the notification destination (trap/inform receiver) for V1/V2c, perform the following
procedure.

Procedure

Perform the procedure in the “Finding a Notification Destination for SNMP V1/V2c” section on
page 16-5.

Perform one of the following tasks:
e To add a new SNMP notification destination, click the Add New button and go to Step 3.

You configure the notification destination for the server that you choose in the Server drop-down
list box in the Find/List window.

¢ To modify an existing SNMP notification destination, locate the notification destination, as
described in the “Finding a Notification Destination for SNMP V1/V2c¢” section on page 16-5; click
the name of the SNMP notification destination that you want to edit and go to Step 3.

e To delete an SNMP notification destination, see the “Deleting a Notification Destination for SNMP
V1/V2c” section on page 16-7.

Enter the configuration settings, as described in Table 16-2.

pe

Tip Before you save the configuration, you can click the Clear button at any time to delete all
information that you entered for all settings in the window.

To save a notification destination, click Insert, or click Save to save changes to an existing notification
destination.

A message indicates that changes will not take effect until you restart the SNMP master agent. To
continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP
master agent, click OK.

~

Note  Cisco recommends that you wait until you finish the SNMP configuration before you restart the
SNMP master agent service. For information on how to restart the service, see the “Configuring
Services” section on page 11-1.

Additional Information
See the “Where to Find More Information” section on page 16-8.
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Notification Destination Configuration Settings for SNMP Vi/V2c Il

Notification Destination Configuration Settings for SNMP
Vi/V2c

Table 16-2 describes the notification destination configuration settings for V1/V2c. For related
procedures, see the “Where to Find More Information” section on page 16-8.

Table 16-2 Notification Destination Configuration Settings for V1/V2
Field Description
Server This setting displays as read only because you specified the server when

you performed the procedure in the “Finding a Notification Destination
for SNMP V1/V2c” section on page 16-5.

To change the server for the notification destination, perform the
procedure in the “Finding a Community String” section on page 16-1.

Host IP Addresses From the drop-down list box, choose the Host IP address of the trap
destination or choose Add New. If you choose Add New, enter the IP
address of the trap destination.

For existing notification destinations, you cannot modify the host IP
address configuration.

Port Number In the field, enter the notification-receiving port number on the
destination server that receives SNMP packets.

V1 or V2c From the SNMP Version Information pane, click the appropriate SNMP
version radio button, either V1 or V2c, which depends on the version of
SNMP that you are using.

e If you choose V1, configure the community string setting.

e If you choose V2c, configure the notification type setting and then
configure the community string.

Community String From the drop-down list box, choose the community string name to be
used in the notification messages that this host generates.

Only community strings with minimum notify privileges
(ReadWriteNotify or Notify Only) display. If you have not configured a
community string with these privileges, no options appear in the
drop-down list box. If necessary, click the Create New Community
String button to create a community string, as described in the
“Configuring a Community String” section on page 16-2.

Notification Type From the drop-down list box, choose the appropriate notification type.
Unified CM clusters only: To apply the notification destination configuration to all nodes in the
Apply To All Nodes cluster, check this check box.

Deleting a Notification Destination for SNMP V1/V2¢

To delete a notification destination, perform the following procedure:

Cisco Unified Serviceability Administration Guide
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Step 1

Step 2

Step 3
Step 4
Step 5

Procedure

Locate the notification destination, as described in the “Finding a Notification Destination for SNMP
V1/V2c” section on page 16-5.

From the list of matching records, check the check box next to the notification destination that you want
to delete.

Click Delete Selected.

A message asks whether you want to delete the notification entries. To continue the deletion, click OK.

A message indicates that changes will not take effect until you restart the SNMP master agent. To
continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP
master agent service, click OK.

pe

Tip Cisco recommends that you wait until you finish all the SNMP configuration before you restart
the SNMP master agent service. For information on how to restart the service, see the
“Configuring Services” section on page 11-1.

After the window refreshes, the notification destination that you deleted no longer displays in the results.

Additional Information

See the “Where to Find More Information” section on page 16-8.

Where to Find More Information

Related Topics
e Understanding Simple Network Management Protocol, page 15-1

e Finding a Community String, page 16-1

e Configuring a Community String, page 16-2

e Community String Configuration Settings, page 16-3

e Deleting a Community String, page 16-4

e SNMP Notification Destination, page 16-5

¢ Finding a Notification Destination for SNMP V1/V2c, page 16-5

e Configuring a Notification Destination for SNMP V1/V2c, page 16-6
¢ Notification Destination Configuration Settings for SNMP V1/V2c, page 16-7
e Deleting a Notification Destination for SNMP V1/V2c, page 16-7

e Configuring SNMP V3, page 17-1

e Configuring SNMP System Group, page 18-1
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Configuring SNMP V3

This chapter, which describes how to configure SNMP v3, so the network management system can
monitor Cisco Unified Communications Manager or Cisco Unity Connection, contains the following
topics:

Finding the SNMP User, page 17-1

Configuring the SNMP User, page 17-2

SNMP User Configuration Settings, page 17-3

Deleting the SNMP User, page 17-4

Finding a Notification Destination for SNMP V3, page 17-5

Configuring a Notification Destination for SNMP V3, page 17-6
Notification Destination Configuration Settings for SNMP V3, page 17-7
Where to Find More Information, page 17-9

If you use SNMP vl or v2c, see the “Configuring SNMP V1/V2c¢” section on page 16-1.

Finding the SNMP User

e

Tp.

Step 1

Step 2

Step 3

The Add New button does not display in the SNMP User Configuration window until you click the Find
button. If no users exist and you want to add a user, click the Find button and wait for the window to
refresh. The Add New button displays.

To find a SNMP user, perform the following procedure:

Procedure

Choose Snmp > V3 > User.

The SNMP User Configuration window displays.

From the Find User where Name list box, choose the specific search criteria that you want to use to find
the user; for example, begins with.

Enter the user name for which you want to search.
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Bl Configuring the SNMP User

Step 4

Step 5

Step 6

Step 7
Step 8

From the Server drop-down list box, choose the hostname or IP address of the server where you access
the user.

Click Find.

After you click the Find button, the Add New button displays. After the search results display, the Apply
to All Nodes check box displays.

Unified CM clusters only: If you want to apply the configuration from one of the options in the search
results to all nodes in the cluster, check the check box next to the name of the option and check the Apply
to All Nodes check box.

From the list of results, click the user that you want to view.

To add or update a user, see the “Configuring the SNMP User” section on page 17-2.

Additional Information
See the “Related Topics” section on page 17-9.

Configuring the SNMP User

Step 1
Step 2

Step 3

Step 4
Step 5

To configure user(s) for SNMP, perform the following procedure:

Procedure

Perform the procedure in the “Finding a Notification Destination for SNMP V3” section on page 17-5.
Perform one of the following tasks:

e To add a new SNMP user, click the Add New button in the SNMP User Configuration Find/List
window and go to Step 3.

¢ To modify an existing SNMP user, locate the user, as described in the “Finding a Notification
Destination for SNMP V3” section on page 17-5; click the name of the SNMP user that you want to
edit and go to Step 3.

e To delete an SNMP user, see the “Deleting the SNMP User” section on page 17-4.

Enter the configuration settings, as described in Table 17-1.

L

Tip Before you save the configuration, you can click the Clear All button at any time to delete all
information that you entered for all settings in the window.

To add a new user, click Insert, or click Save to save changes to an existing user.

A message indicates that changes will not take effect until you restart the SNMP master agent. To
continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP
master agent service, click OK.

ye

Tip Cisco recommends that you wait until you finish the SNMP configuration before you restart the
SNMP master agent service. For information on how to restart the service, see the “Configuring
Services” section on page 11-1.

Cisco Unified Serviceability Administration Guide
m. OL-18619-01



| Chapter 17

Configuring SNMP V3

)

SNMP User Configuration Settings

Note  To access this server that has the user that you configure, make sure that you configure this user
on the NMS with the appropriate authentication and privacy settings.

Additional Information

See the “Related Topics” section on page 17-9.

SNMP User Configuration Settings

Table 17-1 describes the SNMP user configuration settings for V3. For related procedures, see the
“Related Topics” section on page 17-9.

Table 17-1 SNMP User Configuration Settings for V3
Field Description
Server This setting displays as read only because you specified the server when

you performed the procedure in the “Finding a Notification Destination
for SNMP V3” section on page 17-5.

To change the server where you want to provide access, perform the
procedure in the “Finding the SNMP User” section on page 17-1.

User Name

In the field, enter the name of the user for which you want to provide
access. The name can contain up to 32 characters and can contain any
combination of alphanumeric characters, hyphens (-), and underscore
characters (_).

pe

Tip Enter users that you have already configured for the network
management system (NMS).

For existing SNMP users, this setting displays as read only.

Authentication Required

To require authentication, check the check box, enter the password in
the Password and Reenter Password fields, and choose the appropriate
protocol. The password must contain at least 8 characters.

Privacy Required

If you checked the Authentication Required check box, you can specify
privacy information. To require privacy, check the check box, enter the
password in the Password and Reenter Password fields, and check the
protocol check box. The password must contain at least 8 characters.

Tip After you check the Privacy Required check box, the DES (Data
Encryption Standard) check box automatically appears checked.
The DES protocol prevents packets from being disclosed.

Accept SNMP Packets from
any host

To accept SNMP packets from any host, click the radio button.
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Table 17-1 SNMP User Configuration Settings for V3 (continued)

Field Description

Accept SNMP Packets only |To accept SNMP packets from specific hosts, click the radio button. In
from these hosts the Host IP Address field, enter a host from which you want to accept
SNMP packets and click Insert. Repeat this process for each host from
which you want to accept SNMP packets. To delete a host, choose that
host from the Host IP Addresses pane and click Remove.

Access Privileges From the drop-down list box, choose one of the following options for the
access level:

e ReadOnly—The user can only read the values of MIB objects.

e ReadWrite—The user can read and write the values of MIB
objects.

¢ ReadWriteNotify—The user can read and write the values of MIB
objects and send MIB object values for a trap and inform messages.

e NotifyOnly—The user can only send MIB object values for trap
and inform messages.

¢ ReadNotifyOnly—The user can read values of MIB objects and
also send the values for trap and inform messages.

e None—The user cannot read, write, or send trap information.

Tip To change the trap configuration parameters, you need to
configure a user with NotifyOnly, ReadNotifyOnly, or
ReadWriteNotify privileges.

Unified CM clusters only: To apply the user configuration to all nodes in the cluster, check this
Apply To All Nodes check box.

Deleting the SNMP User

Step 1
Step 2
Step 3
Step 4

Step 5

To delete a user for SNMP, perform the following procedure:

Procedure

Locate the SNMP user, as described in the “Finding the SNMP User” section on page 17-1.
From the list of matching records, check the check box next to the user that you want to delete.
Click Delete Selected.

A message indicates that the system will delete notification entries that relate to this user. To continue
the deletion, click OK.

A message indicates that changes will not take effect until you restart the SNMP master agent. To
continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP
master agent service, click OK.
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pe

Tip Cisco recommends that you wait until you finish all the SNMP configuration before you restart
the SNMP master agent service. For information on how to restart the service, see the
“Configuring Services” section on page 11-1.

After the window refreshes, the user that you deleted no longer displays in the results.

Additional Information
See the “Related Topics” section on page 17-9.

SNMP Notification Destination

The following sections apply to SNMP V3 notification destination configuration.
¢ Finding a Notification Destination for SNMP V3, page 17-5
e Configuring a Notification Destination for SNMP V3, page 17-6
¢ Notification Destination Configuration Settings for SNMP V3, page 17-7
e Deleting a Notification Destination for SNMP V3, page 17-8

Finding a Notification Destination for SNMP V3

e

Tip

Step 1
Step 2

Step 3
Step 4

Step 5

Step 6

The Add New button does not display in the SNMP Notification Destination Configuration window until
you click the Find button. If no users exist and you want to add want a user, click the Find button and
wait for the window to refresh. The Add New button displays.

To find a notification destination for V3, perform the following procedure:

Procedure

Choose Snmp > V3 > Notification Destination.

From the Find Notification where Destination IP drop-down list box, choose the specific search criteria
that you want to use to find the notification destination; for example, begins with.

Enter the IP address/hostname of notification destination for which you want to search.

In the Server field, choose the hostname or IP address of the server that supports the notification
destination.

Click Find.

After you click the Find button, the Add New button displays. After the search results display, the Apply
to All Nodes check box displays.

Unified CM clusters only: If you want to apply the configuration from one of the options in the search
results to all nodes in the cluster, check the check box next to the name of the option and check the Apply
to All Nodes check box.
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Step7  From the list of results, click the notification destination that you want to view.

Step8 To add or update a notification destination, see the “Configuring a Notification Destination for SNMP

V3” section on page 17-6.

Additional Information
See the “Related Topics” section on page 17-9.

Configuring a Notification Destination for SNMP V3

To configure the trap/Inform receiver, perform the following procedure:

Procedure

Step1  Perform the procedure in the “Finding a Notification Destination for SNMP V3” section on page 17-5.

Step2  Perform one of the following tasks:

e Toadd anew SNMP notification destination, click the Add New button in the search results window

and go to Step 3.

¢ To modify an existing SNMP notification destination, locate the notification destination in the

search results window; click the name of the SNMP notification destination that you want to edit

and go to Step 3.

e To delete an SNMP notification destination, see the “Deleting a Notification Destination for SNMP

V3” section on page 17-8.
Step3  Configure the settings, as described in Table 17-2.

Je

Tip Before you save the configuration, you can click the Clear button at any time to delete all

information that you entered for all settings in the window.

Step 4 To save a notification destination, click Insert, or click Save to save changes to an existing notification

destination.

Step5 A message indicates that changes will not take effect until you restart the SNMP master agent. To

continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP

master agent service, click OK.

Je

Tip Cisco recommends that you wait until you finish the SNMP configuration before you restart the
SNMP master agent service. For information on how to restart the service, see the “Configuring

Services” section on page 11-1.

Additional Information
See the “Related Topics” section on page 17-9.
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Notification Destination Configuration Settings for SNMP V3

Table 17-2 describes the notification destination configuration settings for V3. For related procedures,
see the “Related Topics” section on page 17-9.

Table 17-2 Notification Destination Configuration Settings for V3
Field Description
Server This setting displays as read only because you specified the server when

you performed the procedure in the “Finding a Notification Destination
for SNMP V3” section on page 17-5.

To change the server for the notification destination, perform the
procedure in the “Finding a Notification Destination for SNMP V3~
section on page 17-5.

Host IP Addresses From the drop-down list box, choose the Host IP address or choose Add
New. If you chose Add New, enter the IP address for the host.

Port Number In the field, enter the notification-receiving port number on the
destination server.

Notification Type From the drop-down list box, choose Inform or Trap.
Tip Cisco recommends that you choose the Inform option. The

Inform function retransmits the message until it is
acknowledged, thus, making it more reliable than traps.

Remote SNMP Engine Id This setting displays if you chose Inform from the Notification Type
drop-down list box.

From the drop-down list box, choose the engine ID or choose Add New.
If you chose Add New, enter the ID in the Remote SNMP Engine Id
field, which requires a hexidecimal value.

Security Level From the drop-down list box, choose the appropriate security level for
the user.

¢ noAuthNoPriv—No authentication or privacy configured.

e authNoPriv—Authentication configured, but no privacy
configured.

e authPriv—Authentication and privacy configured.

Cisco Unified Serviceability Administration Guide
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Table 17-2 Notification Destination Configuration Settings for V3 (continued)
Field Description
User Information pane From the pane, perform one of the following tasks to associate or

disassociate the notification destination with the user.

e To create a new user, click the Create New User button and see the
“Configuring the SNMP User” section on page 17-2.

e To modify an existing user, click the radio button for the user and
click Update Select ed User; then, see the “Configuring the SNMP
User” section on page 17-2.

e To delete a user, click the radio button for the user and click Delete
Selected User.

The users that display vary depending on the security level that you
configured for the notification destination.

Unified CM clusters only: To apply the notification destination configuration to all nodes in the
Apply To All Nodes cluster, check this check box.

Deleting a Notification Destination for SNMP V3

To delete a notification destination, perform the following procedure:

Procedure

Step 1 Locate the SNMP notification destination, as described in the “Finding a Notification Destination for
SNMP V3” section on page 17-5.

Step2  From the list of matching records, check the check box next to the notification destination that you want
to delete.

Step3  Click Delete Selected.

Step4 A message asks you if you want to delete the notification destination. To continue the deletion, click
OK.

Step5 A message indicates that changes will not take effect until you restart the SNMP master agent. To
continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP
master agent service, click OK.

Je

Tip Cisco recommends that you wait until you finish all the SNMP configuration before you restart
the SNMP master agent service. For information on how to restart the service, see the
“Configuring Services” section on page 11-1.

After the window refreshes, the notification destination that you deleted no longer displays in the search
results window.

Additional Information
See the “Related Topics” section on page 17-9.
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Where to Find More Information

Related Topics
e Understanding Simple Network Management Protocol, page 15-1

¢ Finding the SNMP User, page 17-1

e Configuring the SNMP User, page 17-2

e SNMP User Configuration Settings, page 17-3

e Deleting the SNMP User, page 17-4

¢ Finding a Notification Destination for SNMP V3, page 17-5

e Configuring a Notification Destination for SNMP V3, page 17-6

e Notification Destination Configuration Settings for SNMP V3, page 17-7
e Deleting a Notification Destination for SNMP V3, page 17-8

e Configuring SNMP V1/V2c, page 16-1

e Configuring SNMP System Group, page 18-1
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Configuring SNMP System Group

Cisco Unified Serviceability provides the MIB2 System Group Configuration window where you can
configure the system contact and system location objects for the MIB-II system group. For example, you
could enter Administrator, 555-121-6633, for the system contact and San Jose, Bldg 23, 2nd floor, for
the system location. This chapter contains information on the following topics:

e Configuring the MIB2 System Group, page 18-1
e MIB2 System Group Configuration Settings, page 18-2
¢ Where to Find More Information, page 18-2

Configuring the MIB2 System Group

£
Tip

Step 1
Step 2
Step 3
Step 4

Perform the following procedure to configure a system contact and system location for the MIB-II
system group.

This procedure supports SNMP v1, v2c, and v3 configuration.

Procedure

Choose Snmp > SystemGroup > MIB2 System Group.
Configure the settings, as described in Table 18-1.
Click Save.

A message indicates that changes will not take effect until you restart the SNMP master agent. To
continue the configuration without restarting the SNMP master agent service, click Cancel. To restart
the SNMP master agent service, click OK.

)

Note  To clear the System Contact and System Location fields, click the Clear All button. To delete
the system configuration, click the Clear All button and the Save button.

Additional Information
See the “Related Topics” section on page 18-2.
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MIB2 System Group Configuration Settings

Table 18-1 describes the MIB2 System Group configuration settings. For related procedures, see the
“Related Topics” section on page 18-2.

Table 18-1 MIB2 System Group Configuration Settings

Field Description

Server From the drop-down list box, choose the server for which you want to
configure contacts; then, click Go.

System Contact In the field, enter a person to notify when problems occur.

System Location In the field, enter the location of the person that is identified as the

system contact.

Unified CM clusters only: | To apply the system configuration to all of the nodes in the cluster,
check the check box.
Apply To All Nodes

Where to Find More Information

Related Topics
e Understanding Simple Network Management Protocol, page 15-1
e Configuring SNMP V1/V2c, page 16-1
e Configuring SNMP V3, page 17-1
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Configuring SNMP Trap/Inform Parameters

This section describes how to use CLI commands to set configurable trap settings. Table 15-3 provides
the SNMP trap configuration parameters and recommended configuration for CISCO-SYSLOG-MIB
and CISCO-CCM-MIB.

This chapter provides information on the following topics:
e Configuring CISCO-SYSLOG-MIB Trap Parameters, page 19-1
¢ Configuring CISCO-CCM-MIB Trap Parameters, page 19-2

Configuring CISCO-SYSLOG-MIB Trap Parameters

Unified CM and Unified CM BE only: Use these guidelines to configure CISCO-SYSLOG-MIB trap
settings on your system:

e SetclogsNotificationEnabled (1.3.6.1.4.1.9.9.41.1.1.2) to true by using the SNMP Set operation; for
example, use the net-snmp set utility to set this OID to true from the linux command line using:
snmpset -c <community string> -v2¢ <transmitter ipaddress> 1.3.6.1.4.1.9.9.41.1.1.2.01i 1

You can also use any other SNMP management application for the SNMP Set operation.

e Set clogMaxSeverity (1.3.6.1.4.1.9.9.41.1.1.3) value by using the SNMP Set operation; for
example, use the net-snmp set utility to set this OID value from the linux command line using:
snmpset -c public -v2c¢ 1 <transmitter ipaddress> 1.3.6.1.4.1.9.9.41.1.1.3.0 i <value>

Enter a severity number for the <value> setting. Severity values increase as severity decreases. A
value of 1 (Emergency) indicates highest severity, and a value of 8§ (Debug) indicates lowest
severity. Syslog agent ignores any messages greater than the value that you specify; for example, to
trap all syslog messages, use a value of 8.

You can also use any other SNMP management application for the SNMP Set operation.

N

m Before logging, Syslog truncates any trap message data that is larger than the specified Syslog buffer
size. The Syslog trap message length limitation equals 255 bytes.
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Configuring CISCO-CCM-MIB Trap Parameters

Unified CM and Unified CM BE only: Use these guidelines to configure CISCO-CCM-MIB trap settings
on your system:

Set ccmPhoneFailedAlarmInterval (1.3.6.1.4.1. 9.9.156.1.9.2 to a value in the range 30-3600 by
using the SNMP Set operation; for example, use the net-snmp set utility to set this OID value from
the linux command line using: snmpset -¢ <community string> -v2¢c <transmitter ipaddress>
1.3.6.1.4.1.9.9.156.1.9.2 .0 i <value>

You can also use any other SNMP management application for the SNMP Set operation.

Set ccmPhoneStatusUpdateAlarmlInterval (1.3.6.1.4.1.9.9.156.1.9.4) to a value in the range 30-3600
by using the SNMP Set operation; for example, use the net-snmp set utility to set this OID value
from the linux command line using: snmpset -¢ <community string> -v2¢ <transmitter ipaddress>
1.3.6.1.4.1.9.9.156.1.9.4.0 i <value>

You can also use any other SNMP management application for the SNMP Set operation.

Where to Find More Information

Related Topics

Understanding Services, page 9-1

Configuring Services, page 11-1

Configuring SNMP Trap/Inform Parameters, page 19-1
Configuring SNMP V1/V2c, page 16-1

Configuring SNMP V3, page 17-1

Configuring SNMP System Group, page 18-1

Related Documentation

Command Line Interface Reference Guide for Cisco Unified Solutions
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